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4
Install the PostScript printer driver over SMB. Ask the 
administrator for the IP address/DNS name.

Installez le pilote d’imprimante PostScript via SMB. Demandez 
l’adresse IP/le nom DNS à votre administrateur.

Installare il driver di stampa su SMB. Chiedere il nome DNS/
indirizzo IP all’amministratore.

Installieren Sie den PostScript-Druckertreiber per SMB. 
Fragen Sie Ihren Administrator nach der IP-Adresse bzw. dem 
DNS-Namen. 

Instale el controlador de impresora PostScript  a través de 
SMB. Pregunte al administrador cuál es la dirección 
IP/nombre DNS.

Instale o driver de impressora PostScript sobre SMB. Peça ao 
administrador o endereço IP/nome DNS. 

Installeer het PostScript-printerstuurprogramma via SMB. 
Vraag de beheerder om het IP-adres/de DNS-naam.
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Double-click print to add the print connection.

You can add additional connection types later.
Double-cliquez sur print pour ajouter la connexion 
d’impression. 

Vous pourrez ajouter d’autres types de connexion 
ultérieurement.
Fare doppio clic su print per aggiungere il collegamento 
di stampa. 

Sarà possibile aggiungere altri tipi di collegamento più avanti.
Doppelklicken Sie auf „print“, um diese Druckverbindung 
herzustellen.

Sie können später weitere Verbindungen hinzufügen.
Haga doble clic en “print” para agregar la conexión 
de impresión.

Puede agregar otros tipos de conexión más adelante.
Clique duas vezes em “print” para adicionar a conexão 
de impressão.

É possível incluir tipos de conexão adicionais posteriormente.
Dubbelklik op print om de afdrukverbinding toe te voegen.

U kunt later aanvullende verbindingstypen toevoegen.

• direct: Jobs are printed, but not stored.
• hold: Jobs are spooled and stored for later printing.
• print: Jobs are printed and stored.

• direct : les tâches sont imprimées mais pas stockées.
• hold : les tâches sont spoulées et stockées pour 

impression ultérieure.
• print : les tâches sont imprimées et stockées.

• direct: i lavori vengono stampati, ma non memorizzati.
• hold: i lavori vengono inviati in spool per essere 

stampati più tardi.
• print: lavori vengono stampati e memorizzati.

• direct:  Aufträge ohne Spoolen/Speichern drucken
• hold:  Aufträge für spätere Druckausgabe speichern
• print:  Aufträge drucken und speichern

• direct: Los trabajos se imprimen pero no se guardan.
• hold: Los trabajos se almacenan en la cola y se guardan para 

imprimirlos posteriormente.
• print: Los trabajos se imprimen y se guardan.

• direct: as tarefas são impressas, mas não são armazenadas.
• hold: as tarefas são passadas pelo spool e armazenadas para 

impressão posteriormente.
• print: as tarefas são impressas e armazenadas.

• direct: taken worden afgedrukt, maar niet opgeslagen.
• hold: taken worden in de wachtrij geplaatst en opgeslagen om 

deze later af te drukken.
• print: taken worden afgedrukt en opgeslagen.

“\\” + Fiery Server IP address
« \\ » + adresse IP du Fiery Server
“\\” + indirizzo IP di Fiery Server 
\\ + IP-Adresse des Fiery Servers

“\\” + Dirección IP del Fiery Server
“\\” + endereço IP do Fiery Server
“\\” + IP-adres van Fiery Server
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Make sure that the Fiery Server is connected to the copier/
printer and the network. Power on the Fiery Server. 
If you need help, see Configuration and Setup, or check with 
your authorized service/support center.

Assurez-vous que le Fiery Server est connecté au copieur/à 
l’imprimante et au réseau. Mettez le Fiery Server sous tension. 
Pour obtenir de l’aide, voir Configuration et installation ou 
contactez le S.A.V. agréé.

Controllare che Fiery Server sia collegato alla fotocopiatrice/
stampante e alla rete.  Accendere Fiery Server. 
Per informazioni, vedere il manuale Configurazione e 
impostazione oppure rivolgersi al centro di assistenza/
supporto autorizzato.

Vergewissern Sie sich, dass der Fiery Server mit dem 
Ausgabegerät und dem Netzwerk verbunden ist, und schalten 
Sie ihn ein (siehe Konfiguration und Setup). Wenden Sie sich bei 
Fragen an Ihren autorisierten Support- und Servicepartner.

Asegúrese de que el Fiery Server esté conectado a la 
copiadora/impresora y a la red. Encienda el Fiery Server. 
Si necesita ayuda, consulte Instalación y configuración 
o contacte con su centro de servicio técnico/asistencia 
autorizado.

Verifique se o Fiery Server está conectado à copiadora/
impressora e à rede. Ligue o Fiery Server. 
Se você precisar de ajuda, consulte Configuração e instalação, 
ou verifique com seu serviço/centro de suporte autorizado.

Controleer of de Fiery Server is aangesloten op de 
kopieermachine/printer en het netwerk. 
Schakel de Fiery Server in. 
Raadpleeg Configuratie en instellingen voor meer hulp of neem 
contact op met uw geautoriseerde service-/onderhoudsdienst.

2
Install Fiery user software on the client computer.

Installez les logiciels utilisateur Fiery sur l’ordinateur client.

Installare il software utente Fiery sul computer client.

Installieren Sie die Fiery Anwendersoftware auf dem Client-
Computer.

Instale el software del usuario del Fiery en la computadora 
cliente.

Instale o software do usuário do Fiery no computador cliente.

Installeer Fiery-gebruikerssoftware op de clientcomputer.
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Start Command WorkStation and use Search (Auto, or by 
IP range or subnet). The new Fiery Server will have an auto-
generated name, “SERVER-XXXXXXX”. If you cannot find 
the Fiery Server, ask your administrator for the IP address. 
Configure the Fiery Server using the Fiery Setup Wizard (see 
Configuration and Setup).

Démarrez la Command WorkStation et utilisez la fonction 
de recherche (automatique, par plage IP ou sous-réseau). 
Le nouveau Fiery Server se verra attribuer un nom généré 
automatiquement (« SERVER-XXXXXXX »). Si vous ne parvenez 
pas à trouver le Fiery Server, demandez son adresse IP à votre 
administrateur. Configurez le Fiery Server à l’aide de l’assistant 
de configuration Fiery (voir Configuration et installation).

Avviare Command WorkStation e usare Ricerca (automatica, 
per gruppo IP o sottorete). Il nuovo Fiery Server avrà un nome 
autogenerato, “SERVER-XXXXXXX”. Se non si riesce a trovare 
Fiery Server, chiederne l’indirizzo IP all’amministratore. 
Configurare Fiery Server con la procedura di configurazione 
guidata Fiery (vedere il manuale Configurazione e 
impostazione).

Starten Sie die Anwendung Command WorkStation und 
suchen Sie (automatisch oder per IP-Adressbereich oder 
Teilnetz) nach dem Fiery Server. Er erhält einen automatisch 
generierten Namen („SERVER-XXXXXXX“). Fragen Sie, falls 
der Fiery Server nicht gefunden wird, Ihren Administrator 
nach der IP-Adresse. Nehmen Sie das Setup des Fiery Servers 
mithilfe des Assistenten vor (siehe Konfiguration und Setup).

Inicie Command WorkStation y utilice Búsqueda (automática 
o mediante rango de IP o subred). El nuevo Fiery Server 
tendrá un nombre generado automáticamente, “SERVER-
XXXXXXX”. Si no puede encontrar el Fiery Server, pregunte a su 
administrador cuál es la dirección IP. Configure el Fiery Server 
mediante el Asistente para la configuración del Fiery (consulte 
Instalación y configuración).

Inicie a Command WorkStation e use Pesquisar (Automático 
ou por Intervalo de endereço IP ou subrede). O novo 
Fiery Server terá um nome gerado automaticamente, 
“SERVER-XXXXXXX”. Se você não puder localizar o Fiery 
Server, peça ao administrador o endereço IP. Configure o Fiery 
Server usando o Assistente de instalação do Fiery (consulte 
Configuração e instalação).

Start Command WorkStation en gebruik Zoeken (Automatisch, 
of op IP-bereik of subnet). De nieuwe Fiery Server krijgt een 
automatisch gegenereerde naam, “SERVER-XXXXXXX”. Als 
u de Fiery Server niet kunt vinden, vraagt u de beheerder 
om het IP-adres. Configureer de Fiery Server met de Fiery-
instellingenwizard (raadpleeg Configuratie en instellingen).
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Auto-generated name of the Fiery Server
Nom généré automatiquement pour le Fiery Server
Nome autogenerato di Fiery Server
Automatisch generierter Name des Fiery Servers 
Nombre generado automáticamente del Fiery Server
Nome do Fiery Server gerado automaticamente
Automatisch gegenereerde naam van de Fiery Server

Fiery.1

Select Administrator.
Sélectionnez Administrateur.
Selezionare Amministratore.
„Administrator“ wählen

Seleccione Administrador.
Selecione Administrador.
Selecteer Beheerder.

Fiery.1
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Check the installed options.

Vérifiez les options installées.

Controllare le opzioni installate.

Konfigurieren Sie die Installationsoptionen.

Compruebe las opciones instaladas.

Verifique as opções instaladas.

Controleer de geïnstalleerde opties.

A
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To change the installed options, ask your administrator. You may need 

to install the printer driver in a different way. See Printing.

Pour modifier les options installées, contactez votre administrateur. 

Il est possible que vous ayez à installer le pilote d’imprimante d’une 

autre façon. Voir Impression.

Per cambiare le opzioni installate, rivolgersi all’amministratore. 

Potrebbe essere necessario installare il driver di stampa in un modo 

diverso. Vedere il manuale Stampa.

Wenden Sie sich bei Fragen hierzu an Ihren Administrator. Eventuell 

muss der Druckertreiber auf andere Weise installiert werden (siehe 

Drucken).

Para cambiar las opciones instaladas, consulte con su administrador. 

Es posible que necesite instalar el controlador de impresora de una 

manera diferente. Consulte Impresión.

Para alterar as opções instaladas, peça ao administrador. Talvez seja 

necessário instalar o driver da impressora de uma maneira diferente. 

Consulte Impressão.

Raadpleeg de beheerder als u de geïnstalleerde opties wilt wijzigen. 

Mogelijk moet u het printerstuurprogramma op een andere manier 

installeren. Raadpleeg Afdrukken.

7
Print a sample PDF.

Imprimez un document PDF en guise d’échantillon.

Stampare un PDF di esempio.

Drucken Sie eine PDF-Beispieldatei.

Imprima un archivo PDF de ejemplo.

Imprima um PDF de amostra.

Druk een voorbeeld-PDF af.

Installable Options, Configuration, or Accessories
Options installables, Configuration ou Accessoires
Opzioni installabili, Configurazione o Accessori 
„Installierbare Optionen“, „Konfiguration“ bzw. „Zubehör“
Opciones instalables, Configuración o Accesorios
Opções instaláveis, Configuração e Acessórios
Installeerbare opties, Configuratie of Accessoires 
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1
Make sure that the Fiery Server is connected to the copier/
printer and the network. Power on the Fiery Server. 
If you need help, see Configuration and Setup, or check with 
your authorized service/support center.

Assurez-vous que le Fiery Server est connecté au copieur/à 
l’imprimante et au réseau. Mettez le Fiery Server sous tension. 
Pour obtenir de l’aide, voir Configuration et installation ou 
contactez le S.A.V. agréé.

Controllare che Fiery Server sia collegato alla fotocopiatrice/
stampante e alla rete. Accendere Fiery Server. 
Per informazioni, vedere il manuale Configurazione e 
impostazione oppure rivolgersi al centro di assistenza/
supporto autorizzato.

Vergewissern Sie sich, dass der Fiery Server mit dem 
Ausgabegerät und dem Netzwerk verbunden ist, und schalten 
Sie ihn ein (siehe Konfiguration und Setup). Wenden Sie sich bei 
Fragen an Ihren autorisierten Support- und Servicepartner.

Asegúrese de que el Fiery Server esté conectado a la 
copiadora/impresora y a la red. Encienda el Fiery Server. 
Si necesita ayuda, consulte Instalación y configuración 
o contacte con su centro de servicio técnico/asistencia 
autorizado.

Verifique se o Fiery Server está conectado à copiadora/
impressora e à rede. Ligue o Fiery Server. 
Se você precisar de ajuda, consulte Configuração e instalação, 
ou verifique com seu serviço/centro de suporte autorizado.

Controleer of de Fiery Server is aangesloten op de 
kopieermachine/printer en het netwerk. 
Schakel de Fiery Server in. 
Raadpleeg Configuratie en instellingen voor meer hulp of neem 
contact op met uw geautoriseerde service-/onderhoudsdienst.

2
Install Fiery user software on the client computer. Install 
Command WorkStation first.

Installez les logiciels utilisateur Fiery sur l’ordinateur client. 
Installez d’abord la Command WorkStation.

Installare il software utente Fiery sul computer client. 
Installare prima Command WorkStation.

Installieren Sie die Fiery Anwendersoftware auf dem Client-
Computer. Beginnen Sie mit der Anwendung Command 
WorkStation.

Instale el software del usuario del Fiery en 
la computadora cliente. 
Instale primero Command WorkStation.

Instale o software do usuário do Fiery no computador cliente. 
Instale primeiro a Command WorkStation.

Installeer Fiery-gebruikerssoftware op de clientcomputer. 
Installeer eerst Command WorkStation.
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B

C

D

3
Start Command WorkStation and select the Fiery Server. 
Configure the Fiery Server using the Fiery Setup Wizard 
(see Configuration and Setup).

Lancez la Command WorkStation et sélectionnez le Fiery 
Server. Configurez le Fiery Server à l’aide de l’assistant de 
configuration Fiery (voir Configuration et installation).

Avviare Command WorkStation e selezionare Fiery Server. 
Configurare Fiery Server con la procedura di configurazione 
guidata Fiery (vedere il manuale Configurazione e 
impostazione). 

Starten Sie die Anwendung Command WorkStation, stellen 
Sie die Verbindung zum Fiery Server her und nehmen Sie das 
Setup mithilfe des Assistenten vor (siehe Konfiguration und 
Setup).

Inicie Command WorkStation y seleccione el Fiery Server. 
Configure el Fiery Server mediante el Asistente para la 
configuración del Fiery (consulte Instalación y configuración). 

Inicie a Command WorkStation e selecione o Fiery Server. 
Configure o Fiery Server usando o Assistente de instalação do 
Fiery (consulte Configuração e instalação).

Start Command WorkStation en selecteer de Fiery Server. 
Configureer de Fiery Server met de Fiery-instellingenwizard 
(raadpleeg Configuratie en instellingen).
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Auto-generated name of the Fiery Server
Nom généré automatiquement pour le Fiery Server
Nome autogenerato di Fiery Server
Automatisch generierter Name des Fiery Servers 
Nombre generado automáticamente del Fiery Server
Nome do Fiery Server gerado automaticamente
Automatisch gegenereerde naam van de Fiery Server

Select Administrator. Seleccione Administrador.
Sélectionnez Administrateur. Selecione Administrador.
Selezionare Amministratore. Selecteer Beheerder.
„Administrator“ wählen

Fiery.1

Fiery.1Fiery.1

Fiery.1

4
Install the printer driver.

Installez le pilote d’imprimante.

Installare il driver di stampa.

Installieren Sie den Druckertreiber.

Instale el controlador de impresora.

Instale o driver da impressora.

Installeer het printerstuurprogramma.

A

B

C

Select the Fiery Server, or search by the IP address or name 

of the Fiery Server.

Sélectionnez le Fiery Server, ou recherchez-le à l’aide de son adresse IP 

ou de son nom.

Selezionare Fiery Server oppure eseguire la ricerca per indirizzo IP o 

nome.

Wählen Sie den Fiery Server oder suchen Sie unter seiner 

IP-Adresse oder seinem Namen nach ihm.

Seleccione el Fiery Server, o busque por el nombre o dirección IP del 

Fiery Server. 

Selecione o Fiery Server ou pesquise pelo endereço IP ou o nome do 

Fiery Server.

Selecteer de Fiery Server of zoek aan de hand van het IP-adres of de 

naam van de Fiery Server.

D

Click Installable Options.

Cliquez sur Options installables.

Fare clic su Opzioni installabili.

Klicken Sie auf „Installierbare Optionen“.

Haga clic en Opciones instalables.

Clique em Opções instaláveis.

Klik op Installeerbare opties.

E

F

Click Install.

Cliquez sur Installer.

Fare clic su Installa.

Klicken Sie auf „Installieren“.

Haga clic en Instalar.

Clique em Instalar.

Klik op Installeren.

G

Click Finish.

Cliquez sur Terminer.

Fare clic su Fine.

Klicken Sie auf „Fertig stellen“.

Haga clic en Finalizar.

Clique em Concluir.

Klik op Voltooien.

5
Print a sample PDF.

Imprimez un document PDF en guise d’échantillon.

Stampare un PDF di esempio.

Drucken Sie eine PDF-Beispieldatei.

Imprima un archivo PDF de ejemplo.

Imprima um PDF de amostra.

Druk een voorbeeld-PDF af.
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Introduction

Printing describes how to install the printer drivers on Windows and Mac OS computers for the Fiery® ES IC-416.
This document covers the following topics:

• Installing printer drivers on Windows computers

• Setting up the printing connections on Windows computers

• Printing from Windows computers

• Installing printer drivers on Mac OS computers

• Setting up Mac OS computers for printing

• Printing from Mac OS computers

• Fiery® ES IC-416 print options

• Using printing methods other than the printer driver to print to the Fiery® ES IC-416

For information about setting up network servers and client computers to use the, see Configuration and Setup. For
general information about using the printer, your computer, application software, or network, see the
documentation that accompanies those products.
For information about supported operating systems and system requirements, see Configuration and Setup.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-416, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Printer MFP

Fiery ES Fiery® ES IC-416

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in Configuration
and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.
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Term or convention Refers to

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To use
the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-416.

Resource Description

User guides (titles in
italics)

Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material (titles in
italics)

• Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

User software for printing

You need to install user software to set up basic printing on the Fiery ES.
Other documents may describe user software that can be used to print documents.

User software Description

Printer drivers (for Windows and
Mac OS)

Provides information about the Fiery ES and your particular printer model to your
application and printer driver.

Printer Delete Utility (for Windows) Uninstalls the Windows printer driver and associated printer driver files. (See 
Uninstall printer drivers from Windows client computers on page 17.)

Fiery Software Uninstaller Utility (for
Mac OS)

Uninstalls the Mac OS printer and associated printer driver files. (See Uninstall
printer driver from a Mac OS computer on page 32.)
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Windows for Fiery ES

The Fiery ES can be set up as a printer on a Windows computer by installing the printer driver that correspond to
your printer and setting up the Fiery ES for printing.
Printer drivers provide a way to communicate information about print jobs between your applications, the Fiery ES,
and the printer.

Installing Windows printer drivers

Installing the printer driver is the first step to set up the Fiery ES as a printer.
The User Account Control (UAC) feature is available on Windows 8.1, Windows 8, Windows 7, Windows Vista,
Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2 computers.
You must be the administrator or a user with Administrator privileges to install printer drivers.

Note: If the Fiery ES printer driver is already installed, you must uninstall it before you install a new driver. (See 
Uninstall printer drivers from Windows client computers on page 17.)

Installing printer drivers with Point and Print

SMB printing (also known as Windows or WINS printing) allows you to install PostScript printer drivers on your
computer from the Fiery ES with Point and Print.
You can then print to a particular connection (Print queue, Hold queue, Direct connection or the name of the virtual
printer).
Each connection requires a separate installation. Repeat the procedure for each connection.
When you install the printer driver using Point and Print, you cannot configure installable options manually. The
installed options are displayed as the Fiery ES configuration in the printer driver. (See Configure installable options
on Windows client computers on page 23.)
Before you begin, ask your administrator to do the following in Setup on the Fiery ES:

• Assign the Fiery ES a valid IP address.
The IP address or DNS name is required in the following procedure.

• Configure the Fiery ES for SMB printing.

Note: SMB printing is referred to as Windows Printing in Setup and on the Configuration page.
For more information, see Configuration and Setup or Command WorkStation Help.
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Set up SMB printing on Windows computers for the Fiery ES

Install the Fiery ES printer driver with SMB printing on Windows computers.
1 To navigate to computers and devices on your network, do one of the following:

• Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

• Windows 8/Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the
Search charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up
or down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in
the results. Click Devices and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Sharing Center, and then click the View
network computers and devices link from the Network and Sharing Center list.

• Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

2 Search for the Fiery ES on the network using either its name or IP address.
If you cannot locate the Fiery ES, contact your administrator.

3 Double-click the Fiery ES icon to display active print connections.

Note: For a description of each print connection, see Configuration and Setup.

You must now create a printer port and install the printer driver from the User Software DVD.

Note: You cannot use Point and Print to install the driver and configure the printing connection to the Fiery ES
in a single procedure.

4 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to
the Print Drivers\Driver_Installer folder, and double-click setup.exe.
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5 Select the printer driver language in the Fiery Driver Installer dialog box, and click Next.
The Fiery Driver Installer installation wizard appears.

6 Click Next to install the Fiery Driver Installer on your computer.

7 Read the license agreement, click I accept the terms of the license agreement and click Next.

8 Click Next in the Welcome to the Add Printer Wizard dialog box.

9 To add a local printer on the Windows client computer, do one of the following:

• Windows 8.1/8/Server 2012/Server 2012 R2: Select Add a local printer or network printer with manual settings.

• Windows 7/Server 2008 R2: Select Add a local printer.

• Windows Vista/Server 2008: Select Add a local printer.

10 Select Create a New Port, select Local Port from the Type of port menu, and then click Next.

11 In the Port Name dialog box, type the name of the Fiery ES, followed by the printing connection, and click OK.
Enter the port name as follows: \\Aero\print where Aero is the name of the Fiery ES and print is the printing
connection.

12 Click Have Disk in the dialog box displaying lists of manufacturers and printers.
You will now install the printer driver from the User Software DVD.

13 Browse to the Print Drivers\Ps_drvr folder.

14 Make sure oemsetup.inf or oemsetup is selected and click Open.

15 Verify the path is correct in the Install From Disk dialog box and click OK.

16 Follow the on-screen instructions.

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the Fiery ES, if your
administrator has turned on access to WebTools.
For information about Setup, see Configuration and Setup.
For information about setting up and starting WebTools, see Utilities.

1 Start your Internet or intranet browser and type the DNS name or IP address of the Fiery ES.

2 Click the Downloads tab.

3 Click the link for the item that you want to install.
For Windows printer drivers, click the Printer Files link under the Windows heading.

4 If a dialog box prompts you to open the file or save it to disk, save it to disk.

5 Browse to the location where you want to save the PRNTDRV.EXE file and click Save.
The file is downloaded from the Fiery ES. This compressed file is an archive that contains multiple files.
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6 Double-click the PRNTDRV.EXE file to extract the files.
Depending on your operating system, you might be prompted to select a location to extract the files.
After the files are copied to the specified location, the Fiery Driver Installer starts automatically.

Note: The User Account Control (UAC) feature is available on Windows 8.1, Windows 8, Windows 7, Windows
Vista, Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2
computers. You must be the administrator or a user with Administrator privileges to install printer drivers.
Right-click PRNTDRV.EXE and select Run as administrator.

7 Install the printer driver.
Follow the instructions for your operating system to install the printer driver. The procedures are the same as for
installing from the DVD. (See Install and complete the print connection for Windows on page 12.)
For more information, see Command WorkStation Help.

Install and complete the print connection for Windows

You can install the printer driver from the User Software DVD or download and install it from WebTools.
When you install the printer driver and complete the print connection, you are automatically creating a local printer
(Port 9100). You can modify the port connection later, according to your network type.

1 To install the printer driver, do one of the following:

• Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse
to the Windows_User_SW\Print Drivers\Driver_Installer folder, and double-click setup.exe.

Note: When you insert the User Software DVD into the DVD drive, the Fiery Driver Installer may start
automatically.

• From WebTools, after the printer driver is copied to the specified location, the Fiery Driver Installer starts
automatically.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
The Fiery Driver Installer - InstallShield Wizard appears.

3 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

4 Read the license agreement, click I accept the terms of the license agreement and click Next.

5 For these Windows operating systems, do one of the following:

• Windows 8.1/8/Server 2012/Server 2012 R2: Click The printer that I want isn’t listed.

6 To add a local printer on the network, do one of the following:

• Windows 8.1/8/Server 2012/Server 2012 R2: Select Add a local printer or network printer with manual settings.

• Windows 7/Server 2008 R2: Select Add a local printer.

• Windows Vista/Server 2008: Select Add a local printer.

7 Select Create a new port, select Standard TCP/IP Port from the Type of port menu, and then click Next.

Note: The WSD port is supported on Windows 7 or later.
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8 Do one of the following:

• Windows 8.1/8/Server 2012/Server 2012 R2: Type the host name or IP address of the Fiery ES. Select the Query
the printer and automatically select the driver to use check box. Click Next and proceed to step 9.

• Windows 7/Vista/Server 2008/Server 2008 R2: Type the host name or IP address of the Fiery ES, and then click
Next. Proceed to step 9.

9 In the Printers box, select your printer and click Next.

Note: Select the printer driver with “US” for North America (the default Document Size is Letter) or without
“US” for International (the default Document Size is A4).

10 Type a name for the Fiery ES in the Printer name field, and click Next.
This name is used in the Devices and Printers (or Printers and Faxes or Printers) folder and the queues window.

11 Follow the on-screen instructions.
Indicate whether you want to make it the default printer. Do not share the printer and do not print a Test Page at
this time.
Continue with the printer driver installation and at the last screen, click Finish.
The necessary files are installed on your hard disk drive.

12 Configure the installable options.
For more information, see Configure installable options on Windows client computers on page 23.

13 To set up a connection other than Port 9100, see Set up Standard TCP/IP Port (Raw or LPR) printing
connections on Windows client computers on page 18.

14 To use the printer driver, you must select the following options on the Advanced tab of the printer driver:

• Spool print documents so program finishes printing faster

• Start printing immediately

• Print spooled documents first

15 Click Apply in the Fiery ES Properties dialog box, and then click OK.

Install the printer driver on a 64-bit Windows computer from a 32-bit Windows Server 2008
computer

If your network users print to the Fiery ES with Windows Server 2008 (32-bit) print sharing, and 64-bit Windows 7
users are also on your network, you must add the 64-bit printer driver to the Windows Server 2008 (32-bit)
computer, so that users can install the printer driver on their computers using Point and Print.
We do not recommend installing the printer driver from a server (32-bit) to client computer (64-bit). When you
install the 64-bit printer driver to the computer (32-bit), the Windows Server 2008 (64-bit) CD is required.

1 Install the Fiery ES printer driver on the Windows Server 2008 computer.
For instructions, see Install and complete the print connection for Windows on page 12.
During the installation, when asked if you want to share the printer, select Yes.
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2 In the Printers window, right-click the printer that you just installed and select Server Properties.

3 Click the Drivers tab, click Add and then click Next.

4 Select the x64 components check box.

5 Click Have Disk and browse to the Print Drivers\Ps_drvr folder on the User Software DVD, and select the
oemsetup.inf file.

6 If you are installing from the files you downloaded from the Fiery ES using the Downloads tab in WebTools,
browse to Print Drivers\Ps_drvr, make sure that oemsetup.inf is selected and click Open.

7 Follow the on-screen instructions to complete the printer driver installation.

Install and connect to a virtual printer

A virtual printer allows you to print to the Fiery ES using a predefined set of job settings.
You do not have to set print options manually. Before you can print to a virtual printer, the administrator must
create and configure the virtual printer using Command WorkStation. After the virtual printer is set up, you can
install the printer driver and printer description files on your computer from the Fiery ES using Point and Print.
For more information about setting up virtual printers, see Command WorkStation Help.
When you install the printer driver with Point and Print, you cannot configure installable options manually.
Installable options are configured automatically. The installed options are displayed in the printer driver when you
select the Two-Way Communication option.

Set up a virtual printer on Windows computer with the User Software DVD

Complete the installation and setup of the virtual printer on a Windows computer by installing the printer driver
from the User Software DVD.

1 To navigate to computers and devices on your network, do one of the following:

• Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

• Windows 8/Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the
Search charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up
or down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in
the results. Click Devices and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Sharing Center, and then click the View
network computers and devices link from the Network and Sharing Center list.

• Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

2 Search for the Fiery ES on the network using either its name or IP address.
If you cannot locate the Fiery ES, contact your administrator.
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3 Double-click the Fiery ES icon to display active print connections.
Virtual printers are listed along with the Print queue, Hold queue, and Direct connection (if those connections
are active). Virtual printers are usually assigned names that indicate the type of job for which they are set up.

4 Insert the User Software DVD into the DVD drive, type the name of the DVD drive (for example, D:\), browse to
the Print Drivers\Driver_Installer folder, and double-click setup.exe.

5 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.
The Fiery Driver Installer installation wizard appears.

6 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

7 Read the license agreement, click I accept the terms of the license agreement and then click Next.

8 For these Windows operating systems, do one of the following:

• Windows 8.1/8/Server 2012/Server 2012 R2: Click The printer that I want isn’t listed.

9 To add a local printer on the network, do one of the following:

• Windows 8.1/8/Server 2012/Server 2012 R2: Select Add a local printer or network printer with manual setting.

• Windows 7/Server 2008 R2: Select Add a local printer.

• Windows Vista/Server 2008: Select Add a local printer.

10 Select Create a new port, select Standard TCP/IP Port from the Type of port menu, and then click Next.

11 In the Port Name dialog box, type the name of the virtual printer for the printing connection, and click OK.

12 In the Printers box, select your printer and click Next.

Note: Select the printer driver with “US” for North America (the default Document Size is Letter) or without
“US” for International (the default Document Size is A4).

13 Type a name for the virtual printer in the Printer name field, and click Next.
This name is used in the Printers window and the queues window.

14 Follow the on-screen instructions.
Indicate whether you want to make the virtual printer the default printer. Do not share the printer and do not
print a Test Page at this time.
Continue with the printer driver installation and at the last screen, click Finish.
The virtual printer is displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.
You can print to a virtual printer as you would print to any other printer. Depending on how the virtual printer is
configured, you may not be able to set some print options.

Note: If you use Command WorkStation to import a PostScript file to a virtual printer and the file already
specifies the number of copies, the setting for the number of copies in the PostScript file takes precedence over
the number of copies set in the virtual printer.
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Turn on Two-Way Communication on Windows client computers

You must turn on the Two-Way Communication option to automatically update your printer driver to reflect the
options currently installed on the printer.

Note: You must log on with Administrator privileges to add or change the installable options after the Windows 8.1,
Windows 8, Windows 7, Windows Vista, Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, or
Windows Server 2012 R2 printer driver is installed. (See Configure installable options on Windows client computers
on page 23.)

1 Navigate to the devices and printers on your network.

• Windows 8.1/Server 2012 R2: Press the Windows logo key on the keyboard to open the Start screen. From the
desktop, click the Start button in the lower-left corner of the screen. Click Control Panel and then click Devices
and Printers.

• Windows 8/Server 2012: Press the Windows logo key on the keyboard to open the Start screen. Open the
Search charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up
or down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in
the results. Click Devices and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Sharing Center, and then click the View
network computers and devices link from the Network and Sharing Center list.

• Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 Right-click the Fiery ES icon and choose Printer properties or Properties.

3 Click the Installable Options tab.

4 Select the Two-Way Communication check box.

5 Type the Fiery ES IP address or DNS name.

6 Select Update Fiery Driver When Opened to display the current default settings for the printer when the printer
driver is opened.

7 Click Update.

Note: To confirm that Two-Way Communication is turned on, click the About tab and check that the Fiery ES
name and other server information are displayed.

8 Click Apply, and then click OK.
You must click OK for the printer driver to reflect the correct installable options.
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Uninstall printer drivers from Windows client computers

The Printer Delete Utility is installed and used locally to uninstall printer drivers from a Windows client computer.
You do not need to connect to the Fiery ES before you use the software.
1 Install the Fiery Printer Delete Utility using one of the following methods:

• Download the Client Software Installer for Windows from WebTools.
Start your Internet or intranet browser and type the DNS name or IP address of the Fiery ES. Click the
Downloads tab. Click the link to install and follow the on-screen instructions.

• Insert the User Software DVD into the DVD drive of the computer.
The Fiery Installer starts automatically.

2 In the window that appears, select Modify, and then click Next.

3 Select the Fiery Printer Delete Utility check box, and follow the on-screen installation instructions.

4 Click Start, select Programs or All Programs, and then select Fiery.

5 Select Printer Delete Utility.
Any Fiery ES printer drivers found on your computer are listed.

6 Do one of the following:

• To delete a printer, select the check box next to the printer name and click Delete the Selected Printers.

• To delete all of the installed printer drivers, select the Delete All Printer Drivers check box, and click OK.

7 When you finish deleting printer drivers, click Exit.
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Setting up Windows computers for printing

After the printer driver is installed on the Windows client computer, you need to configure the proper connection
for your networked Fiery ES printer.
To print from Windows computers, you or the administrator must perform the following tasks to set up a
connection:

• Set up network servers, if any.

• Set up the Fiery ES to accept print jobs from your computer.

• Configure a port on each Windows computer for the network type.

Setting up printing connections on Windows client computers

The print connections must be set up on the Windows client computers.
The Fiery ES supports the following printing connections:

• SMB

• Standard TCP/IP (RAW or LPR)

• IPP or IPP over SSL

• FTP

• WSD

Set up Standard TCP/IP Port (Raw or LPR) printing connections on Windows client
computers

After you install the printer driver, you can add or configure the Setup for the Standard TCP/IP Port (Raw or LPR)
connection on a Windows client computer.
To complete the Standard TCP/IP Port (Raw or LPR) connection, do the following:

• Prepare the Fiery ES to accept print jobs using Standard TCP/IP Port (Raw or LPR) protocols.

• Turn on LPD or Port 9100 on the Fiery ES.

• Configure the computer for the TCP/IP connection.

For more information about Setup, see Command WorkStation Help.
Before you complete the following procedure, contact your system administrator for the IP address assigned to the
Fiery ES.
The TCP/IP protocol should be installed as a default on the Windows computer. For Port 9100, you can set up the
connection and install the printer driver in one procedure.

Note: You can also set up the LPR Port connection by installing Print Services for UNIX, which is supplied as an
add‑on Windows component. For more information, see the documentation that accompanies Windows.
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1 Navigate to the devices and printers on your network.
The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 Right-click the Fiery ES icon and choose Printer properties or Properties.

3 Click the Ports tab.

4 To add a new port, click Add Port.
To change the port settings, proceed to step 10.

5 In the Printer Ports dialog box specify the port type, do one of the following:

• Select Standard TCP/IP Port from the list of Available port types and click New Port.

• Double-click Standard TCP/IP Port in the list.

The Add Standard TCP/IP Printer Port Wizard dialog box appears.
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6 Click Next.

7 Type the Fiery ES IP address.

8 Click Next.

9 Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box, and then click Close in the Printer
Ports dialog box.
To change the default setting, proceed to step 10.
If you do not want to change the default setting, the setting is now completed.

Note: Port 9100 was set as the default setting in Install and complete the print connection for Windows on page
12.
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10 Click Configure Port on the Ports tab of the Properties dialog box.

11 To set up the port settings, do one of the following:

• To use LPR printing, select LPR in the Protocol area and LPR Byte Counting Enabled in the LPR Settings area.

Note: You can also proceed without selecting LPR Byte Counting Enabled.

• To use Port 9100 printing, select Raw in the Protocol area.
The port number 9100 automatically appears in the Raw Settings area. This is the default port number. You
can print to the printer connection selected for Port 9100 printing on the Fiery ES.
To specify a specific port number, see the following step.

12 Type the name of the print connection.
For Port 9100, type the following port numbers for each print connection in the Raw Settings area:

• Fiery ES default: 9100
• direct: 9101
• print: 9102
• hold: 9103

Note: Type the number exactly as shown.

13 When the SNMP Status Enabled check box is selected, spooling is stopped if the printer driver or spooler detects
an error status on the Fiery ES.

Printing

Windows for Fiery ES

21



14 Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

Note: The Fiery ES supports printing in the IPv6 environment on Windows 8.1, Windows 8, Windows 7,
Windows Vista, and Windows Server 2008/2008 R2/2012/2012 R2.

15 Click Apply in the Fiery ES Properties dialog box, and then click OK.

Complete IPP connections on Windows client computers

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery ES over the Internet from Windows
computers.
Before you begin, perform the following tasks:

• Make sure that the Fiery ES is configured for TCP/IP printing and IPP printing. (See Command WorkStation
Help.)

• Specify the printing destination on your computer.
IPP over SSL connections is supported.

Note: Using IPP over SSL connection requires certificates on Windows 8.1/8/7 and Windows Server 2008 R2/Server
2012/Server 2012 R2. For information on certificate creation, see Configuration and Setup. You can manage
certificates from Configure. (See Command WorkStation Help.)

1 Navigate to the devices and printers on your network.
The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 To add a printer, do one of the following:

• Click Add a printer, and then select Add a network, wireless, or Bluetooth printer or Add a network printer.

• Double-click the Add Printer icon, click Next, and then select Network printer and click Next.

3 To search for a printer on the network, do one of the following:

• Windows 8.1/8/7/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2: If the printer search takes a long
time, click Stop, and then click The printer that I want isn’t listed.

• Windows Vista: Select Connect to a printer on the Internet or your intranet.
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4 To connect to a printer on the network, do one of the following:

• Windows 8.1/8/7/Server 2008/Server 2008 R2/ Server 2012/Server 2012 R2: Click Select a Shared printer by
name, and in the URL field, type the IP address or DNS name of the Fiery ES, followed by the name of the
connection (print, hold, or direct).
For example, http://10.10.10.150/ipp/print or http://DNS name of server/ipp/print sends the job to the
Print queue on the Fiery ES.

Note: The URL for the printer is not case-sensitive.

• Windows Vista: In the URL field, type the IP address or DNS name of the Fiery ES, followed by ipp/ and then
the name of the connection (hold, direct, print, or name of virtual printer).
For example, http://10.10.10.150/ipp/print, http://DNS name of the server/ipp/print or ipp://10.10.10.150
sends the job to the Print queue on the Fiery ES.
For IPP over SSL, type https, instead of http.

Note: The ipp/print in the example is case-sensitive.

5 Click Next.

6 To install the printer driver, do one of the following:

• Windows 8.1/8/7/Server 2008/Server 2008 R2/Server 2012/Server 2012 R2: Click Install driver.

• Windows Vista: Click OK.

7 If you are installing the PostScript printer for the first time, follow the procedure Install and complete the print
connection for Windows on page 12.

8 Indicate whether you want to make the Fiery ES the default printer and then click Next.

9 Click Finish.

Configure installable options on Windows client computers

After you complete the printer driver installation, you must configure the Fiery ES for the options installed on the
printer to allow the Fiery ES to take advantage of the printer options.
Configure the options manually, or for TCP/IP network connections, use the Two-Way Communication option to
configure the options automatically.

Note: When you configure installable options manually, make sure to leave Two-Way Communication and Update
Fiery Driver When Opened options unchecked.
For information about specifying installable options, see printer driver Help.

Note: The User Account Control (UAC) feature is available on Windows 8.1, Windows 8, Windows 7, Windows
Vista, Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2
computers. You must log on with Administrator privileges to add or change the installable options after the printer
driver is installed.

1 Navigate to the devices and printers on your network.
The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.
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2 For Windows computers with User Account Control, right-click the Fiery ES icon, select Run as administrator,
and then select Printer properties or Properties.
The User Account Control dialog box opens.

3 Select the User that has administrator privileges, type the password, and then click OK.

4 Right-click the Fiery ES icon and choose Printer properties or Properties.

5 Click the Installable Options tab and make your selections.

6 Click Apply, and then click OK.
You must click OK for the printer driver to reflect the correct installable options.

Note: The Installable Options are not reflected correctly if you close the dialog box by clicking the Cancel key or
the Close button.

Configure installable options for printer drivers installed with the Add Printer Wizard on Windows
client computers

After you install the printer driver, you must configure the installable options.
If you install the printer driver from Add Printer Wizard and then use Two-Way Communication to configure the
installable options, the installable options are not configured properly.

1 After you install the printer driver, right-click the Fiery ES icon, select Printer properties, click the Installable
Options tab, and then select your installable options.

2 Click Apply, and then click OK.
You must click OK for the printer driver to reflect the correct installable options.

Printing from Windows client computers

You can print to the Fiery ES just as you would print to any other printer from a Windows application.
You can print from a networked Windows computer or a computer using Windows (WINS) printing. Select the
Fiery ES as the current printer in the Printer Name list, specify print options, and then print the document from the
application.
The following list includes other methods to print to the Fiery ES and describes where to find information about
these features:

• Downloading files to the Fiery ES with the Docs tab in WebTools. (See Utilities.)

• Printing documents with E-mail Services. (See E-mail Service on page 56.)

• Printing documents with Hot Folders. (See Hot Folders Help.)

• Printing documents with Command WorkStation. (See Utilities.)

• Printing with Windows servers connected to the Fiery ES. (See Configuration and Setup.)

• Printing documents on the USB flash drive to the Fiery ES. (See Printing from a USB flash drive on page 58.)
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• Printing documents with PrintMe cloud printing. (See PrintMe cloud printing on page 63.)

• Printing documents with Web Services Device (WSD) printing. (See Web Services for Devices printing on page
66.)

The following list includes information about printing and saving files to the Fiery ES and describes where to find
information about these features:

• Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)

• Printing jobs from Windows applications. (See Print jobs from Windows applications on page 25.)

• Specifying default print options. (See Specify default print options for print jobs on Windows client computers
on page 28.)

• Customize the Quick Access icon. (See Customize the Quick Access icon in the Windows printer driver on page
30.)

• View the printer status. (See View the printer status on page 30.)

• Save files to print to a remote location. (See Saving files to print at a remote location on page 30.)

• Define and print custom page sizes. (See Defining and printing custom page sizes on page 102.)

Print jobs from Windows applications

To print from Windows applications, install the PostScript printer driver, and then specify print options for a
particular job before sending it to the Fiery ES for printing.
Be sure to configure the options on the Advanced tab of the printer driver after installation is complete. (See 
Installing Windows printer drivers on page 9.)
If you print to a virtual printer, you may not be able to set some print options, depending on how the virtual printer
is configured.
Some print options that are selectable from an application are similar to print options that are specific to the Fiery
ES and the printer. In these cases, use the print options specific to the Fiery ES and the printer. These options appear
on the Fiery Printing tab. The application may not set up the file properly for printing on the Fiery ES, resulting in
unexpected finishing, printing errors, or longer processing time.
If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.
Some print options, such as expert color settings and VDP master information, are available only if Two-Way
Communication is turned on or a particular installable option is configured. For information about Two-Way
Communication, see printer driver Help. (See Configure installable options on Windows client computers on page
23.)
If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See 
Print options and default settings on page 68.)

Set print options for a specific print job with the Windows printer driver

After you install the Windows printer driver on the client computer, you can set print options for a print job.
1 In your application, select File > Print, and select the Fiery ES as your printer.
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2 Click Properties.

3 Click the Fiery Printing tab.

Callout Refers to

1 Print option icons

2 Active area

3 Printer Status

4 Presets (Job Templates), see Help

5 Customize (Shortcuts), see Help

6 Job View

7 Help

The Fiery Printing tab serves as the control center for all frequently used printing functions.
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When you save the print options in a preset, the following option settings are not reflected:

• Job Info options: Secure print, User Authentication password, Department name, Account password,
Authentication server name, Project code, and Project password.

• Layout option: Impose

For information about using presets, see printer driver Help.

Note: For a list of print options, see Print options and default settings on page 68.

4 Specify print options and settings for your job.
The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

• Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
print option can be added or removed from the view. The Quick Access tab lets you find print options quickly
without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon in the Windows
printer driver on page 30.)

• Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 68.)

• Media- Attributes and sources of paper to print and insert. (See Media options on page 72.)

• Layout- Defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
75.)

• Color- Color settings and graphic arts features (when turned on). (See Color options on page 81.)

• Image- All Image Quality settings supported by the connected Fiery ES and printer. (See Image options on
page 87.)

• Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in Fiery ES Printer Setup but can be changed
from Command WorkStation. (See Finishing options on page 89.)

• VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (See Variable
Data Printing (VDP) options on page 91.)

• Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 93 or printer driver Help.)

• Printer- Information about printer status that includes the current paper and toner levels. (See View the printer
status on page 30 or printer driver Help.)

5 After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.
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Specify default print options for print jobs on Windows client computers

You can set the default print options for Windows print jobs using the Windows printer driver.
1 Navigate to the devices and printers on your network.

• Windows 8.1/Server 2012 R2: Press the Windows button on the keyboard to open the Start screen. Click
Control Panel and then click Devices and Printers.

• Windows 8/Server 2012: Press the Windows button on the keyboard to open the Start screen. Open the Search
charm by moving the mouse pointer to the upper-right or lower-right corner of the screen, move it up or
down, and click Search. Type Control Panel in the search box, click Apps, and then click Control Panel in the
results. Click Devices and Printers.

• Windows 7/Server 2008 R2: In Control Panel, click Network and Sharing Center, and then click the View
network computers and devices link from the Network and Sharing Center list.\

• Windows Vista/Server 2008: In Control Panel, double-click Network and Sharing Center, and then click the
View computers and devices link.

The printers are displayed in the Devices and Printers (or Printers and Faxes or Printers) folder.

2 Right-click the Fiery ES icon and select Printing Preferences.

3 If the Fiery Printing tab is not displayed, click it.
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Callout Refers to

1 Print option icons

2 Active area

3 Printer Status

4 Presets (Job Templates), see Help

5 Customize (Shortcuts), see Help

6 Job View

7 Help

4 Specify the default settings for your print job. (See Set print options for a specific print job with the Windows
printer driver on page 25.)

5 Click OK to close the dialog box.
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Customize the Quick Access icon in the Windows printer driver

The Quick Access icon can be customized with print options that you use frequently.
This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.
When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1 In your application, select File > Print and select the Fiery ES as your printer.

2 Click Properties.

3 Click the Fiery Printing tab.

4 Click Customize to specify the options shown in the Customize Quick Access dialog box.

5 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

6 Click OK to save your changes.
For more information about Quick Access, see printer driver Help.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the Fiery ES and display them in
the printer driver with the Two-Way Communication option.
You can retrieve its color settings from the Fiery ES and display them in the printer driver.
For information about monitoring the status of the printer, see printer driver Help.

Saving files to print at a remote location

If you do not have an Fiery ES on site and are preparing files for a service bureau or other location, print the final files
to the File port (as opposed to one of the local ports).
You can also print to the File port to create a file to download using the Docs tab in WebTools. For instructions on
printing to the File port, see the documentation that accompanies Windows.
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Mac OS for Fiery ES

The Fiery ES can be set up as a printer on a Mac OS computer by installing the printer driver that correspond to
your printer and setting up the Fiery ES for printing.
Printer drivers provide a way to communicate information about print jobs between your applications, the Fiery ES,
and the printer.

Note: Select the printer driver with “US” for North America (the default Document Size is Letter) or without “US”
for International (the default Document Size is A4).

Installing printer driver on a Mac OS computer

Installing the printer driver is the first step to set up the Fiery ES as a printer.

Note: If the Fiery ES printer driver is already installed, you must uninstall it before you install a new driver. (See 
Uninstall printer driver from a Mac OS computer on page 32.)

Install Mac OS printer driver from the User Software DVD

The User Software DVD provides the software for Mac OS computers, such as the printer driver.
1 Quit all open applications.

2 Insert the User Software DVD into the DVD drive.

3 Open the Mac_User_SW folder.

4 Double-click Fiery Printer Driver.dmg.

5 Double-click Fiery Printer Driver.pkg and click Continue.

6 Read the license and click Continue.

7 Follow the on-screen instructions.
The Fiery Printer Driver Installer installs the printer driver that correspond to the Fiery ES.

8 If you can find the Fiery ES from the list of printers by Network Discovery, do one of the following:

• Select the Fiery ES, and continue to install the printer driver by specifying the Print queue. The printer uses the
Bonjour connection.

• If you specify the Hold queue, the printer uses the LPD (LPR) protocol.
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9 If you cannot find the Fiery ES (on a different subnet) and you want to use Port9100/LPR/ipp or want to connect
to a virtual printer, then click Install Printer Driver Only.
You need to associate the printer driver from System Preferences > Printers & Scanners with the Fiery ES.

Download printer drivers with WebTools

WebTools allow you to download printer driver installers to your computer directly from the Fiery ES, if your
administrator has configured access to WebTools.
For more information about setting up and starting WebTools, see Utilities.

1 Start your Internet or intranet browser and type the DNS name or IP address of the Fiery ES.

2 Click the Downloads tab.

3 Click the Printer Files link for Mac OS X.
A file named Fiery Printer Driver.dmg is downloaded to your desktop.

Note: If the file is not on the desktop, open the Downloads folder.

4 Double-click Fiery Printer Driver.dmg.

5 Double-click Fiery Printer Driver.pkg and click Continue.

6 Read the license and click Continue.

7 Follow the on-screen instructions.

Uninstall printer driver from a Mac OS computer

The Fiery Software Uninstaller utility is installed and used locally on your Mac OS computer.
You do not need to connect to the Fiery ES before you use the software.

Install and use the Fiery Software Uninstaller utility

1 To copy the Fiery Software Uninstaller.dmg to your desktop, do one of the following:

• Copy it from the User Software DVD.

2 Double-click Fiery Software Uninstaller.dmg.
The Fiery Software Uninstaller opens in the Finder, displaying the Fiery Software Uninstaller icon and an arrow
pointing to a link to the Applications folder.

3 Drag the Fiery Software Uninstaller icon to the Applications folder.

4 Open the Applications folder and double-click the Fiery Software Uninstaller icon.

5 Click the Printers tab if it is not already selected.

6 Select a printer from the Installed Printers list.
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7 Do one of the following:

• Click Remove Printer and Driver to remove the printer along with its printer driver files.
If you want to remove the printer and the associated printer driver files, you can select only one printer at a
time.

• Click Remove Printer to remove the printer from the Installed Printers list only, but leave the printer driver files
installed.
The utility can remove only printers that are not currently in use or open on the Dock.

Note: If more than one printer uses the same printer driver file, removing the printer driver file also removes all
printers using that printer driver.

8 To confirm that you want to delete the printer, type the password for your Mac OS computer in the dialog box
and click OK.

9 Click the Drivers tab to view the installed printer drivers.

10 Close the Fiery Software Uninstaller dialog box.

Delete the Fiery Software Uninstaller utility

• Delete the Fiery Software Uninstaller icon from the Applications folder.

Set up Mac OS computers for printing

After the printer driver that corresponds to your printer has been installed, you must set up the Mac OS computer
for printing to the Fiery ES.

Set up printing on a Mac OS X v10.10 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.10. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.10 client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.
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Set up the Fiery ES with Printers & Scanners on a Mac OS X v10.10 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.
In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer

Add a printer with the Default connection on a Mac OS X v10.10 client computer

You can add a printer with the Default connection on a Mac OS X v10.10 client computer.
1 Click the Default icon in the Add dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.10.
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2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected. If your administrator configured the Secure Access printing at
the Fiery ES, the printer driver for Secure Access printing is selected.

3 Click Add.
The Fiery ES name appears in the list of printers.

4 Select Fiery ES.

5 Click Options & Supplies, and then click the Options tab.

6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver Help.

Obtain the IP address of the Fiery ES on a Mac OS X v10.10 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a Mac OS X v10.10 client computer, you can
find out the IP address of the Fiery ES from the printer’s Webpage.
1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver Help.

6 Click the Close button to exit WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.
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Add a printer with the IP Printer connection on a Mac OS X v10.10 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.10 client computer.
1 Click the IP icon in the Add dialog box.

2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. Do not leave the Queue field empty.
Specify either the Print queue or Direct connection. Do not specify the Hold queue.
The IP address or DNS name appears in the Name field.

3 Choose Select Software from the Use menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.
The Fiery ES with its IP address appears in the list of printers.
For information about configuring installable options, see printer driver Help.
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Set up printing on a Mac OS X v10.9 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.9. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.9 client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.

Set up the Fiery ES with Printers & Scanners on a Mac OS X v10.9 client computer

1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Click the + button to add a printer.
In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer
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Add a printer with the Default connection on a Mac OS X v10.9 client computer

You can add a printer with the Default connection on a Mac OS X v10.9 client computer.
1 Click the Default icon in the Add dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.9.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected. If your administrator configured the Secure Access printing at
the Fiery ES, the printer driver for Secure Access printing is selected.

3 Click Add.
The Fiery ES name appears in the list of printers.

4 Select Fiery ES.

5 Click Options & Supplies, and then click the Options tab.

6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver Help.
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Obtain the IP address of the Fiery ES on a Mac OS X v10.9 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a Mac OS X v10.9 client computer, you can
find out the IP address of the Fiery ES from the printer’s Webpage.
1 Select Apple menu > System Preferences, and then select Printers & Scanners.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver Help.

6 Click File > Close Window to close WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Printers & Scanners dialog box.

Add a printer with the IP Printer connection on a Mac OS X v10.9 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.9 client computer.
1 Click the IP icon in the Add dialog box.

Printing

Mac OS for Fiery ES

39



2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. Do not leave the Queue field empty.
Specify either the Print queue or Direct connection. Do not specify the Hold queue.
The IP address or DNS name appears in the Name field.

3 Choose Select Software from the Use menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Specify the installable option settings in the installable options pane in the Printers & Scanners dialog box, and
then click OK.
The Fiery ES with its IP address appears in the list of printers.
For information about configuring installable options, see printer driver Help.

Set up printing on a Mac OS X v10.8 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.8. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.8 client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.

Set up the Fiery ES with Print & Scan on a Mac OS X v10.8 client computer

1 Select Apple menu > System Preferences, and then select Print & Scan.
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2 Click the + button to add a printer.
In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer

Add a printer with the Default connection on a Mac OS X v10.8 client computer

You can add a printer with the Default connection on a Mac OS X v10.8 client computer.
1 Click the Default icon in the dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.8.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected. If your administrator configured the Secure Access printing at
the Fiery ES, the printer driver for Secure Access printing is selected.

3 Click Add.
The Fiery ES name appears in the list of printers.
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4 Select Fiery ES.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver Help.

Obtain the IP address of the Fiery ES on a Mac OS X v10.8 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a Mac OS X v10.8 client computer, you can
find out the IP address of the Fiery ES from the printer’s Webpage.
1 Select Apple menu > System Preferences, and then select Print & Scan.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver Help.

6 Click File > Close Window to close WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Print & Scan dialog box.
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Add a printer with the IP Printer connection on a Mac OS X v10.8 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.8 client computer.
1 Click the IP icon in the Add dialog box.

2 Do one of the following:

• For LPD printing, select Line Printer Daemon -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect -  Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. Do not leave the Queue field empty.
Specify either the Print queue or Direct connection. Do not specify the Hold queue.
The IP address or DNS name appears in the Name field.

3 Choose Select Printer Software from the Use menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Specify the installable option settings in the installable options pane in the Print & Scan dialog box, and then click
OK.
The Fiery ES with its IP address appears in the list of printers.
For information about configuring installable options, see printer driver Help.
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Set up printing on a Mac OS X v10.7 client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.7. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.7 client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
In the dialog box that appears, select a printer connection.

Set up the Fiery ES with Print & Scan on a Mac OS X v10.7 client computer

1 Select Apple menu > System Preferences, and then select Print & Scan.

2 Click the + button to add a printer.
In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer
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Add a printer with the Default connection on a Mac OS X v10.7 client computer

You can add a printer with the Default connection on a Mac OS X v10.7 client computer.
1 Click the Default icon in the dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the list of printers.
Any published virtual printer is available over LPR and FTP.

Note: SMB printing is not supported for Mac OS X v10.7.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected. If your administrator configured the Secure Access printing at
the Fiery ES, the printer driver for Secure Access printing is selected.

3 Click Add.
The Fiery ES name appears in the list of printers.

4 Select Fiery ES.

5 Click Options & Supplies, and then click the Driver tab.

6 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver Help.
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Obtain the IP address of the Fiery ES on a Mac OS X v10.7 client computer

When the Bonjour connection is used for the Fiery ES printer driver on a Mac OS X v10.7 client computer, you can
find out the IP address of the Fiery ES from the printer’s Webpage.
1 Select Apple menu > System Preferences, and then select Print & Scan.

2 Select the Fiery ES from the list, and then click Options & Supplies.

3 Click the General tab, and then click Show Printer Webpage.

4 Click the Configure tab.

5 Scroll to Network Protocol Setup, locate the IP address for the Fiery ES, and record it for future reference.
The IP address is needed to turn on Two-Way Communication in the printer driver.
For information about Two-Way Communication, see printer driver Help.

6 Click File > Close Window to close WebTools.

7 Click OK to close the Options & Supplies pane.

8 Close the Print & Scan dialog box.

Add a printer with the IP Printer connection on a Mac OS X v10.7 client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.7 client computer.
1 Click the IP icon in the dialog box.
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2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. Do not leave the Queue field empty.
Specify either the Print queue or Direct connection. Do not specify the Hold queue.
The IP address or DNS name appears in the Name field.

3 Choose Select Printer Software from the Print Using menu.

4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Click OK.
The Fiery ES with its IP address appears in the list of printers.

7 Select Fiery ES.

8 Click Options & Supplies, and then click the Driver tab.

9 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver Help.

Set up printing on a Mac OS X v10.6.x client computer

After you have the Fiery ES printer driver installed, you must set up printing to the Fiery ES on a client computer
running Mac OS X v10.6.x. You can add the printer with the LPR, Port 9100 or IPP connection.

Set up the Fiery ES from the Print dialog box on a Mac OS X v10.6.x client computer

1 Open a file in your application.

2 Select File > Print.

3 Select Add Printer from the Printer menu.
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Set up the Fiery ES with Print & Fax on a Mac OS X v10.6.x client computer

1 Select Apple menu > System Preferences, and then select Print & Fax.

2 Click the + button to add a printer.
In the dialog box that appears, select one of the printer connections:

• Default

• IP Printer

Add a printer with the Default connection on a Mac OS X v10.6.x client computer

You can add a printer with the Default connection on a Mac OS X v10.6.x client computer.
1 Click the Default icon in the Add Printer dialog box.

The names of printers with default connections are listed.
The names of the virtual printers appear as printer name : virtual printer name in the Printer Name list.
Any published virtual printer is available over SMB, LPR, and FTP.

2 Select the Fiery ES from the list.
The information about the selected printer appears at the bottom of the Default pane. The appropriate printer
driver for the Fiery ES is automatically selected. If your administrator configured the Secure Access printing at
the Fiery ES, the printer driver for Secure Access printing is selected.

3 Click Add.

4 Click Continue.
The Fiery ES name appears in the list of printers.
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5 Select Fiery ES.

6 Click Options & Supplies, and then click the Driver tab.

7 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver Help.

Add a printer with the IP Printer connection on a Mac OS X v10.6.x client computer

You can add a printer with the IP Printer connection on a Mac OS X v10.6.x client computer.
1 Click the IP icon in the Add Printer dialog box.

2 Do one of the following:

• For LPD printing, select Line Printer Daemon  -  LPD from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field, and then type the print connection (print or hold) or published virtual printer name
in the Queue field.

• For Port 910x printing, select HP Jetdirect - Socket from the Protocol list, type the Fiery ES IP address or DNS
name in the Address field. The Queue field can be left empty.

• For IPP printing, select Internet Printing Protocol - IPP from the Protocol list and type the Fiery ES IP address
or DNS name in the Address field, and then type ipp/ followed by the print connection (print, hold, direct, or
name of virtual printer) in lowercase letters in the Queue field.

Note: The Fiery ES requires a queue name. Do not leave the Queue field empty.
Specify either the Print queue or Direct connection. Do not specify the Hold queue.
The IP address or DNS name appears in the Name field.

3 Choose Select Printer Software from the Print Using menu.
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4 Locate the printer manufacturer or model in the list, select the printer driver, and then click OK.

5 Click Add.

6 Click Continue.
The Fiery ES with its IP address appears in the list of printers.

7 Select Fiery ES.

8 Click Options & Supplies, and then click the Driver tab.

9 Specify the installable option settings, and then click OK.
For information about configuring installable options, see printer driver Help.

Configuring installable options on Mac OS client computers

To use the print options for the printer and Fiery ES appropriately, you must configure the Fiery ES from your
computer for the options that are installed on the printer. Configure the options manually.
For information about configuring installable options, see printer driver Help.

Using Desktop Printer

After adding the Fiery ES to the list of printers in the Printers & Scanners (or Print & Scan, or Print & Fax) dialog box,
you can create and use the Desktop Printer feature.
For information about the Desktop Printer feature, see printer driver Help.

Printing from Mac OS client computers

You can print to the Fiery ES just as you would print to any other printer from a Mac OS application.
Select the Fiery ES as the default printer in the list of printers, specify print options, and then print the document
from the application.
The following list includes other methods to print to the Fiery ES and describes where to find information about
these features:

• Downloading files to the Fiery ES with the Docs tab in WebTools. (See Utilities.)

• Printing documents with Hot Folders. (See Hot Folders Help.)

• Printing documents with Command WorkStation. (See Utilities.)

• Achieving optimal printing results from applications. (See Color Printing and Fiery Color Reference.)

• Selecting the Fiery ES in the Printers list. (See Select the Fiery ES as the default printer on a Mac OS client
computer on page 51.)

• Printing jobs from Mac OS applications. (See Set print options and printing from Mac OS applications on page
51.)
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• Customizing the Quick Access view. (See Customize the Quick Access pane in the Mac OS printer driver on page
54.)

• Viewing the printer status. (See View the printer status on page 55.)

• Defining and printing custom page sizes. (See Defining and printing custom page sizes on page 102.)

Select the Fiery ES as the default printer on a Mac OS client computer

Before you print a job, you must set the Fiery ES in the Printers list as your default printer.
1 Make sure that the Fiery ES is connected to the network and turned on.

2 Select Apple menu > System Preferences, and then select Printers & Scanners (or Print & Scan, or Print & Fax).
The printers that are set up for printing are listed. The virtual printers that are configured at the Fiery ES and set
up for printing are also listed.

3 Select Fiery ES from the Default Printer menu.

4 Close the window.

View queries in the Print Queue on a Mac OS v10.7 or later client computers

When the printer driver establishes communication with the Fiery ES on a Mac OS X v10.7 or later client computer,
the queries are listed as jobs in the Print Queue.
To view the queries, open the Print Queue.

• Select Apple menu > System Preferences > Print & Scanners (or Print & Scan), then select the Fiery ES from the
list of printers, and click Open Print Queue.
The queries are not real jobs and they will disappear from the Print Queue after they are completed.

Set print options and printing from Mac OS applications

To print from Mac OS client computers, install the printer driver that corresponds to your printer.
In Mac OS applications, print options are set from the Print dialog box. (See Installing printer driver on a Mac OS
computer on page 31.)
Some print options that are selectable from an application are similar to print options that are specific to the Fiery
ES and the printer. In these cases, use the print options specific to the Fiery ES and the printer. These options appear
in the Fiery Features pane and/or in the Printing Preferences window. The application may not set up the file
properly for printing on the Fiery ES, resulting in unexpected finishing, printing errors, or longer processing time.
If you specify incompatible print settings when printing a document, the Conflict dialog box provides instructions to
resolve the conflict.
Some print options are available only if Two-Way Communication is turned on or a particular installable option is
configured.

Printing

Mac OS for Fiery ES

51



You can retrieve its expert color settings from the Fiery ES when Two-Way Communication is turned on and display
them in the printer driver.
For information about Two-Way Communication, see printer driver Help. (See Configuring installable options on
Mac OS client computers on page 50.)
If you select Printer’s default, the job prints according to the settings that the administrator specified in Setup. (See 
Set print options and print a job from a Mac OS X client computer on page 52.)

Set print options and print a job from a Mac OS X client computer

You use the printer driver to specify print options for a particular job and then print it to the Fiery ES.
1 In your application, select File > Print, and select the Fiery ES as your printer.

2 Select Fiery Features from the drop-down list.
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Callout Refers to

1 Fiery Features

2 Customize (Shortcuts), see Help

3 Full Properties

4 Presets (Job Templates), see Help

5 Two-Way Communication

When you save the print options in a preset, the following option settings are not reflected:

• Job Info options: Secure print, User Authentication password, Department name, Account password,
Authentication server name, Project code, and Project password.

• Layout option: Impose

For information about using presets, see printer driver Help.

Note: You cannot import or export Local Presets to or from the Mac OS X v10.7 printer driver.
For a list of print options, see Print options and default settings on page 68.

3 Click Full Properties in the Quick Access pane to specify print options and settings for your job.
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The print options are grouped by categories. Each group or tab contains print options that are similar or
complement one another.

• Quick Access- Contains duplicate print options from the other job properties groups. It is customizable, so any
job override print option can be added or removed from the view. The Quick Access pane lets you find print
options quickly without browsing through all of the Job Properties tabs. (See Customize the Quick Access icon
in the Windows printer driver on page 30.)

• Job Info- All information about the job, including user information that may be required for user
authentication and job handling. (See Job Info options on page 68.)

• Media- Attributes and sources of paper to print and insert. (See Media options on page 72.)

• Layout- Layout defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray Alignment. (See Layout options on page
75.)

• Color- Color settings and graphic arts features (when turned on). (See Color options on page 81.)

• Image- All Image Quality settings supported by the connected Fiery ES and printer. (See Image options on
page 87.)

• Finishing- Print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options. These options override settings in Fiery ES Printer Setup but can be changed
from Command WorkStation. (See Finishing options on page 89.)

• VDP- All Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings. (See Finishing
options on page 89.)

• Stamping- All image stamping options that add or hide/remove any image on the job. This also includes
watermark properties that define the placement and style of the watermark. (See Stamping (Watermark)
options on page 93 or printer driver Help.)

• Printer- Information about printer status that includes the current paper and toner levels. (See View the printer
status on page 30 or printer driver Help.)

4 After you specify the print settings, click OK, and then click Print to send your print job.

Note: When you use the Enable job tracking print option, a window is displayed for your job accounting
information.

Customize the Quick Access pane in the Mac OS printer driver

The Quick Access pane can be customized with print options that you use frequently.
This saves time because you do not have to open all of the other print option icons to set the options that you placed
in Quick Access.
When you place a print option in Quick Access, it still appears under its original print option icon. You can set the
option from either location.

1 In your application, select File > Print and select the Fiery ES as your printer.

2 Select Fiery Features from the drop-down list.

3 Click Customize to specify the options shown in the Quick Access pane.
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4 Add or remove a shortcut by selecting one and moving it from the Available Shortcuts list to/from the Current
Shortcuts list.

5 Click OK to save your changes.

Note: The Configure button for Two-Way Communication is not displayed in the Mac OS X v10.7 or later
printer drivers.
For more information about Quick Access, see printer driver Help.

View the printer status

You can retrieve the status and levels of consumable materials of the printer from the Fiery ES and display them in
the printer driver with the Two-Way Communication option.
You can retrieve its color settings from the Fiery ES and display them in the printer driver.
For information about monitoring the status of the printer, see printer driver Help.
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Other Printing Methods

You can print jobs with the Fiery ES printer driver to the Fiery ES, as well as other printing methods, such as
Command WorkStation.

E-mail Service

E-mail Service allows you to control the Fiery ES using your current email infrastructure, print to remote locations,
and bypass firewalls.
E-mail Service is not application-specific. You can use any email infrastructure.
The Fiery ES supports internal address books. Administrators can retrieve, add, delete, and clear addresses from
address books by sending requests through email. (See Configuration and Setup.)
To set up E-mail Service, see Command WorkStation Help.
Use E-mail Service in the following ways:

• Print a job from an email application.
To print with an email client, you send a file as an email attachment. E-mail Service extracts the file and sends it
to the Fiery ES. The attachment can be in any file format the Fiery ES recognizes (PS, PDF, EPS, VDP, or TIFF).

Note: E-mail Service does not process files with .vbs, .exe, or .bat extensions.

• Manage jobs using an email application.
You can manage your print jobs by submitting email commands to the Fiery ES using email.

Printing using an email client

You can submit print jobs to the Fiery ES in the form of an email attachment using your email application.
When you send an email with an attachment, E-mail Service extracts the file and sends it to the Fiery ES Print queue.
The file format must be one supported by the Fiery ES.
By default, anyone can print with an email client, unless the Print address book has been set up by the administrator.
If the Print address book has been set up and your email address is not in it, you cannot send files to the Fiery ES
using email. (See Configuration and Setup.)
When User Authentication is turned on at the Fiery ES, the email attachment must have the appropriate user name
and password when it is printed through email printing. As part of creating the email attachment with the Fiery ES
printer driver, type the appropriate user name and password on the Job Info tab of the printer driver. The user name
and password must match those defined by the administrator in the Users and Groups section of Configure. For
information about Users and Groups, see Command WorkStation Help.

Note: The Direct connection is not supported by the email client feature.
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When the attached job is printed, the email is also printed, which includes the typical header information, such as
subject, date, sender, and so forth.

Print an email attachment with an email client

You can print an email attachment with an email client.
1 Open your email application.

2 Type the Fiery ES email address in the To: line.

3 Type text in the Subject line or leave the Subject line blank.

4 Attach the file that you want to print.
The attachment can be in any file format the Fiery ES recognizes (PS, PDF, EPS, VDP, or TIFF).

Note: If your attachment exceeds the file size limitation set by your email system administrator, the email is not
sent.

5 To identify the job or provide further processing instructions, type text in the body of the message.

Note: HTML-formatted email messages are not supported, and might not print as they appear on the remote
workstation. Send email messages in plain text format.
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6 Send the email.
The file is sent to the Fiery ES and the job is printed. After the Fiery ES receives the job, you receive an email
notification that the print job was accepted. The email provides a job identification (ID). Use job IDs to manage
jobs with email commands. The email notification indicates any current error at the printer. (See Manage print
jobs with email commands on page 58.)
After the job is printed, you receive a second email notification that indicates the job printed successfully.

Manage print jobs with email commands

You can manage your print jobs by submitting commands to the Fiery ES using email.
You can cancel a job, check job status, and get help on a job. When you send a command, the Fiery ES sends an email
response.

1 In your email application, type the Fiery ES email address in the To: line.

2 Type one of the following commands in the Subject line:

• To check the status of a job, type #JobStatus<job id> in the Subject line.
You receive a reply to your job status query. You can only get the status of the job if you sent the job or are an
administrator.

• To cancel a job, type #CancelJob<job id> in the Subject line.
You receive a notification indicating that the job has been canceled and did not print to the Fiery ES. You can
only cancel a job if you sent the job.

• To get help, type #Help in the Subject line.
You receive an email response that contains links that allow you to cancel jobs, check job status, and search
and manage address books. Click any of the links to perform a command.

3 Send the email to the Fiery ES.

Printing from a USB flash drive

You can print files from a USB flash drive to the Fiery ES.
The USB port and automatic printing feature must be enabled in Configure, as described in Configuration and Setup
or Command WorkStation Help.
You can manually print files from a USB flash drive when USB Media Autoprint is disabled in Configure.
Files are automatically processed as soon as you connect the USB flash drive to the Fiery ES. The files can be from
Mac OS or Windows computers, and can be any of the supported file types (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or
XLS).
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You can set up folders in the root of the flash drive to correspond to the Fiery ES queues:

• To send files to one of the standard print queues (print, hold, or direct) on the Fiery ES, create folders with those
names in the root of the flash drive, and then drop the files into the folders.

• To print any file from the USB flash drive, manually select the file to print, specify where to send it, and select
print options.

• Files that are placed at the root level of the USB flash drive are sent to the Print queue.

• To send files to a virtual printer that is configured on the Fiery ES, create a folder with the virtual printer name in
the root of the flash drive, and then drop the files into the folder. Verify with your administrator that the virtual
printers are published. For more information about virtual printers, see Command WorkStation Help.

Note: If you have more than 50 published virtual printers, you cannot print from a USB flash drive to a virtual
printer.

Print files automatically from a USB flash drive

You can print files automatically from a USB flash drive only if automatic printing is turned on in Configure.

1 Ensure the USB port and automatic printing are enabled, as described in Configuration and Setup or Command
WorkStation Help.

2 Create folders at the top (root) level of the USB flash drive named print, hold, direct, and the name of any virtual
printer that has been configured and published on the Fiery ES.

3 Save the files (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or XLS) from either the Mac OS or Windows computer to
the USB flash drive, placing the files in the folders that correspond to the action that you want to take.

4 Connect the USB flash drive to the USB port on the Fiery ES.
The files are automatically printed or held according to the folder they are in.
For the location of the USB port, see Configuration and Setup.

5 After the files have arrived in the related queue, remove the USB flash drive from the computer.

Important: Make sure that the USB flash drive is properly stopped before you disconnect it from the
computer.

Print files manually from a USB flash drive

You can manually select files to print from a USB flash drive.
When USB Media Autoprint is disabled in Configure, you must manually select the files that you want to print from
the USB flash drive and specify where you want to send them.

Print with USB Media Server

You can print files from a USB flash drive connected to the Fiery ES from the printer control panel.
1 Ensure the USB port is enabled, as described in Configuration and Setup or Command WorkStation Help.
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2 Insert the USB flash drive into a USB port on the Fiery ES.

3 On the printer control panel, press the Menu button.

4 Press the Fiery logo.

5 Press USB Media Server.
All files on the USB flash drive are shown. The printable files (DOC, EPS, PCL, PDF, PPT, PS, TIFF, or XLS) are
displayed with the print icon to show they are printable.

6 Navigate to the file that you want to print and select it.
To open a folder, select the folder from the list then press Browse Directory.
To return to a higher-level folder, press Upper Folder.

7 Select a file by pressing on the file name.

8 Specify print options for the file.

• Copies (Default is 1)

• Queue (Hold, Print, Direct, or any published virtual printer set up for the Fiery ES)

• Duplex, Tumble, or One Side

• Page Size (Default, list of available page sizes)

9 Press Print to send the file to the Fiery ES for printing or Cancel to cancel the print request.

10 Remove the USB flash drive from the Fiery ES.

Print and retrieve a secure print job

The Secure Print feature offers a level of security for confidential or sensitive print jobs, which print only when you
are present at the printer control panel.
To use this feature, you first enter an arbitrary password into the Secure print field in the printer driver when you
send your job to the Fiery ES. Then, to print your job, you re-enter the password at the printer control panel.

Send a secure print job

1 In your application, and do one of the following:

• On Windows computers: Select File > Print, select the Fiery ES as your printer, click Properties, and then click
the Job Info icon.

• On Mac OS X computers: Select File > Print, select the Fiery ES as your printer, select Fiery Features from the
drop-down list, click Full Properties in the Quick Access pane, and then click the Job Info icon in the Printing
Preferences dialog box.
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2 Type an arbitrary password in the Secure print field.

Note: The password requires at least 1 character and can be up to 31 characters long. It is limited to
alphanumeric characters (do not use symbols).
For more information about typing the password, see Job Info options on page 68.

3 Make any other required changes to Job Properties.

4 Click OK to close the Fiery ES Properties dialog box.

5 Click OK or Print to close the Print dialog box and send your job to the Fiery ES.
The job is sent to the printer.

Print a secure print job from the printer

1 On the printer control panel, press the Menu button.

2 Press the Fiery logo.

3 Press Secure Jobs.

4 Tap the Secure Code field, use the keyboard to type the same password that you typed in the Secure print field of
the printer driver, and then press OK.
The print jobs that match the password are displayed in the Secure Print screen.

5 Press Show Files.

6 Select your print job or press Print All to print all secure jobs listed.

7 Specify the number of copies to print and then press Print or Delete.

FTP printing

You can send jobs to the Fiery ES using FTP printing if the Fiery ES is set up as an FTP server with FTP Services
configured on it.
For more information about configuring FTP Services, see Command WorkStation Help.
You can use any FTP client application. Before you use FTP printing, the FTP client application requires the
following information (see your administrator):

• IP address or DNS name for the Fiery ES

• Directory or path to send the job to, such as the Print queue, Hold queue, or published virtual printers (if
supported)
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Note: You cannot print to the Direct connection with FTP printing.

• User name and password (if required)

You can send the following files to the Fiery ES:

• PostScript (PS)

• Printer Control Language (PCL)

• Tagged Image File Format (TIFF)

• Portable Document Format (PDF)

Note: Encapsulated PostScript (EPS) files are not supported for FTP printing.

Print files to the Fiery ES with the FTP protocol

You can use the FTP protocol to print files to the Fiery ES.
1 Connect to the Fiery ES with your FTP client application.

Folders corresponding to the Print queue, Hold queue, and any published virtual printers are displayed.

2 Navigate to the folder representing the print connection or published virtual printer.

3 Upload your job to the appropriate folder.
After the job is printed, it is deleted from the Fiery ES.

Direct Mobile Printing

Direct Mobile Printing allows direct printing to the Fiery ES from mobile devices, such as iPad, iPhone, and iPod
touch.
The Fiery ES must have certain networking options turned on in Setup. After Setup is complete, the Fiery ES appears
in the list of available printers on the mobile device.
In addition, observe the following configuration requirements:

• Make sure that the Fiery ES is connected to a wireless access point on the network.

• Make sure that supported mobile devices are connected to the same wireless network as the Fiery ES. The
Printer Default Paper Size is used for all Direct Mobile Printing jobs.

For information about configuring the settings in Setup on the Fiery ES, see Configuration and Setup.
For a list of supported mobile devices, see Configuration and Setup.
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Print from a mobile device

You can print files from your mobile device to the Fiery ES.
1 On the mobile device, open the Print window.

For more information, see the documentation that accompanies your device.

2 Select Fiery ES in the list of available printers.

3 Specify print settings, and click Print.

PrintMe cloud printing

Users with a PrintMe subscription can upload a document to the PrintMe cloud service and then print the document
to the printer using the printer control panel.
Before you print:

• Make sure that the Fiery ES has an Internet connection and is connected to the network.

• Turn on PrintMe and related settings on the Fiery ES using Configure.
For information about configuring the settings in Setup on the Fiery ES, see Configuration and Setup.

• Upload the document to PrintMe, either at http://www.printme.com or send by email to print@printme.com.
For more information about using PrintMe, see http://w3.efi.com/Fiery/Products/Office/EFI-PrintMe.

• Print directly from a Windows application. To do this, you must first install the PrintMe printer driver. See 
Install the PrintMe printer driver on page 64.

• When you upload or email a document to PrintMe, you receive an email confirmation that contains a unique
document ID. You need this document ID to print, as described in the following procedures.

• Make sure that the printer is not printing or processing any files.

• PrintMe supports the following file types: PDF, XLS, DOC, PPT, GIF, JPG, TIFF, PICT, HTML, TXT, and PS.
The maximum file size is 25MB.

In particular, observe the following:

• The PrintMe feature on the Fiery ES requires a subscription to the PrintMe cloud service.

• For information or support related to the PrintMe cloud service, contact Electronics For Imaging at
printmesupport@efi.com.

• PrintMe availability may vary, depending on the country or region.

Print a PrintMe document from a printer

You can print an uploaded document from the PrintMe cloud service to the printer.
1 On the printer control panel, press the Menu button.

2 Press the Fiery logo.
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3 Press PrintMe.

4 Type the Document ID and press Next.
Refer to the email confirmation for Document ID.
Jobs associated with the Document ID are displayed.

5 Select a job to print and then select the print settings:

• Copies (number of copies)

• Duplex, Tumble, or One Side

• Color or B/W (black and white)

6 Press Print to print the job.

7 Press Delete to permanently remove all documents associated with the Document ID from PrintMe.

Install the PrintMe printer driver

You can print to the PrintMe cloud service just as you would print to any desktop printer with the PrintMe printer
driver.

Note: The PrintMe printer driver is supported on client Windows computers that operate in a non-proxy network
environment.

Install the PrintMe printer driver on a Windows client

You can install the PrintMe printer driver on a Windows client.
1 Go to http://www.printme.com/home/index.html and click Get the driver from the PrintMe toolbar to download

the PrintMe printer driver.

2 Double-click the EFI PrintMe Driver icon and follow the on-screen instructions.
If prompted, restart the computer.

3 To verify that the driver is set up correctly, click Start and select Printers and Faxes.
The EFI PrintMe printer should be listed. If it is not, reinstall the printer driver.
After the PrintMe printer driver is installed, you can print to the PrintMe cloud service from most Windows
applications.

Note: To uninstall the PrintMe printer driver, open the Add/Remove Programs tool in the Windows Control
Panel and remove the EFI PrintMe Driver.

Print documents from Windows applications

You can print documents with the PrintMe printer driver.
1 In the Windows application, click File > Print.

Printing

Other Printing Methods

64

http://www.printme.com/home/index.html


2 Select EFI PrintMe from the printer pull-down menu.

3 Type your email address and click OK.

An email message containing the Document ID is sent to your email address.

Print with Fiery JDF

Fiery JDF allows submission of JDF jobs to a Fiery ES from applications that allow creation of JDF tickets.
Use Configure to specify JDF settings and to view the Fiery JDF version, the JDF Device ID, and the JMF URL. For
more information, see Command WorkStation Help.

1 From Configure, choose Job Submission > JDF Settings.

2 Select Enable JDF.

3 If a virtual printer is configured for the Fiery ES, select one from the Use Job Settings from Virtual Printer option.

Note: Specify this option only if it applies to your specific workflow.

4 Specify a default print queue action from Job Action.

5 Select Override JDF job with the above settings, if you want to override the settings specified in the JDF ticket.

6 Specify how you want the JDF jobs closed once they are printed.

7 Specify the items required for closing a JDF job. The items you select here must be filled out before the job can
close automatically or manually.

8 Specify the network paths where the Fiery ES searches for common resources.

9 Click Save.
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Web Services for Devices printing

Web Services for Devices (WSD) allows printing from Windows 7 and Windows 8 computers, and Windows 8-based
tablets.
The WSD option on the Fiery ES must be turned on in Setup. After Setup is complete, you can install the WSD
printer driver for the Fiery ES.
For information about configuring the settings in Setup on the Fiery ES, see Configuration and Setup.

Install the WSD printer driver

You can install the WSD printer driver on Windows 7 and Windows 8 computers, and Windows 8-based tablets.
1 Download the printer driver with WebTools.

For instructions on downloading the printer driver with WebTools, see Download printer drivers with WebTools
on page 11.

2 In the Fiery Driver Installer dialog box, select the printer driver language and click Next.

3 Click Next in the Welcome to the InstallShield Wizard for Fiery Driver Installer dialog box.

4 Read the license agreement, click I accept the terms of the license agreement and click Next.

5 Select Add a network, wireless or Bluetooth printer.

6 Select the printer from the list of available printers and proceed to step 10.

Note: The WSD printer shows the Fiery ES with the printer in parentheses for the name of the printer.
If the printer is not listed, proceed to step 7.

7 Click The printer that I want isn’t listed.

8 Click Add a printer using TCP/IP address or host name and click Next.

9 Select Web Services Device for Device type, type the IP address of the Fiery ES, and click Next.
Connection to the printer is initiated and the printer driver is installed.

10 Click Next and follow the on-screen instructions.
Do not share the printer and do not print a Test Page at this time.
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Print Options

Print Options describes the Fiery ES printer driver, available print options, and where to set print options to print
your jobs successfully.

About the Fiery ES printer driver

Windows and Mac OS computers communicate with the Fiery ES by means of a printer driver and a PostScript
Printer Description (PPD) file. A PPD file contains information about the features and capabilities of a particular
printer (for example, what paper sizes and media types are supported) and the Fiery ES.
A printer driver manages printing communication between your application and the printer. It interprets the
instructions generated by the application, merges those instructions with printer-specific options you set, and then
translates all information into Adobe PostScript, a language the printer understands. In other words, the printer
driver writes a PostScript file based on your original file and the options you set from the Print dialog box.
The Fiery ES receives files from computers on the network, processes the files, and then sends them to the printer.
For information about the specific print options for the Fiery ES, see Print options and default settings on page 68.

Set print options for the job

Print options give you access to the special features of your printer and the Fiery ES.
You can specify print options in these areas:

• Setup
Some settings are specified during Setup by the administrator. For information about the current default server
settings, contact the administrator or operator.

• Applications
With the printer drivers provided, you can specify job settings when you print a job.

• Color Setup
You can set the default CMYK/Grayscale Source, CMYK/Grayscale Processing Method, RGB Source, Separate
RGB/Lab to CMYK Source, Output Profile, RGB/Lab Rendering Intent, Spot Color Matching, Gray (CMYK),
Gray (RGB), Black Text and Graphics, and Black Overprint settings. (See Color Printing.)
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• Hot Folders
You can assign a group of print options to a Hot Folder. When you specify print options for a Hot Folder, the
print options are assigned to all jobs sent through that Hot Folder. These print options override any default
options.
For information, see Hot Folders Help.

• Overrides in Command WorkStation Job Properties
To change job settings from Command WorkStation, double-click a job to display the Properties dialog box.
For more information, see Command WorkStation Help.

Print option override hierarchy

Print option settings that were specified in the printer driver can be overridden in Command WorkStation Job
Properties.
The override hierarchy is as follows:

• Settings from the user’s printer driver override the Fiery ES Setup settings.

• Settings assigned to Hot Folders override the user’s printer driver settings.

• Settings made from the job management tools (Command WorkStation Job Properties) override the user’s
printer driver settings.

Print options and default settings

You can use the printer driver interface to configure a particular print option to print a job. If you choose not to
configure the print option, the Fiery ES prints the job with the default setting.
For options that the administrator configures, choosing Printer’s default results in the Fiery ES printing the job with
the factory default.
For options that cannot be configured in Setup, the Fiery ES prints the job with a preconfigured Printer’s default
setting. When you select the printer driver for North America, the default Document size is Letter or for
International, the default Document size is A4. For more information, see the following tables.
To determine the current Setup defaults, print the Configuration page from Command WorkStation. (See
Configuration and Setup.)

Note: A job uses the Fiery ES default settings (unless otherwise specified) at the time it is processed for printing, not
at the time it is sent to the Fiery ES Hold queue.
The print options are organized according to the printer driver icons (tabs).

Job Info options

The Job Info tab shows all information about the job, including user information that may be required for user
authentication and job handling.
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Copies

The maximum number of copies is 9999.

Note: The maximum number of jobs in the Printing queue and Archived list is 9999.

Print Range

Specify the page range or odd/even pages to print.
For variable data printing jobs, a range of Records is selected for printing. For imposed variable data printing jobs, a
range of Records and Sheets is printed.
For imposed jobs, a range of Sheets is printed.
This option is only accessible from Command WorkStation Job Properties.

Accounting: Enable job tracking

Select to turn on job tracking.
To display the job notes at print time for the job, select Allow entry of account information.
To use the last job account information for the print job, select the Show last entered account information check
box.
To save the last entered job account information in the job notes, select Use last entered account information.
This option is not available from Command WorkStation Job Properties.

Account track

Select the Account track check box to assign the Department name and Account password for a print job.

Note: To use this option, you must configure it on the printer.

Account track: Department name

Specify an account identification value for the Department name (up to 8 alphanumeric characters).

Note: To use this option, you must configure Account track on the printer.

Account track: Account password

Specify the Account password for a job (up to 64 alphanumeric characters).

Note: To use this option, you must configure Account track on the printer.

Destination: Box number

Specify a Box number when using the Copier stored print option.
The Fiery ES sends the print job to the hard disk drive on the printer specified by the Box number.
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The Box number is available from 1 to 999999999.

Note: If you specify the reserved number as 0, the printer cancels the job.
For more information, see the documentation that accompanies your printer.

Destination: Copier stored print

The Copier stored print option allows you to store a print job on the hard disk drive of the printer.
Do one of the following:

• Select Off to send the image data as a normal print job.

• Select HDD stored to store the print job on the hard disk drive of the printer.

• Select HDD stored and print to store the print job on the hard disk drive of the printer and to print the job.

The hard disk drive (HDD) must be installed in the printer to select one of the HDD options.
For more information, see the documentation that accompanies your printer.

Job notes: Instructions

Specify instructions for the operator about the job.
This field accepts alphanumeric and special characters but does have a maximum limit.

Job notes: Notes 1/Notes 2

Specify information about the job. The field accepts alphanumeric and special characters but does have a maximum
limit.

Job notes: Secure print

Use Secure print when printing sensitive or confidential documents.
Specify an arbitrary password and re-enter it when you are present at the printer.

Print queue action

Select the job action associated with a published queue.
Select Print to send the file directly to printing.
Select Print and hold to save the raster file after printing.
Select Process and hold to process, but not print a job.
Select Hold to spool the job until the operator takes further action. Held jobs can exist in a preprocessed or
processed state.
Select Print and delete to queue a job to be processed, printed, and then deleted. This action ensures that the printed
job is not saved to the Printed list, which is often required for secure printing.

Note: This option is invalid if your job is sent to the Direct connection.
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Proof print

Select the Proof print check box to print a single copy of a job(s) to verify output.
When Proof print is selected, it stores a print job and prints only one copy. The remaining copies print after you
enter information from the printer control panel.
This function is available only when you print multiple-copies.
To print the document, release the held document from the printer control panel.
For information, see the documentation that accompanies your printer.

Reporting: Control Bar

Select the check box to turn on the Control Bar feature to print a Control Bar (for print job identification) in the
margin.
This option is available as part of Fiery Productivity Package. For more information, see Fiery Productivity Package.
Printer’s default reflects the setting specified in Color Setup in Command WorkStation.

Reporting: Postflight

Specify whether or not you want to use the Postflight feature, a diagnostic tool that allows you to analyze how data is
processed by the Fiery ES.
This option is available as part of Fiery Productivity Package. For more information, see Fiery Productivity Package.

Server authentication: Authentication server name

Specify the Authentication server name for the User Authentication Server (up to 32 byte characters).

Note: To use this option, you must configure User Authentication Server on the printer.
For more information, see the documentation that accompanies your printer.

Server authentication: Project code

Specify the Project code for the User Authentication Server (up to 32 alphanumeric characters).

Server authentication: Project password

Specify the Project password for the User Authentication Server (up to 64 alphanumeric characters).

User Authentication: I’m a Guest

Select to turn on I'm a Guest feature to allow guest printing.
Guest printing must be turned on at the Fiery ES.
In Command WorkStation, the management of jobs is determined by how you log on to the Fiery ES.
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When the printer is accessible to public users (unregistered users), selecting this option enables you to execute
printing without entering the user name and password. The printed jobs use the public account for job accounting.
For more information about the user authentication feature on the printer, see the documentation that accompanies
your printer.

User Authentication: Password

If User Authentication is configured on the Fiery ES, specify your user Password to print a job. Type your local
password or domain password for user authentication.
If User Authentication is configured on the printer, type your local password or domain password to print a job. For
more information about the user authentication feature on the printer, see the documentation that accompanies
your printer.

User Authentication: User name

If User Authentication is configured on the Fiery ES, specify your User name to print a job. Type your user name or
domain\user name for user authentication.
If User Authentication is configured on the printer, type your user name or domain\user name to print a job. For
more information about the user authentication feature on the printer, see the documentation that accompanies
your printer.

User Authentication: Use Windows Login

If you are logged on to your Windows computer, select Use Windows Login for user authentication. This option
appears when you log on to your domain on your Windows computer.
For more information, see Configuration and Setup.

Media options

The Media tab shows attributes and sources of paper to print and insert.

Document size

Document size is the page size defined in your application’s Print setup (or Page setup) dialog box.
When printing one document page per sheet of paper, document size is usually the same as output paper size.
However, document size may differ when printing booklets or imposing multiple document pages on a single sheet.
Document size may also differ from output paper size when you use the Scale or Scale to fit options, in which case
the document page size is scaled at a given percent to fit a certain paper size.
To assign document size, do one of the following:

• Select the size from the available list.

• Click Custom to select a non-standard paper size.

Note: Document size is grayed out and cannot be changed from the Mac OS printer driver. You can specify the
document size with the Paper size option from the Mac OS printer driver.
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Cover options: Back cover

Specify a back cover to print at the end of the print job.
Do one of the following:

• Specify None to print the job without a back cover.

• Specify Blank to print a blank back cover.

• Specify Printed to print on the back cover.

When creating a Saddle Stitch booklet, use the Booklet Maker Define Cover option.

Cover options: Back cover tray

Specify the paper tray to use for the back cover.

Cover options: Front cover

Specify a front cover to print at the beginning of the print job.
Do one of the following:

• Specify None to print the job without a front cover.

• Specify Blank to print a blank front cover.

• Specify Printed to print on the front cover.

When creating a Saddle Stitch booklet, use the Booklet Maker Define Cover option.

Cover options: Front cover tray

Specify the paper tray to use for the front cover.

Cover options: PI back cover tray

Specify the PI (Post Inserter) back cover tray for the print job.

Cover options: PI front cover tray

Specify the PI (Post Inserter) front cover tray for the print job.
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Output paper size

Output paper size defines the size of the sheet of paper on which your job prints. It is the size of the physical sheet of
paper in the printer tray.
To assign paper size, do one of the following:

• Select the size from the available list.

• Click Custom to select a non-standard paper size.

• Select Same as document size to print one document page per sheet of paper.

Paper tray

Use the Paper tray print option to specify the paper tray that contains the paper to use for your print job.
Paper tray allows you to select a specific tray for your job. If you select the Auto tray select setting, the printer prints
from any tray containing the paper size necessary for the job. This setting also allows the printer to automatically
switch between trays, if the current tray becomes empty, while continuing to print.
If you turn on the Tray alignment print option, then Paper tray cannot be set to Auto tray select.
For information about setting your choice of media in one of the trays, see the documentation that accompanies the
printer.

Paper type

Use the Paper type print option to specify the type of paper used for your print job.
For information about media types and paper specifications, see the documentation that accompanies the printer.

Slip sheets: Transparency interleaving

Select On to print multiple transparency sheets separated by blank, plain paper pages.

Note: This option is supported with Letter or A4 size plain paper or transparencies only.

Slip sheets: Interleave tray

Select an input tray for transparency interleaving.

Tray alignment

Select turn on Tray alignment to adjust the image on the page to achieve alignment on both sides of a page when
printing duplex.
For more information, see Command WorkStation Help.
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Mixed media

Specify different media types, paper source, and chapter-based finishing for pages, or ranges of pages, within a print
job.
For more information, see printer driver Help.
For information about accessing and using Mixed media, see Command WorkStation Help. Features specific to the
Fiery ES are described in Utilities.

Layout options

The Layout tab defines the imposition of the print job and the booklet process on the media/sheet, except for
positioning that compensates for finishing options, for example, Tray alignment.
The printer driver has the following layout modes:

• Normal is used for printing standard documents, from 1 to 16 document pages per sheet. (See Normal layout
options on page 75.)

• Gangup is used for speed printing imposition modes. (See Gangup layout options on page 77.)

• Booklet is used for printing documents in booklet layout. (See Booklet options in the printer driver and Job
Properties on page 78.)

• Impose is used for imposition layouts for custom printing, binding, and trimming. (See Impose layout options on
page 81.)

Normal layout options

Normal layout options are used for printing standard documents, from 1 to 16 document pages per sheet.

Duplex

Select to print a job with duplex (double-sided) pages.
Select Off for single-sided printing.
Specify Right & left bind or Top bind for duplex (double-sided) printing by specifying the orientation of printed
images.

Note: Two-sided tab (index) printing of 9x11 paper size is not supported.
For more information, see Print Duplex (double-sided) pages on page 106.

Mirror

Select to turn on Mirror to print the mirror image of the job.
This option is not available from the Mac OS X printer driver and Command WorkStation Job Properties.
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Orientation override

The Orientation Override print option is used with jobs that do not have an orientation or that have incorrect
orientation.
It specifies the orientation to use for finishing settings (for example, stapling) that interact with orientation and
for flowing pages on N-up layouts. In some cases, the orientation of a job may be correct in print, but incorrect
in preview.
This option is accessible only from Command WorkStation Job Properties.

Orientation

Specify Portrait or Landscape page orientation for the document.
This option is not available from the Mac OS X printer driver and Command WorkStation Job Properties.

N-up option: Page Order

Specify the layout direction when the Pages per Sheet option is set to 2-up or greater.

N-up option: Pages per Sheet

Specify the number of document pages per sheet of paper for your print job.
This option cannot be used with the Create master or Use master options.

Note: This option is invalid if your job is sent to the Direct connection.

N-up option: Print border

Select to turn on Print border to print borders around each page in your print job.

Rotate 180 (check box)

Select to rotate the pages of a job 180 degrees.

Scale to fit

Specify whether to scale your job to fit to a paper size. When using the Scale to fit option, you cannot use the
manual Scale option.
The Scale to fit option allows you to scale a job to a paper size different from the document size. When you turn
on this option, the image is increased or reduced in size to fit the imageable area of the paper size you select
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from the Paper size menu. The document size is scaled to the printable imageable area of the paper for edge-to-
edge printing. When you turn off this option, the original document size is printed without any scaling, even if
you select a larger paper size.

Scale to fit option Document size - Letter Output paper size - 11x17

Scale to fit turned on

Scale to fit turned off

Scale

Specify an increase or decrease in the scale of your print job. When using the manual Scale option, you cannot
specify Scale to fit.
The operator can specify a scaling override in Command WorkStation, but the override is applied to any scaling
value already set in the active job. For example, if a user sends a job with a scaling value of 50% and the operator
specifies a Scale override of 300%, the job is printed at 150% of the original document size, that is, 50% of 300%.

Gangup layout options

Gangup layout options are used for speed printing imposition modes.

Note: The Gang-up feature is not valid if your job is sent to the Direct connection.

Gangup

Select Gangup to specify options for speed printing imposition modes.

Gang-up type

Gangup booklet has two types used for speed printing imposition: Step & repeat and Cut & stack.
Select Step & repeat to speed print a job by printing two document pages on each sheet. When the printed
sheets are cut in half, the result is two complete sets of the same document.
Select Cut & stack to speed print a job by printing two document pages side by side. When the printed sheets are
cut in half and stacked together, the result is one complete set of the document (in faster printing time).
For more information, see Gang-up printing on page 104).
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Page Alignment: Duplex

Select the duplex (double-sided) setting to specify the orientation of printed images for gang-up printing.
Select Off for single-sided printing.
Specify Right & left bind for duplex (double-sided) printing to specify the orientation of printed images.
For more information, see Print Duplex (double-sided) pages on page 106.

Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.
You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).
Specify a positive value to increase the amount of blank space between adjacent pages.
Specify a negative value to decrease the amount of blank space between adjacent pages.
For more information, see Booklet Maker Help.

Paper size

Defines the size of the sheet of paper on which your job prints. It is the size of the physical sheet of paper in the
printer tray.
To assign paper size, select one of the following:

• Select the size from the available list.

• Select Custom Paper Size to select a non-standard paper size.

• Select Same as document size to print one document page per sheet of paper.

For information about Document size and Paper size, see Document size and Paper size on page 103
For information about printing custom page sizes, see Defining and printing custom page sizes on page 102

Paper Size: Shrink to fit

Automatically scales down or reduces the document page size to fit the imageable area of the selected paper size
specified from the Paper size menu. Shrink to fit does not scale up or enlarge.
When Shrink to fit is turned off, page contents print at 100%.

Booklet options in the printer driver and Job Properties

Booklet layout options are used for printing documents in booklet layout.
The Booklet Maker print options accessible from the printer driver. For the Booklet Maker print options accessible
from Command WorkStation Job Properties, see Booklet Maker in the printer driver and Command WorkStation
Job Properties on page 98.
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Note: The Booklet Maker feature is not valid if your job is sent to the Direct connection.
You can use the Booklet Maker Wizard to specify booklet options by clicking Launch Wizard.

Booklet

Select Booklet to specify options for printing documents in Booklet layout.
Click Launch Wizard to specify how to arrange the pages of the job in special layouts for folding or cutting after
printing.

Booklet Type

Booklet Type is a combination of binding method, which determines how the signatures of the booklet are
folded and imposed, and binding edge, which determines the location of the spine of the booklet.
For information about Booklet printing, see Booklet Maker Help.

Cover: Back cover

When Front & Back Separately is selected, use the Back cover option to define how the content of the back cover
is printed.
Select Print on outside to print only on the outside of the back cover (the inside of the back cover is blank).
Select Print on inside to print only on the inside of the back cover (the outside of the back cover is blank).
Select Print on both sides to print on both the inside and outside of the back cover.
Select Do not print if you do not want any content printed on the back cover.
When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures in the
job. For more information, see Booklet Maker Help.

Cover: Content input

Specify the cover type for your Saddle booklet.
Select Front & Back Separately to include cover content (individual pages in your document) as part of your
booklet print job.
Select Pre-Printed (use insert) to insert a pre-printed cover that is added to the body pages from an inserter tray.
For more information, see Booklet Maker Help.

Cover: Define Cover (for Saddle books only)

Click Define Cover to specify the cover options.

Cover: Front cover

When Front & Back Separately is selected, use the Front cover option to define how the content of the front
cover is printed.
Select Print on outside to print only on the outside of the front cover (the inside of the front cover is blank).
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Select Print on inside to print only on the inside of the front cover (the outside of the front cover is blank).
Select Print on both sides to print on both the inside and outside of the front cover.
Select Do not print if you do not want any content printed on the front cover.
When you add a cover, blank pages may be inserted, depending on the allocation of pages to signatures. For
more information, see Booklet Maker Help.

Page Alignment: Centering adjustment

Centering adjustment positions page content in relation to the center of one-half the paper size or the spine, the
center of the sheet where the fold occurs.
At the center positions page content in the center of one-half the specified paper size.
At the spine aligns page content with the spine or center fold of your booklet.
For more information, see Booklet Maker Help.

Page Alignment: Compensate creep

Compensate creep adjusts the position of the page content to counteract the shift that occurs when sheets are
folded to create Saddle and Nested Saddle booklets.
Select Plain when printing Saddle or Nested Saddle booklets with a large number of pages.
Select Thick when printing Saddle or Nested Saddle booklets on heavyweight paper.
For information about printing booklets, see Booklet Maker Help.

Page Alignment: Increase gutter by

Increase gutter by controls the amount of space between adjacent pages on a sheet to adjust for trimming or
other finishing options.
You can specify the gutter value from -1.969 to 1.969 inch in 0.001 inch increments (-50.0 to 50.0 mm in 0.1 mm
increments).
Specify a positive value to increase the amount of blank space between adjacent pages.
Specify a negative value to decrease the amount of blank space between adjacent pages.
For more information, see Booklet Maker Help.

Paper size: Paper Size for 2-up

Defines the size of the sheet of paper (unfolded) on which a booklet is printed. It is the size of the physical sheet
of paper in the printer tray.
To assign a paper size for a booklet, select one of the following:

• Select the size from the available list.

• Select Custom Paper Size to select a non-standard paper size.

• Select Same as document size to print one document page per sheet of paper.
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For information about Document size and Paper size, see Document size and Paper size on page 103
For information about printing custom page sizes, see Defining and printing custom page sizes on page 102
For more information about printing booklets, see Booklet Maker Help.

Paper Size: Shrink to fit

Automatically scales down or reduces the document page size to fit the imageable area of the selected paper size
specified from the Paper size menu. Shrink to fit does not scale up or enlarge.
When Shrink to fit is turned off, page contents print at 100%.

Subset Size: Number of sheets in a subset (for Nested Saddle books only)

When Nested Saddle is selected, use this option to specify the number of sheets in each subset.

Impose layout options

Fiery Impose provides several pre-defined imposition templates used for custom printing, binding, and trimming.
The Impose option is only accessible from Command WorkStation Job Properties.
For more information, see Command WorkStation Help.

Impose

Select Impose to specify an imposition layout for a job.

Templates

Specify an imposition layout template for a job.
The available templates are as follows:

• Normal: Default Template and 1-up full bleed

• Booklet: 2-up perfect, 2-up saddle, and 4-up head to head

• Gangup: 3-up trifold brochure, 4-up gate fold, and 4-up z fold

Edit Impose Template

You can edit the imposition template in Fiery Impose.
Click Edit Impose Template to open a template in Fiery Impose for editing.
For information about Impose, see Utilities. For information about using Impose, see Command WorkStation
Help.

Color options

The Color tab shows color settings and graphic arts features (when turned on).
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Color mode

Select the color mode for the current print job.
Specify the color mode for the print job by doing one of the following:

• Select CMYK for a color document.

• Select Grayscale for a grayscale or black-and-white document.

Specify the color print options and settings by doing one of the following:

• Select Basic Settings to specify color print options and settings. For more information, see Basic color options on
page 82.

• Select Expert Settings to edit other color print options and settings, including Black overprint, Black text and
graphics, Gray (CMYK), and Gray (RGB). For more information, see Expert color options on page 84.

Basic color options

The basic color options can be accessed by clicking Basic Settings on the Color tab of the printer driver or Command
WorkStation Job Properties.
Basic Settings are as follows:

• CMYK/Grayscale Source specifies the simulation profile for the print job.

• RGB Source specifies a source color space definition for printing RGB images, graphics, and text.

• Spot Color activates the PANTONE Lookup Table. The Fiery ES uses a built-in table to generate the closest
CMYK matches of spot colors when the Spot color matching check box is selected.

• Gray and Black specifies the settings to use for the object types (Text/Graphics or Text/Graphics/Images) using
black only.

• Output Profile uses selected profile for color conversion for the printer.

• Calibration shows the last date and time the calibration was updated for the printer.

Auto trapping

Trapping is a technique to print some objects slightly larger or smaller than specified in an application, in order to
prevent white edges around the objects.
These white edges, or “halos,” can be caused by factors such as misregistration, the physical properties of the toners,
and the stiffness of the media. The Auto trapping feature provides you with advanced trapping settings and gives you
full control over their values.
Select this option if the job should automatically reduce white gaps for text and graphics.
Turning on this option may result in graphics or text surrounded with borders.
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Combine separations

You can print the color separations in the job as a single page or as four individual pages.
When printing separations from supported desktop publishing applications, do one of the following:

• Select the Combine separations check box to combine separations on a single page.

• Clear the check box to view separations as individual black-and-white pages, each representing one color plate.

For more information, see Color Printing.

Composite overprint

Design applications are typically set to knock out objects.
To overprint, you must first change the settings in the source application. When the Composite overprint option is
turned on, the overprinting attribute specified in the source application take place, provided the output is in
composite mode (not printed in separations) and/or be printed with CMYK or Grayscale color mode. (See Color
Printing).
Select this option to overprint objects that are specified in the source PostScript or PDF file.

Substitute colors

Select Substitute colors to use the substitute color values defined in Spot-On.
For more information, see Color Printing.

Optimize RGB transparency

You can use the Optimize RGB transparency option to achieve correct color output for areas of overlapping
transparent RGB or Lab colors (such as a drop shadow) in a PDF job.
Turn on to achieve correct color output for areas of overlapping transparent RGB or Lab colors (such as a drop
shadow) in a PDF job.
If you turn on Optimize RGB Transparency, the Fiery ES uses the correct RGB source profile and rendering intent
when converting the overlapping RGB colors to CMYK during the PDF-to-PostScript conversion. If you turn off
Optimize RGB Transparency, the area of overlapping colors might print with incorrect color or undesirable artifacts."
This option is only accessible from Command WorkStation Job Properties, Hot Folders, and Virtual Printers. (See
Color Printing).
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Expert color options

The expert color options can be accessed by clicking Expert Settings on the Color tab of the printer driver or
Command WorkStation Job Properties, and then clicking the Color Input tab in the Advanced Edit dialog box.
Expert Settings modes are as follows:

• Color Input is used for color printing. (See Color Input options on page 84).

• Gray & Black Processing is used to specify how to print black text and graphics in the print job. (See Gray & Black
Processing options on page 86).

• Output is used to specify the output profile to use for printing a document. (See Output options on page 87).

Color Input options

The Color Input options can be accessed by clicking Expert Settings on the Color tab of the printer driver or
Command WorkStationJob Properties, and then clicking the Color Input tab in the Advanced Edit dialog box.

Black point compensation

The Black Point Compensation option lets you control the output quality of shadow areas for CMYK source
colors.
Use Black Point Compensation to enhance details in shadows when the CMYK source space is larger than the
gamut of the printer. In proofing applications, when the CMYK source space is smaller than the gamut of the
printer, do not use this option.

Note: For RGB source colors, black point compensation is always applied.
Black point compensation works by scaling the source colors so that the darkest point in the source profile maps
to the darkest point in the output profile.

CMYK/Grayscale Processing method

Specify the CMYK/Grayscale Processing method for the print job.
Specify the simulation method for CMYK print jobs.
Do one of the following:

• Select Full (Source GCR) for a more complete and accurate simulation. Full (Source GCR) applies colorimetric
transformations that adjust hue as well as output density and produces output that maintains the same
amount of black as the source document.

• Select Full (Output GCR) to apply the same simulation method as Full (Source GCR), except that the output
produced contains a black amount determined by the Output profile.

• Select Pure Primaries to use one-dimensional transfer curves to adjust density output of individual color
channels.

For more information, see Color Printing.
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CMYK/Grayscale Source

Specify the simulation profile for the print job.
For more information, see Color Printing.

Paper simulation

Select the Paper simulation check box to adjust the color according to the shade of the paper stock specified in
the selected CMYK/Grayscale source profile.
This option is available as part of Fiery Productivity Package. For more information, see Fiery Productivity
Package.

RGB rendering intent

Specify a RGB rending intent for the print job.
Specify a default CRD (color rendering dictionary) for color conversion when printing RGB images, graphics,
and text.
Do one of the following:

• Select Presentation to print files with artwork, graphics, and text. The result is similar to Photographic, with
well-rendered flesh tones and more saturated colors.

• Select Photographic to print photographs, including scanned and digital camera images. The result is less
saturated than Presentation style.

• Select Relative Colorimetric when color matching is important, but you also want to print white as paper
white. The white point transformation eliminates borders between blank spaces and white objects.

• Select Absolute Colorimetric when exact colors are required and visible borders are not distracting. There is
no white point transformation.

Note: If you experience tone reproduction problems, set this option to Photographic.
For more information, see Color Printing.

RGB Source

Specify a source color space definition for printing RGB images, graphics, and text.
For more information, see Color Printing.

Separate RGB/Lab to CMYK source

Select the Separate RGB/Lab to CMYK source option for RGB jobs to simulate an output printer other than the
printer to which you are printing.
For more information, see Color Printing.
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Spot color matching

Clear the Spot color matching check box to print specified PANTONE colors in your job using the alternate
color space and values for the spot color specified in the source application.
Select to activate the PANTONE Lookup Table. The Fiery ES uses a built-in table to generate the closest CMYK
matches of spot colors. (See Color Printing.)

Use embedded profile when present (RGB)

When the Use embedded profile when present (RGB) option is turned on, the Fiery ES ignores the RGB Source
option and uses the RGB profile embedded in the print job as the RGB source profile.

Use embedded profile when present (CMYK)

When the Use embedded profile when present (CMYK) option is turned on, the Fiery ES ignores the CMYK/
Grayscale Source option and uses the CMYK profile embedded in the print job as the CMYK source profile.

Gray & Black Processing options

The Gray & Black Processing options can be accessed by clicking Expert Settings on the Color tab of the printer driver
or Command WorkStation Job Properties, and then clicking the Gray & Black Processing tab in the Advanced Edit
dialog box.

Black text and graphics

Specify how to print black text and graphics in the print job.
Do one of the following:

• Select Normal to print black text and graphics as a four-color black using C, M, Y, and K toner, and to use
normal PostScript rendering.

• Select Pure Black On to print black text and graphics as a one-color black, using black toner only.

• Select Rich Black On to print black text and graphics as richer looking black, by layering a small amount of
Cyan toner underneath the black toner to make the black even darker.

This option is automatically set to Pure Black On if the Black overprint (for pure black) option is set to Text or
Text/Graphics. (See Color Printing.)

Black overprint (for pure black)

Specify text or text/graphics to overprint in the job.
Do one of the following:

• Select Text to overprint black text.

• Select Text/Graphics to overprint black text and graphics.

For more information, see Color Printing.
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Gray (RGB)

Select the Gray (RGB) settings to print an RGB job using black toner instead of process black.
This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using black
only, when R=G=B. (Graphics refer to vector graphics; Images refer to raster images.)
This option is designed to use black efficiently, by using only black toner (rather than four-color process black).
(See Color Printing).

Gray (CMYK)

Select the Gray (CMYK) settings to print a CMYK job using black toner instead of process black.
This option renders the selected object types (Text/Graphics or Text/Graphics/Images) in grayscale using black
only, when C=M=Y=0 and K=n, where n is not zero. (Graphics refer to vector graphics; Images refer to raster
images.)
This option is designed to use black efficiently, by using only black toner (rather than four-color process black).
(See Color Printing).

Output options

The Output options can be accessed by clicking Expert Settings on the Color tab of the printer driver and Command
WorkStationJob Properties, and then clicking the Output tab in the Advanced Edit dialog box.

Default output profile

Specify the output profile to use for the print job.
For more information, see Color Printing.

Image options

The Image tab shows all image quality settings supported by the connected Fiery ES and printer.
For information about options specified in Setup, see Configuration and Setup.

Brightness

Specify the image brightness for the print job.
Select 85% for a substantially lighter image, 115% for a substantially darker image, or one of the settings in between.

Edge enhancement

When the Edge enhancement print option is set to On, it smooths the edges of text and graphics and reduces the
appearance of jagged edges.
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Gloss print

Select the Gloss print check box to gloss the print job like a photograph.
This feature is available when the Paper type option is set to Plain paper and the Duplex option is set to Off.

Image enhance: Apply image enhancement

Select the Apply image enhancement check box to apply photo enhancement to the job.
The supported file formats are PDF, PS, TIFF, and EPS.
This option is not valid for images under 72 dpi. Also, it is not applied to pages with a large number of images. For
more information, see Image Enhance on page 106.

Image enhance: Image enhancement range

Specify all pages, specific page(s), or sheets of the document to apply photo finishing enhancement.

Image smoothing

Select the Image smoothing option to minimize grainy output when printing low-resolution (up to 300 dpi) images.
This option is valid for images less than or equal to 150 dpi when the Resolution option is set to 600 dpi, and for
images less than or equal to 300 dpi when the Resolution option is set to 1200 dpi. This option improves graphic and
image types of gradients.

Image quality

The Image quality print option allows you to specify the type of image quality for the job.
This option affects the fineness of images in the job; there is a trade-off with processing speed.

Resolution

The Resolution print option allows you to specify the resolution of the print job (specified in dots-per-inch, 600dpi
or 1200dpi).

Note: Calibration is affected by the resolution setting. When you create a custom calibration setting, be sure the
resolution setting is the same setting that is used in jobs that are printed with the calibration setting. For more
information, see Color Printing.
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Screen pattern

Specify a halftone screen pattern for the print job.
Select one of the following:

• Gradation priority for gradation-optimized halftone screening.

• Resolution priority for resolution-optimized halftone screening.

• High-resolution priority for high resolution-optimized halftone screening.

The Screen pattern settings are affected by the resolution. The screens used at 600 dpi are generally smoother in
gradation than those used at 1200 dpi. Set the Resolution print option to 600 dpi if your job contains images and
gradations. Set the Resolution print option to 1200 dpi if your job contains mostly line art and text.

Use maximum printer density

The Use maximum printer density option is designed to create solid, saturated colors. It is typically used to print text
and graphics, not photographic images.
Select this option to print 100% C, M, Y (or R, G, B) at the maximum density that the printer is capable of printing,
regardless of calibration. C, M, Y (or R, G, B) values less than 100% still print at the calibrated density value.
For best results printing CMYK color, set CMYK/Grayscale Source to Bypass Conversion. For best results printing
RGB color, make sure the Use Embedded Profile When Present (RGB) option is selected.

Finishing options

The Finishing tab shows print options related only to finishing equipment on the printer, and also image shifting to
compensate for finishing options.
These options override settings in Fiery ES Printer Setup but can be changed from Command WorkStation.

Delivery Option: Collate

Specify how to output multiple-page/multiple-copy jobs.

• Collate: Copies of a complete job are sorted as 1-N, 1-N.

• Uncollate: Copies of a complete job are sorted as 1,1, 2,2, 3,3.

• Offset collate: Copies of a complete job are sorted as 1-N, 1-N with offset stacking.

• Offset uncollate: Copies of a complete job are sorted as 1,1, 2,2, 3,3 with offset stacking.

Note: This option is invalid if your job is sent to the Direct connection.

Note: The collation of Mixed Media and Variable Data Printing (VDP) jobs is handled differently. For Mixed Media
jobs, copies of a complete job are sorted according to finishing set. For VDP jobs, copies of a complete job are sorted
per record.
For information about VDP, see Variable Data Printing.
For information about Mixed Media, see Utilities.
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Delivery Option: Output tray

Specify the output tray for the job.

Fold

Specify a fold style for the print job.
For more information, Fold options on page 104.

Fold: Tri-fold type

The Tri-fold type print option allows you to specify the number of pages to be tri-folded at a time.
The printer can tri-fold all pages together, each page one-by-one, or a specific number of pages.

Note: This option is available when Tri-fold is selected for the Fold option.

Fold: Tri-fold number

The Tri-fold number print option allows you to specify the number of pages to be tri-folded.

Note: This option is available when the Tri-fold type option is set to Page unit.

Image shift

Select the Image shift check box to adjust an image for duplex printing by shifting the image horizontally, in the
direction of paper travel, relative to the leading edge.
This option affects the offsetting of the image for the entire job, not on a per-page-basis. However, you can specify
alignment settings for the front (odd) and back (even) pages.
Image Shift settings are not available from inside Mixed Media.
Image Shift is not supported for Booklet Maker and Gang-up printing.
For more information, see printer driver Help.

Punch edge

Specify the location of punched holes.
To use this option, you must install a finisher with hole punching functionality.
For information about installing finishers and other installable options, see printer driver Help.

Punch holes

The Punch holes print option allows you to specify the number of holes to punch for your job.
To use this option, you must install a finisher with hole punching functionality.
For information about installing finishers and other installable options, see printer driver Help.
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For more information, see Punch position and hole punching on page 106.

Stapler: Staple

The Staple print option allows you to specify the number of staples and their positions.
Staple positions vary according to paper size, paper type, number of pages, and feed direction.
To use this option, you must install a finisher with stapling functionality.

Variable Data Printing (VDP) options

The VDP tab shows all Variable Data Printing (VDP) settings, such as FreeForm and advanced VDP settings.
The Fiery ES is compatible with the following variable data printing languages:

• FreeForm and FreeForm 2

For more information about VDP languages, see Variable Data Printing.
VDP documents using FreeForm must have the following settings for the master document and variable document
match:

• Color mode

• Combine separations

• Duplex

• Orientation

• Paper size

• Staple

The following setting for the variable document overrides the corresponding settings in the master document:

• Paper tray

• Paper type

Cache PDF and PS objects

Select to turn on the Cache PDF and PS objects feature, which recognizes objects (text, images, vectors) within a
PostScript or PDF file. PDF objects must be tagged as XObjects and PS objects must be in PS forms to be cached,
which reduces the need to re-process image data for faster printing.
This option is only accessible from Command WorkStation Job Properties.
For more information, see Variable Data Printing.

Create master

To create a FreeForm master from this job, specify a number to assign to the FreeForm master file.
Command WorkStation allows you to select up to 100 FreeForm masters.
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For more information, see Variable Data Printing.

Enable enhanced FreeForm

Select to turn on Enable enhanced FreeForm to allow the mapping of select pages from the FreeForm master file in
the desired order and merge with the variable file when the job is processed.
You cannot apply FreeForm settings to an imposed job.
For more information, see Variable Data Printing.

Preview Master

Click Preview Master to generate a low-resolution image of your master page.
This option is not available for the Mac OS X v10.7 or later printer drivers.

Print master

Select Print Master to verify or confirm your Master page.
Printer’s default reflects the setting specified in Fiery ES Setup.
For more information, see Variable Data Printing.

Remove white PPT background

Select to turn on Remove white PPT background when using Microsoft Office PowerPoint to create variable data in
conjunction with FreeForm.
This option removes the white background from PowerPoint files.

Use master

For variable data print jobs, specify a FreeForm master number to be used for the job.
Command WorkStation allows you to select up to 100 FreeForm masters.
For more information, see Variable Data Printing.

Define record length: Define record length

Process a PDF or PostScript file like a variable data print job, and apply record-based finishing.
This option is used in connection with the Pages Per Record option.
For more information, see Variable Data Printing.
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Define record length: Pages per record

Define record-based (rather than job-based) finishing, based on the number entered.
This option is used with the Define Record Length option.
For more information, see Variable Data Printing.

Stamping (Watermark) options

The Stamping tab shows all image stamping options that add or hide/remove any image on the job.
This also includes watermark properties that define the placement and style of the watermark. For information, see
printer driver Help.

Copy security

The Copy security print option allows you to use security settings to identify and prevent unauthorized copies.
Choose one of the following:

• Copy protect - to include a pattern that is faintly visible (background) on printed document, however when the
document is photocopied, the imprint is darker and distinctly visible.

• Stamp repeat - to add a watermark/overlay that is clearly visible in both print and copies.

• Copy guard - to embed the copy guard information into the printed paper to prevent copying the printed paper
on the printer.

Angle

The Angle print option allows you to specify an angle for Copy security stamping. Four lines or less can be printed
when the angle is not “0 degrees.”
The option is valid when the Copy security print option is set to Copy protect or Stamp repeat.

Characters

The Characters print option allows you to select the characters (text) when using either the Copy protect or Stamp
repeat (advanced watermark) print options.

Color contrast

The Color contrast print option allows you to specify pattern color contrast for text/background color for Copy
protect and Copy guard.

Color density

The Color density print option allows you to select a pattern color density for text/background color for Copy
protect, Copy guard, and Stamp repeat.
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Copy protect color

The Copy protect color print option allows you to specify the pattern color to use with the Copy security print option
settings.

Text size

The Text size print option allows you to specify the text size for the Copy security print option settings.

Copy security numbers: Distribution control number

The Distribution control number print option when turned on allows you to include the Distribution control number
when using the Copy security print option settings.
To assign a specific start number, use the separate Start number print option.

Copy security numbers: Job number

The Job number print option when turned on allows you to include the job number (printer-defined) when using the
Copy security print option settings.

Copy security numbers: Serial number

The Serial number print option when turned on allows you to include the printer serial number when using the Copy
security print option settings.

Copy security numbers: Start number

The Start number print option allows you to specify a starting copy number when using Copy security print option
settings.

Copy security numbers: Start number type

The Start number type print option allows you to specify the numbering format type when using the Copy security
print option settings.

Copy security pattern: Background pattern

The Background pattern print option allows you to select the Copy protect or Copy guard patterns from the
background patterns registered with the printer.

Copy security pattern: Pattern

The Pattern print option allows you to specify how to print the Copy security stamping pattern.

Copy security pattern: Pattern overwrite

The Pattern overwrite print option allows you to select whether the pattern is combined in the background or
foreground of the document for Copy security stamping options.
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Copy security timestamp: Date

The Date print option allows you to select the Copy security date format.

Copy security timestamp: Time

The Time print option allows you to select the Copy security time format.

Watermark

Select standard text for your watermark from the pull-down menu.
To create your own watermark, click New.
To modify a standard watermark, select it from the pull-down menu and click Edit.
To remove a watermark from the list, select it from the pull-down menu and click Delete.
For more information about using watermarks, see printer driver Help.

Note: For Windows, do not select these fonts: AdobeSansMM and AdobeSerifMM.

Print Watermarks: First Page Only

Specify how to print the watermark for the print job.
Select to turn on First Page Only to print a watermark only on the first page.
For more information about using watermarks, see printer driver Help.

Override print option settings in Job Properties

Print option settings that were specified in the printer driver can be overridden in Command WorkStation Job
Properties.
1 In Command WorkStation, right-click a held job in the Job Center view.

2 Select Properties.

3 Specify the print option settings, and then click Print.

Exceptions to overriding print option settings in Job Properties

You can override most print options in the printer driver and Command WorkStation Job Properties.
The exceptions are listed in the table.

Printer driver tab Option Driver Win Driver Mac CWS

Job Info Print Range X

Print queue action X X
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Printer driver tab Option Driver Win Driver Mac CWS

Secure print X X

User Authentication: User name X X

User Authentication: Password X X

User Authentication: Use Windows Login X

User Authentication: I'm a Guest X

Media Document size X

Layout: Normal Mirror X

Orientation X

Orientation override X

Color Optimize RGB transparency X

Variable Data Printing (VDP) Cache PDF and PS objects X

Stamping (Watermark) Watermarks X X

Print Watermarks: First Page Only X X

Booklet Maker layouts in the printer driver and Command WorkStation Job Properties

Booklet Maker is the imposition tool that allows you to quickly print documents in booklet format, without the need
for more involved page imposition programs.
Booklet Maker provides advanced settings, while streamlining the booklet-making process by displaying only the
options and controls relevant to your selections. Booklet Maker is capable of imposing jobs from nearly any
application.
Access Booklet Maker in the printer driver when you print a job, or in Command WorkStation Job Properties.

Note: Mixed Media jobs and variable data printing jobs are not supported by Booklet Maker.
The following booklet layouts are available:

• Saddle binding: Signatures are folded together as a group, and then stapled or stitched along the center fold,
which forms the spine of the booklet.
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1

Callout Refers to

1 Saddle (left) binding

2 Saddle (right) binding

3 Saddle (top) binding

• Nested Saddle binding: Combines saddle and perfect binding methods by stacking two or more saddles (also
called “groups” or “subsets”) together along the common fold, then gluing them together at the fold to form the
spine.

1
1

Callout Refers to

1 Nested Saddle (left) binding

2 Nested Saddle (right) binding

3 Nested Saddle (top) binding

• Perfect binding: Separate, folded pages are printed and stacked in booklet order. Finished pages are stitched
adjacent to one another for trimming or gluing.
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2 3

6 7 8 5

4 1

Callout Refers to

1 Perfect booklet

2 Front (2, 3, 6, 7) and Back (4, 1, 8, 5)

For more information, see Booklet Maker Help.
For more information, see Booklet options in the printer driver and Job Properties on page 78.

Booklet Maker in the printer driver and Command WorkStation Job Properties

You can access Booklet Maker in the printer driver and Command WorkStation Job Properties when you print a job.
You can work with Booklet Maker as follows:

• Using the Booklet Maker wizard
Recommended for first-time or novice users.

• Specifying settings in the main Booklet Maker dialog box
Recommended for experienced or advanced users.

For more information, see Booklet options in the printer driver and Job Properties on page 78.

Access Booklet Maker from the Windows printer driver

1 In your application, select File > Print.

2 Select the Fiery ES as your printer and click Properties.

3 In the printer driver, click the Layout icon and select the Booklet option.
For more information, see Booklet Maker Help.

Access Booklet Maker from the Mac OS X printer driver

1 In your application, select File > Print.

2 Select the Fiery ES as your printer, and select Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.

Printing

Print Options

98



4 In the printer driver, click the Layout icon and select the Booklet option.
For more information, see Booklet Maker Help.

Access Booklet Maker from Command WorkStation

1 Double-click your print job in the Held or Printed list, or right-click the job and select Properties.

2 Click the Layout icon in the Job Properties window.

3 Select the Booklet option.

4 Specify the Booklet Maker settings or click Launch Wizard to specify the settings graphically.
For more information, see Command WorkStation Help.

About Booklet Maker imposition

Imposition is the process of printing multiple pages on single sheets of paper.
When imposed sheets are folded together as signatures, the pages follow in sequential, or reading, order. Booklet
Maker is designed for 2-up imposition, which imposes four individual pages from your document on a single sheet
that is printed duplex.
The order in which pages are imposed is determined by the binding method that you select.

Booklet Maker and Impose

Booklet Maker settings are supported by Impose, if turned on.
You can open a job with Booklet Maker settings in Impose to preview the imposition layout or further modify the
imposition layout, if necessary.
Impose translates and maps all Booklet Maker settings to Impose commands.

Note: When a job with Booklet Maker settings has been edited in the Impose window, the job can no longer be
edited in Booklet Maker. Impose offers more settings that cannot be mapped to Booklet Maker settings.
For more information about Impose, see Utilities.

Create a booklet with the booklet options in the printer driver or Job Properties

Booklet Maker dynamically displays all of the controls applicable to creating a booklet in the main Booklet Maker
window.
1 Select a Booklet Type: Saddle, Nested Saddle, or Perfect.

2 Select a binding edge: Left, Top, or Right.

3 Specify a Paper size.

4 Select Shrink to fit, if required.
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5 Specify Page alignment.

6 Specify Creep compensation, if required.
Creep compensation is available for saddle and nested saddle booklets.

7 Specify cover settings, if you selected a saddle booklet.

Note: Cover settings are only available for saddle booklets. (See Adding a cover to a Saddle booklet on page 100).

8 Click OK to save your settings, Cancel to cancel the job, or Print to print your job.

Create a booklet with the Booklet Maker wizard

In the Booklet Maker wizard, accessed by clicking Launch Wizard, the windows display the steps in the booklet-
making process.
1 Click Launch Wizard.

2 Specify the Booklet Type (binding method) and binding edge.

3 If Saddle was selected for Booklet Type, specify cover and content settings, and then click Next.

4 Specify paper size and media settings, and then click Next.
If Saddle was selected for Booklet Type, specify the paper settings for the cover, and then click Next.
If Nested Saddle was selected for Booklet Type, specify number of sheets in a subset.

5 Specify layout settings, and then click Next.
If Saddle or Nested Saddle was selected for Booklet Type, specify creep compensation.

6 View the settings summary.

7 Click Finish to save your booklet, Back to change any settings, or Cancel to cancel the job.

Adding a cover to a Saddle booklet

You can add covers (optional) for Saddle booklets only with the Booklet Maker wizard.

Add a pre-printed cover to a Saddle booklet

1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.

2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

3 Select Pre-Printed from the Cover Content input menu.

4 Click Define Cover and specify the cover media settings.

5 Click OK.
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Add an inline cover to a Saddle booklet

1 In the main Booklet Maker window, select Saddle for Booklet Type and a binding edge.

2 Specify the required settings for Paper Size and Page Alignment for the body of the booklet.

3 Select Front & Back Separately from the Cover Content input menu.

4 Specify the Front cover and Back cover settings.

5 Click Define Cover and specify the cover media settings.

6 Click OK.

Note: When you print an inline cover with top-edge binding, the outside back cover automatically rotates 180
degrees to match the orientation of the front cover.

Booklet Maker cover options for Saddle booklets

For Saddle only, Booklet Maker includes two cover options: pre-printed or inline, for which you can specify media.
You can specify additional options for an inline cover by specifying the following cover options:

• Content input: Select from Front and Back Separately or Pre-Printed.

• Front and Back Separately: Select this option to specify an inline cover that prints the cover pages and body pages
as a single job. Separate pages from your document are imposed on a single sheet that forms the cover pages of
your booklet.
You can specify an inline cover when your original document includes the cover pages and/or cover artwork for
your booklet. The cover content may be the first and last pages of your document, or the first two and last two
pages of your document, or any combination.
If you select this option, you can specify the Front cover and Back cover options.

• Pre-Printed: Select this option to insert a pre-printed cover that will be merged with the body pages of your
booklet, which print separately.
If you select this option, the Front cover and Back cover options are disabled.

• Front cover and Back cover: These options allow you to quickly decide whether your front and back covers print
duplex, single-sided, or both sides blank, without needing to add blank pages in your original document.
With top-edge binding that includes a cover, the outside of the back cover automatically rotates 180 degrees to
match the orientation of the front cover.

• Define Cover: This option allows you to select cover media settings for your cover pages, which may be trimmed.
This option is available for both pre-printed and inline covers.

Printing Booklet Maker jobs

Booklet Maker does not support jobs sent to the Direct connection. Booklet Maker print jobs must be sent to the
Print queue or Hold queue.
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Set measurement units in Command WorkStation

You can change the default unit of measurement for all input fields in the Command WorkStation Preferences
dialog box.
Units specifies the units of measurement used to display attributes, such as page sizes and custom sizes, that you
enter in the Job Properties dialog box. This setting does not affect predefined page-size values.

1 In Command WorkStation, select Edit > Preferences.

2 Click Regional Settings.

3 Select the unit of measurement (millimeters, points, or inches).

4 Click OK.
The changes are not effective until Command WorkStation is restarted.

Defining and printing custom page sizes

With custom page sizes, you define the dimensions of a printed page. After you define a custom page size, you can
use it from within an application without redefining it each time you print.
When you create custom page sizes, specify width dimensions to correspond with the shorter side of your job and
specify height dimensions to correspond with the longer side of your job. Set custom page sizes in this way,
regardless of the orientation settings in the application.

Callout Refers to

1 Portrait orientation

2 Landscape orientation

3 Height

4 Width

Note: Custom page sizes are not supported with Imposition jobs.
For information about defining and printing custom page sizes, see printer driver Help.
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Document size and Paper size

Document size is the page size defined in your application’s Print setup (or Page setup) dialog box.
Paper size is the size of the actual sheet of paper on which your job is printed. It may be useful to think of Document
size as digital input (the page size defined in your original document) and Paper size as the physical output (the
actual size of the paper in the printer tray).
In cases when you print one document page per sheet of paper, Document size is usually the same as the Paper size.
However, Document size may differ from Paper size when you print booklets or impose multiple document pages on
a single sheet.
The illustrations show examples of possible relationships between Document size and Paper size. Note that the
orientation of all pages shown is landscape.

Description Document size (input) Paper size (output)

Document size is the same as Paper size. Scaling is 100%. Letter Letter

Tabloid Document size scaled to fit on Letter Paper size. Scaling is 50%. Tabloid 11x17 Letter

A4 Document size scaled to fit on A3 Paper size. Scaling is 141%. A4 A3

Document size may also differ from Paper size when using the Scale or Scale to fit options. The Scale option reduces
or enlarges the document page at a specified percent. The Scale to fit option automatically reduces or enlarges the
document image to fit the selected paper size.
For information about Document size and Paper size in booklet printing, see Booklet Maker Help.
For more information, see Scale on page 77.
For more information, see Scale to fit on page 76.
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Fold options

The Fold style specifies how the folded job is printed.
You can specify whether the pages of your folded job print with the imageable area on the inside or outside of the
folded sheet.

Fold style Fold illustration

Half-fold

Tri-fold

Z-fold (A3, B4, 11x17, 8K)

Z-fold (8 1/2x14)

A finisher capable of folding must be installed on the printer to use the Fold print option.
For information about finishers and other installable options, see printer driver Help.

Gang-up printing

Gangup layout options are used for speed printing imposition modes.
The Fiery ES includes two speed-printing options for gang-up printing:

• Step & repeat - Select this option to speed print a job so that the first page of your document is printed twice on
the first sheet. The next sheet duplicates the data on the second page, the next sheet duplicates the data on the
third page, and so on. When the printed sheets are cut in half, the result is two complete sets of the same
document.
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2 2

2 2

1 1

3 3

1 1

4 4

Callout Refers to

1 Single-sided, front only

2 Duplex (double-sided), front (1, 3) and back (2, 4)

• Cut & stack - Select this option to speed print a job so that when the sheets are stacked and cut from the central
position, the job is numbered in order and separated as two stacks. The print order is such that when the sheets
are cut in half, you can combine them to form a single complete set of the document, in faster printing time.

2 6

2 4

1 3

3 7

1 5

4 8

Callout Refers to

1 Single-sided, front only

2 Duplex (double-sided), front (1, 3, 5, 7) and back (2, 4, 6, 8)

For more information, see Gangup layout options on page 77

Access Gang-up print from the Windows printer driver

1 In your application, select File > Print.

2 Select the Fiery ES as your printer and click Properties.

3 In the printer driver, click the Layout icon and select the Gangup option.

Access Gang-up print from the Mac OS X printer driver

1 In your application, select File > Print.

2 Select the Fiery ES as your printer and select Fiery Features from the drop-down list.

3 Click Full Properties in the Quick Access pane.
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4 In the printer driver, click the Layout icon and select the Gangup option.

Image Enhance

The Image Enhance feature lets you apply photo finishing enhancement to color images on specified pages or sheets
of a job. This feature affects only photographic images, not graphics such as logos or charts.
To turn on this feature, select the Apply image enhancement check box for a job and specify the pages or sheets to
be affected. This option is located in the Image tab of the printer drivers and Command WorkStation Job Properties.
You can customize Image Enhance settings from Command WorkStation.
For more information, see Command WorkStation Help and Color Printing.

Print Duplex (double-sided) pages

1 In your application, do one of the following:

• On Mac OS X computers: Select File > Print, select the Fiery ES as your printer, select Fiery Features from the
drop-down list, click Full Properties in the Quick Access pane, and then select Normal on the Layout tab.

• On Windows computers: Select File > Print, select the Fiery ES as your printer, click Properties, and then click
the Layout icon.

2 Select one of the Duplex settings:

• Right & left bind: Prints the top of the image on Side 1, on the same edge of the page as the top of the image on
Side 2.

• Top bind: Prints the top of the image on Side 1, on the opposite edge of the page from the top of the image on
Side 2.

Orientation Right & Left bind Top bind

Portrait 1 2 1

2

Landscape 1 2 1

2

3 Print the job.

Punch position and hole punching

You can specify the number of holes to punch and the location of the punched holes.
A finisher capable of punching must be installed on the printer.
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Note: Punch positions vary according to paper size, paper type, number of pages, feed direction, and original
orientation.

Punch
setting

Portrait: Left Portrait: Right Portrait:Top Landscape: Left Landscape: Right Landscape: Top

2-holes

3-holes

4-holes

The number of holes differs depending on the finisher destination:

• US, 2-holes or 3-holes

• EU, 2-holes or 4-holes

For information about finishers and other installable options, see printer driver Help.

User Authentication

If Users and Groups user authentication is configured in Fiery ES Setup, you must enter a valid user name and
password to send a print job to the Fiery ES.
In Command WorkStation, the management of jobs is determined by how you log on to the Fiery ES.
The print options associated with User and Groups user authentication are as follows:

• On Mac OS X computers: Select the Job Info icon and type logon information in the User name and Password
fields.

• On Windows computers: Set the following:

• Use Windows Login - Select this option if you are already logged on to a Windows computer. Otherwise, type
your Windows network logon information in the User name and Password fields.

• Validate - Click to validate user authorization and to confirm printing privileges. To validate, Two-Way
Communication must be turned on. For information on establishing Two-Way Communication, see printer
driver Help.

• I’m a guest - Select this option to activate guest printing privileges. By default, guest printing is turned on.

For information about turning on Users and Groups user authentication in Configure, see Configuration and Setup
and Command WorkStation Help.
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Introduction

The Fiery® ES IC-416 media pack includes a set of software utilities that allow you to manage the Fiery® ES IC-416, as
well as the print workflow and content of jobs on the MFP.
This document provides an overview of how to install, configure, and use the following Fiery® ES IC-416 utilities:

• Command WorkStation monitors and manages the print workflow of jobs on the Fiery® ES IC-416.

• Fiery Preview provides a soft proof of each sheet surface of a job before it is processed. The visual interface
changes dynamically to display any changes made in preparing documents for printing.

• Fiery Impose applies imposition layouts to jobs for custom printing, binding, and trimming.

• Fiery Compose defines the chapter divisions of a job, specifies ranges of pages on varying types of media, inserts
blank media between pages, and inserts tab media containing text labels.

• Fiery Productivity Package offers additional color and production features for operators (or users with Operator
or Administrator privileges) to monitor and manage the print workflow of jobs.

• Fiery Remote Scan retrieves a scan on the printer from a remote computer on the network. Includes the Scan
TWAIN plug-in module.

• Hot Folders provide a simple and automated method of sending print jobs to the Fiery® ES IC-416 across the
network by allowing documents to be dropped into a folder associated with preset print options.

• WebTools manages your Fiery® ES IC-416 remotely from the Internet or your company intranet.

For information about using color management, see Color Printing.
For information about Fiery Productivity Package, see Fiery Productivity Package.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-416, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Printer MFP

Fiery ES Fiery® ES IC-416

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in Configuration
and Setup.
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Term or convention Refers to

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To use
the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-416.

Resource Description

User guides (titles in
italics)

Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material (titles in
italics)

• Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

Utilities
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Installing user software

You can install Fiery ES user software on Windows and Mac OS computers.
Install user software in one of the following ways:

• From the User Software DVD

• From the Fiery ES, using the Internet or intranet

If earlier versions of Fiery ES user software are installed on your computer, the installer allows you to uninstall those
applications before installing new software.

Note: When you upgrade user software, use the Fiery User Software Installer and follow the instructions by selecting
Modify.
For more information, see Modify user software from media on page 8.
If you do want to uninstall an earlier version of user software, you may want to back up your settings. Back up and
restore of Fiery ES resources and settings is available from Command WorkStation. For more information, see
Configuration and Setup and Command WorkStation Help.
After first-time installation of Fiery ES user software, updates are managed by the Fiery Software Manager
application. For information, see Using Fiery Software Manager on page 10.

Note: Before installing Fiery ES user software, you must disconnect any measurement instrument from the
computer. Otherwise, after installation the instrument may not be recognized by the software.

Installing user software on a Windows computer

All installation of user software on a Windows computer is done with the Fiery User Software Installer.
Before installing the software, ensure that your computer meets the minimum system requirements. For system
requirements, see Configuration and Setup.
The only applications that are not installed by the Fiery User Software Installer are Adobe Acrobat and Enfocus
PitStop, for use with Fiery Impose/Compose. For more information, see Fiery make-ready applications on page 18.
Procedures describe installing from the User Software DVD, over the network, or over the Internet, and also
modifying the user software.
Procedures describe installing from the User Software DVD, or over the Internet, and also modifying the user
software.
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Install user software on a Windows computer from media

1 Insert the User Software DVD into the DVD drive of your computer.

2 Follow the on-screen instructions.

Important: Do not attempt to install user software by opening the individual folders for the applications. To
modify or remove user software after you install it on your computer, use the Fiery User Software Installer.

Modify user software from media

1 Insert the User Software DVD into the DVD drive of your computer.

2 In the window that appears, select Modify, Repair, or Remove.

• Modify: Allows you to add new program features or remove currently installed features.

• Repair: Reinstalls all currently installed program features.

• Remove: Removes all currently installed program features.

3 Follow the on-screen instructions.
You can also install the user software from the Fiery ES over the Internet or your company intranet, using
WebTools. Ask your network administrator for the IP address of the Fiery ES.
Use your Internet browser to access WebTools. For complete information about browser and system
requirements, see Configuration and Setup.

Install user software on Windows from WebTools

1 Start your Internet browser.

2 Type the IP address or DNS name of the Fiery ES.
If the home page for the printer appears instead of the WebTools page, click the WebTools link.

3 Click the Downloads tab.

4 Click the link for the software that you want to install.

5 Choose Run to open the file or choose Save to save it to your computer.
a) If you choose Save, browse to the location where you want to save the USERSWMI.exe file, and then click

Save.

b) Double-click the USERSWMI.exe file.

6 Type the Fiery ES URL, http://<IP address>, when prompted.

7 Follow the on-screen instructions.
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Uninstall user software on Windows

To remove user software after you have installed it on a Windows computer, use the Fiery User Software Installer.

Note: Do not attempt to uninstall user software from the Windows Control Panel.
For information, see Modify user software from media on page 8.

Installing user software on a Mac OS computer

Installation of user software on a Mac OS computer is done separately for each application.
Note the following:

• When you initiate installation of an application, any previous version installed on the client computer is
automatically removed.

• All applications must be from the same package of software. When you initiate installation of one application
from a package, all applications on the client computer from a different package are removed. You are prompted
to re-install the applications from the new package. If necessary, you can manually uninstall the user software
using the Fiery Software Uninstaller.

Adobe Acrobat and Enfocus PitStop, for use with Fiery Impose/Compose are supplied with your Fiery Impose/
Compose kit and are installed in a separate operation. For more information, see Fiery make-ready applications on
page 18.
Installing and uninstalling user software on a Mac OS computer can be done from the User Software DVD, or over
the Internet or your company intranet. Ask your network administrator for the IP address of the Fiery ES

Note: The paragraph above applies to the Fiery ES.
Use your Internet browser to access WebTools on the Internet. For complete information about browser and system
requirements, see Configuration and Setup.
For information about installing printer drivers, see Printing.

Install user software on Mac OS from media

1 Insert the Fiery ES User Software DVD into the DVD drive of your computer.

2 In the User Software window, open the Mac_User_SW folder.

3 Double-click the Fiery Applications.dmg icon.

4 Double-click the icon for the application that you want to install.

5 To install printer drivers, double-click the Fiery Printer Driver.dmg icon.

Note: For information on installing printer drivers, see Printing.

6 Follow the on-screen instructions.
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Install user software on Mac OS from WebTools

1 Start your Internet browser.

2 Type the IP address or DNS name of the Fiery ES.
If the home page for the printer appears instead of the WebTools page, click the WebTools link.

3 Click the Downloads tab.

4 Click the link for the software that you want to install, client software or printer files.
If you selected client software, the Fiery Applications.dmg file is downloaded to your computer. If you selected
printer files, Fiery Printer Driver.dmg file is downloaded.

Note: For information on installing printer files, see Printing.

5 Double-click Fiery Applications.dmg.

6 Double-click the icon for the application that you want to install.

7 Follow the on-screen instructions.

Uninstall user software on Mac OS

1 Insert the User Software DVD into the DVD drive of your computer.

2 Double-click the icon for the Fiery Software Uninstaller.

3 Drag the Fiery Software Uninstaller icon to your Applications folder.

4 Choose Go > Applications > Fiery Software Uninstaller.

5 Select the software that you want to uninstall and follow the on-screen instructions.

Using Fiery Software Manager

Fiery Software Manager is installed automatically by the Fiery User Software Installer and manages any available
updates of the Fiery User Software.
After installation, the Fiery Software Manager icon is displayed by default in the Windows computer task bar or the
Menu bar on a Mac OS computer. You can specify a number of preferences for managing updates.

1 Right-click the Fiery Software Manager icon in the task bar (Windows) or the Menu bar (Mac OS) and select
Preferences.

2 Select one of the following:

• Launch at Login (default setting): Fiery Software Manager automatically checks for updates and notifies you.

• Download updates automatically: Fiery Software Manager notifies you which versions of applications are
installed and what updates are available.
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• Show additional features: Installs server updates for Fiery JDF (service technicians only) or downloads server
language packages for additional language support.

• Help EFI improve its software: Allows EFI to collect anonymous usage data from Fiery applications.
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Command WorkStation

Command WorkStation is a cross-platform application that gives operators the tools to manage jobs on the Fiery ES,
and administrators the tools to configure the Fiery ES for printing.
Command WorkStation includes the Job Center for job management, Device Center for server resource
management, and Fiery make-ready applications for complex preparation of jobs for printing.
In the Job Center and Device Center views, the Servers list shows every Fiery ES that you are connected to. You can
switch between servers, and add or remove them from the list. Information is available about consumables on the
printer, tray association status, and errors and alerts.

• Job Center displays the tools for managing jobs in the print queues, and a job preview of processed jobs. The
status of jobs is shown. You can search for jobs and access features from the customizable toolbar.

• Device Center gives you access to all of the resources of the Fiery ES. From the Device Center, you can access
Server Configuration and tools such as Backup & Restore. You can perform Color Setup, configure Virtual
Printers, manage VDP Resources, and view fonts installed on the Fiery ES.

Installing Command Workstation

Install Command WorkStation on a Windows or Mac OS computer with a network connection to the Fiery ES.
For a complete list of system requirements, see Configuration and Setup.
The Installer is provided on the User Software DVD as part of the Fiery User Software Installer (Windows
computers) or as a separate application (Mac OS X). To install Command WorkStation, see Installing user software
on page 7.

Connecting Command WorkStation

To use Command WorkStation, you must configure the connection to the Fiery ES.
The first time you start Command WorkStation, you are prompted to configure the connection to the Fiery ES. You
can also edit the configuration whenever a change to your Fiery ES or network occurs, such as a changed server
name or IP address. If you change Fiery ES Setup information, do so before you reconfigure the connection.

Note: Officially, Command WorkStation is supported for up to ten simultaneous connections to Fiery ES Servers.
However, additional connections are not blocked by the user software.
The Fiery ES Configuration page contains information you need when configuring the connection, such as the IP
address of the Fiery ES. For TCP/IP installations, you can use the DNS name instead of the IP address. Make sure
that the Fiery ES is registered in a Domain Name Server (DNS) on your network. For more information, contact your
network administrator.
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Configure the connection to the Fiery ES

Configure the connection from Command WorkStation to the Fiery ES.
Before configuring the connection, you must obtain the IP address or DNS name of the Fiery ES. Print the
Configuration page to obtain this information.

1 Start Command WorkStation:

• Windows: Click Start and choose All Programs > Fiery > Command WorkStation 5.

• Mac OS: Choose Go > Applications > Fiery > Command WorkStation 5 > Command WorkStation.

2 Type the DNS name or IP address and click Add to add the server to the Disconnected servers list.
a) If no Fiery ES is found, click the Search icon, search by a range of IP addresses or by the IP address and subnet

mask, and then click Go. Or, select Auto Search. All available servers are listed.

b) To search for a particular server, type the server name in the Filter by keyword field.

c) Select the Fiery ES that you want to use, click Add, and then click Connect.

3 Choose Administrator, Operator, or Guest from the User menu and type the appropriate password, if required.
Ask your administrator for the password for the Fiery ES that you want to connect to.
You have the option to save your password by selecting Save password. The next time you log on as that user, the
password is automatically entered. Command WorkStation saves one password per Fiery ES at any one time.
For information about setting passwords and the default Administrator password for the Fiery ES, see
Configuration and Setup.

Note: In addition to the three default user names of Administrator, Operator, and Guest, users can login with
their own user names if the network administrator has set them as a member of one of the groups in Configure >
User Accounts.

4 Click Login.

Command WorkStation is now connected to the Fiery ES. You can begin using Command WorkStation to monitor
and manage jobs on the Fiery ES.
For information about managing and connecting another Fiery ES, see Command WorkStation Help.

Using Command WorkStation

For instructions on using Command WorkStation, features, see the online Help.
The Help menu offers access to the following resources:

• Help provides detailed procedural information.

• How To accesses the EFI web page, which provides demo scripts and sample files.

• What’s New describes the new features of Command WorkStation.
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Mixed Media

The Mixed Media feature allows you to define the chapter divisions of a job, print ranges of pages on varying types of
media, and insert blank media between pages.
The following guidelines and restrictions apply to Mixed Media settings:

• The Mixed Media dialog box restricts you from specifying settings that conflict with any media, page size, or
finishing settings that have been specified for the job in the Job Properties dialog box or printer driver.

• When you specify print options (in the Job Properties dialog box or printer driver) after specifying Mixed Media
settings, certain print options may conflict with the page-specific Mixed Media settings. You must resolve the
conflict by choosing different print options or removing certain Mixed Media specifications.

• Mixed Media settings affect the use of output color profiles when the Use media defined profile option is
selected in Color Setup. For more information, see Color Printing.

Define media for selected pages

You can define different media for selected pages, or a range of pages.
1 Select or right-click a spooled/held job in the Job Center view and choose Properties from the Actions menu, or

double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

3 In the Mixed Media dialog box, click New Page Range.

4 In the Page/Page Range Media dialog box, type pages and page ranges as comma-separated values (for example:
3,9–14,18).

5 Choose other settings, as required.
If you assign a new media type to the back side of a duplexed sheet, a blank page is inserted to force the assigned
page content to the front side of the next sheet.

6 Click the Custom button to open the Custom Paper Size dialog box and specify a custom output paper size.

7 Choose the required media from the Media menu.

8 Click Add Definition after each media setting that you define.

9 Click Close to return to the Mixed Media dialog box.

Insert blank pages

You can insert blank pages in your job and assign different media for them.
1 Select or right-click a spooled/held job in the Job Center view and choose Properties from the Actions menu, or

double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

3 Click New Insert in the Mixed Media dialog box.
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4 Indicate whether to insert the blank before or after the target page. Define the target page as the first or last page
in the document, or as a specific numbered page.

5 Choose other settings, as required.

6 Click the Custom button to open the Custom Paper Size dialog box and specify a custom output paper size.

7 Choose the required media from the Media menu.

8 Click Insert after each blank page that you define.

9 Click Close to return to the Mixed Media dialog box.

Insert tabs

The Insert Tab feature allows you to automatically insert tab pages throughout a job.
The Insert Tab feature accommodates various sizes and types of tab media stock. You can insert the tab text and
override text attributes on a per-job basis.

Note: When you configure counters for the printer, printed tab pages count as black-and-white pages, provided the
tab text color is set to the default (Black). Expelled tabs are not counted as printed pages.

1 Select or right-click a spooled/held job in the Job Center view and choose Properties from the Actions menu, or
double-click a job.

2 Click the Media icon and scroll down to Mixed Media.

3 Click New Tab in the Mixed Media dialog box.

4 In the Insert Tab dialog, type the number of tab positions included in a complete tab set in the Number of tabs
in a set field.
This specification ensures that tab text is printed in the correct tab positions. For example, tab positions in a set
consisting of ten tabs are distinct from tab positions in a set consisting of five tabs.

5 Specify other settings as required for the tab stock.
Paper size values refer to the dimensions of the stock, including the tabbed portion.

6 To specify attributes for the tab text, type the number of tabs in the Number of tabs to insert field, and then click
Insert.

Specify tab text

You can specify what text you want on inserted tabs, and also specify styles.
1 If you want all the tabs to use the same text attributes, select the Apply the same text attributes for all tabs option

in the Tabs Text area of the Insert Tab dialog box.

2 In the Text Attributes column, click the arrows to display the menus for font, size, color, text rotation, and text
alignment, and choose the attributes that you want from each menu.
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3 Indicate where you want each tab inserted in the document.
a) In the Page field, type the page number where you want the tab inserted.

b) Select Before to insert the tab before the page number, or clear this check box.

Note: If you define a tab to be inserted between an odd-numbered page and an even-numbered page in a duplex
job, the tab is inserted after the odd-numbered page on the first sheet, and the even-numbered page is printed
on the next sheet.

4 Type the desired tab text for each tab in the Tab Text field.
To define text attributes for each tab individually, click Text Attributes for that tab.

5 After you type the tab text, click OK to close the Insert Tab dialog box.

6 To modify media settings for the tabs, select the tab description in the Mixed Media Definition list, and then click
Edit.

7 To apply your Insert Tab settings to the document, click OK to close the Mixed Media dialog box and Job
Properties.

Image Enhance

Use the Image Enhance print option to apply photo enhancement to photographic color images on specified pages
or sheets of a job.

Important: This feature is not used on graphics such as logos or charts.

To turn on this feature, select the Apply Image Enhancement option for a job and specify the pages or sheets to be
affected. This option is located in the Image tab of the printer driver and Job Properties. You can customize Image
Enhance settings from Command WorkStation.
For more information about the Image Enhance print option and how to configure it, see Printing.

Troubleshooting connections

If you cannot connect to the Fiery ES or locate the Fiery ES from your computer, contact the network administrator.
The administrator may need to troubleshoot your network connections and check settings on the servers that you
print to. If settings have changed, it may be necessary to reconfigure the Fiery ES (see Configuration and Setup).
If you can connect to the Fiery ES with another utility, you may need to reconfigure the Command WorkStation
connection to the Fiery ES.
If you configured the Fiery ES and set up client computers and network servers according to the instructions in
Configuration and Setup, print a Test Page. If you can print the Test Page but still cannot print a document from a
remote computer, contact your network administrator to troubleshoot the network connection.
If you cannot connect and cannot print a Test Page, check the printer control panel for error messages.
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Command WorkStation does not respond

You can try different actions when Command WorkStation does not respond.
If the Command WorkStation windows do not update:

• Log off and then quit Command WorkStation.

• Restart Command WorkStation or restart the computer.

If the Command WorkStation windows do not update or no jobs are displayed, and the mouse has no effect (you
cannot select a job or a window, use a right mouse command, or select a menu item), the Fiery ES is offline or
network communication has failed.
To force an exit from Command WorkStation:

• Windows: Press Ctrl-Alt-Delete and use the Task Manager to close Command WorkStation.

• Mac OS X: Choose Apple menu > Force Quit, select Command WorkStation, and then click Force Quit. Or, press
Command+Option+Esc, select Command WorkStation, and then click Force Quit.

• At the Fiery ES, disconnect and reconnect the network cable, and then try printing a Test Page or Configuration
page.

• If printing fails, restart the Fiery ES.

Create a job error report

If you encounter any errors while processing or printing a job, you can create a job error report in Command
WorkStation for troubleshooting purposes.
The job error report can be sent to technical support.

1 Select a job in the Printed or Held list in Command WorkStation.

2 Press Ctrl (Windows) or Command (Mac OS) at the same time as you right-click.

3 Click Create Error Report.

4 Add the information you want to include in the Error Report.

5 Follow the instructions.
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Fiery make-ready applications

Fiery make-ready applications integrate labor-intensive document preparation activities at both the sheet level and
page level in one visual interface.
These integrated job preparation tools offer the following modes, depending on what client license is available:

• Preview provides a preview of a job before it is processed and is a standard feature of Command WorkStation.
Users can do a soft proof of each sheet surface of a job before it is processed. The visual interface changes
dynamically to display any changes made in preparing documents for printing.

• Fiery Compose allows you to define the chapter divisions of a job, print ranges of pages on varying types of
media, insert blank media between pages, and insert tab media containing text labels (if the printer supports tab
printing). 

• Fiery Impose applies imposition layouts to jobs for custom printing, binding, and trimming. Fiery Impose also
applies impositions to variable data jobs and saves imposed jobs as PDF files.

The Fiery make-ready applications are supported on both Windows and Mac OS computers. For information about
system requirements, see Configuration and Setup.

Fiery make-ready software kits

The Fiery make-ready applications are available in several different kit configurations.
You must have the software kit-specific licenses installed on your computer to use the full functionality of the
software. If you choose not to activate the license for any of the components, Fiery Impose runs in Demo mode, and
Fiery Compose settings are not displayed. In Impose Demo mode, imposed jobs print with a watermark, and you can
save imposed jobs in .dbp format to the Fiery ES. You can save imposed jobs in Adobe PDF format to a hard drive
and the Fiery ES when you are in Demo mode, but they are saved with a watermark.
The available kits are:

• Fiery Impose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License Activation Code)

• Fiery Compose kit (includes the Adobe Acrobat/Enfocus PitStop DVD and a License Activation Code)

• Fiery Impose-Compose kit, which includes both Fiery Impose and Fiery Compose (includes the Adobe Acrobat/
Enfocus PitStop DVD and a License Activation Code)

Enabling Fiery make-ready applications

Fiery make-ready applications are license-protected features of Command WorkStation that work in conjunction
with Adobe Acrobat and the Enfocus PitStop plug-in.
Fiery make-ready applications include Fiery Impose and Fiery Compose.
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You must install a special license on each computer that runs the software. This section explains how to install the
license and the required software. Note the following:

• The License Activation Code is provided on a card in your kit.

• Adobe Acrobat must be installed on the same computer as the Fiery make-ready application to preview .ps files.
You do not need Adobe Acrobat or Enfocus PitStop to preview .pdf files.

Install a license for your software option

A special license is required to use your software option.
You can install a license in the following ways:

• Automatically, if you are connected to the internet, as described below.

• Manually, if you are not connected to the internet. See Activate a Fiery option manually on page 19.

You can de-activate the license and re-activate it on a different computer. See Fiery Options Help, accessed from the
License Activation window.

1 In Command WorkStation, right-click a spooled job and choose Impose or Compose.

2 If you are asked whether to activate the option, click Yes.
If you selected Impose, you can select Use Demo or Yes.
To open the License Activation window, you can also select Preview in step 1, and choose Help > Manage License.

3 In the License Activation window, click Activate.

4 To agree to the terms and conditions of the license agreement, click Continue.

5 For License Activation Code, type the LAC you received in your kit, and click Continue.

6 If the Fiery option name is correct, click Activate.

7 Click Finish.
For more information about the activation process, click the Help icon in the License Activation window.

Activate a Fiery option manually

If the computer is not connected to the Internet, you must manually transfer data between the computer and the EFI
licensing website. You will generate a request file, submit it to the EFI licensing website to obtain a license file, and
then use the license file to activate the option.
1 In the License Activation window, click Activate.

2 Click Continue to agree to the terms and conditions of the license agreement.

3 Type the LAC in the License Activation Code field, and then click Continue.

4 Click Continue to proceed with the manual process.

5 Click Create Request File and save the file.

6 Copy the request file to a computer that is connected to the Internet.
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7 Open a browser and go to licensing.efi.com.

8 Click Browse, select the request file, and then click Upload.

9 Click Continue.

10 Click Download License File and save the file.

11 Copy the license file to the computer where you first entered the License Activation Code.

12 Return to the Generate License window and click Yes.

13 Click Browse, select and open the license file, and then click Activate.

14 If the activation requires a restart, you can either click Restart to restart now or click Finish if you want to activate
additional options before restarting. If the activation does not require a restart, just click Finish.

Install Adobe Acrobat and Enfocus PitStop Pro

Install Adobe Acrobat and Enfocus PitStop Pro from your software option kit.
1 If the most recent versions of Adobe Acrobat and Enfocus PitStop Pro are not installed, uninstall the versions

that are currently resident on the computer.
a) Close all open applications.

b) Follow the instructions for your computer for removing programs.

c) After you finish uninstalling earlier versions of Adobe Acrobat and Enfocus PitStop, restart the computer.

2 Close all software applications that are currently running on the computer.

3 Insert the Adobe Acrobat/Enfocus PitStop DVD (Windows or Mac OS) into the DVD drive of your computer.

4 If the installer does not start automatically, navigate to the root level of the DVD and double-click Setup.exe
(Windows) or Setup.app (Mac OS).

• Mac OS X: Click Install and follow the on-screen instructions.

• Windows: Select the language and click Next.

The software option that you purchased is now fully enabled.

Fiery make-ready applications help

Fiery make-ready applications help is accessed from the application window.
Fiery make-ready applications include Fiery Impose and Fiery Compose.
The Help menu offers access to the following kinds of help:

• Help provides procedural information.

• How To accesses the EFI web page, which provides demo scripts and sample files.

• What’s New describes the new features of Command WorkStation.
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Scan

Scan is a collection of software components that allow you to scan documents from the printer glass (platen) or
through the automatic document feeder (ADF) on the printer and send the scanned images to specific destinations.
Scan consists of the following:

• Fiery Remote Scan includes the TWAIN plug-in module. Fiery Remote Scan allows you to retrieve a scan from a
printer.

• Scan to Mailbox allows you to send the scan to a mailbox on the Fiery ES, from where it can be retrieved.

• Docs WebTool allows you to retrieve scanned jobs from mailboxes on the Fiery ES.

User Box feature on the printer

The User Box feature on the printer allows you to scan documents from the printer glass or through the printer’s
automatic document feeder (ADF) and save the scanned images to mailboxes on the printer hard disk.
After scanning a document to a User Box on the printer, you can send the scans to specific destinations, such as a
local drive, and also retrieve them using WebTools Mailbox and Fiery Remote Scan. To save data to a User Box,
create the box, and then scan the data to the specified box. Each user can have access to multiple boxes: Public,
Personal, and Group boxes.
Public User Boxes are accessible to everyone, Personal User Boxes are assigned to a single user, and Group User
Boxes can be used by the users who are logged in as members of that User Box group account.
Different levels of authentication are supported on the printer. User authentication may be enabled to access the
printer, as well as mailboxes, depending on the type of mailbox and the environment. Public boxes are accessible in
any scenario, with user authentication turned on or off. For Personal boxes, user authentication is turned on, and
then users create their own personal boxes by entering a box/name and an optional password. For Group boxes, the
account track feature must be enabled on the printer, and a password and user name are required to access each box.
To find out what levels of user authentication have been set on the printer, ask your system administrator.
The printer supports the following file formats: PDF, Compact PDF, TIFF, JPEG, XPS, and Compact XPS. The
default file type for scanning is PDF, which is supported in Command WorkStation. If a job is scanned in a format
that is not supported in Command WorkStation, it is still possible to print the file using the Fiery ES printer driver or
third party application printer driver.
The printer also supports producing multiple page files or single page files for all file formats supported, except for
JPEG, which supports only single page files. To scan a multiple-page job in JPEG format, you must scan each page
separately.
See Scan to a User Box on page 22 for an overview of scanning to a User Box. More information about setting up
User Boxes on the printer is provided in the manual that accompanies your printer.
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Scan to a User Box

This procedure provides an overview of scanning to a User Box from the printer control panel.
1 If user authentication is enabled, enter the user name and password.

Ask your system administrator for the log in information.

2 Press Fax/Scan on the printer control panel.

3 Press Direct Input.

4 Press User Box.

5 Select a User Box.
You can also create a User Box by entering a User Box number.

6 Enter the document name.

7 Specify scan settings.

8 Press Start.

For more information, see the guide that comes with your printer.

Installing Fiery Remote Scan

To install and use Fiery Remote Scan, either as a separate application or as a plug-in module, you must have a
Windows or Mac OS computer with a network connection.
For detailed system requirements, see Configuration and Setup. The installer for Fiery Remote Scan is located on the
User Software DVD. To install Fiery Remote Scan, see Installing user software on page 7.

• Access Fiery Remote Scan in the following ways:

• The Remote Scan application is a separate application started from your desktop. The Remote Scan application
allows you to retrieve scan files from a mailbox.

• The Remote Scan TWAIN plug-in module is used with compatible TWAIN compliant applications, such as
Adobe Photoshop or Adobe Acrobat. You can directly acquire the scan into the application.

Multiple Fiery Remote Scan TWAIN users can simultaneously access the same Fiery ES.

Configuring Fiery Remote Scan

When you open Fiery Remote Scan for the first time, you must configure the connection to the Fiery ES. You can
add more than one Fiery ES to the Fiery Server list in Fiery Remote Scan and select the required one from the list.
To configure the connection, you need the name or IP address of the Fiery ES. If you do not have the name or IP
address, use the Search function to find the Fiery ES on your network.
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After first use, Fiery Remote Scan automatically attempts to connect to the last Fiery ES used in the previous session.
You can immediately start to retrieve any scans initiated at the printer control panel, and use Fiery Remote Scan
Help.
Instructions for configuring and modifying the connection to the Fiery ES are also provided in Fiery Remote Scan
Help.

1 Open Fiery Remote Scan.

2 Click the Choose a Fiery icon (magnifying glass) to open the Connect to Server dialog box.

3 Type the name or IP address in the Connect to a server field.
If you do not have the name or IP address, see To perform an advanced search on page 23.

4 Click the plus sign icon to add it to the server list.
When you click the plus sign, you add the Fiery ES to the list, but do not connect to it. This operation is useful
when you want to add more than one Fiery ES in a session. You can then switch between any Fiery ES in the Fiery
Remote Scan window without opening the Connect to Server dialog box.

5 Click Connect or Cancel.
Clicking Connect adds the Fiery ES to the list at the same time as connecting to it. If the connection was
successful, the Fiery Remote Scan window opens.
If you clicked Cancel, all operations that you did to add or remove the Fiery ES are cancelled. Any server list
changes are discarded.
If you do not have the specific name or IP address of the Fiery ES, you can search by IP ranges or by subnet.

To perform an advanced search

You can search for a Fiery ES in different ways.
1 In the Connect to Server dialog box, click the Choose a Fiery icon (magnifying glass) to open the Search dialog

box.

2 Select Auto Search or select IP Range or Subnet to specify the range to search, and then click Go.
Any available Fiery ES that matches the search criteria is shown. You can filter the search result list by typing a
keyword in the Filter by keyword field.

3 Select the Fiery ES from the results list and click Add.

4 To add another Fiery ES to the list for later use, click the plus sign in the Connect to Server dialog box.

5 In the Connect to Server dialog box, click Connect to add the Fiery ES to My Fiery List and connect to it.
If you clicked Connect and the connection was successful, the Fiery Remote Scan window opens.
If you clicked Cancel, all operations that you did to add or remove any Fiery ES are canceled. Any server list
changes are discarded.
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Using Fiery Remote Scan

The Fiery Remote Scan standalone application and the Fiery Remote Scan TWAIN plug-in module manage scanning
on the printer from the Fiery ES.
With Fiery Remote Scan or the TWAIN plug-in module, you can retrieve files from the mailbox. If you are using
Fiery Remote Scan, you can choose where to save the scanned file on the computer. If you are using the TWAIN
plug-in module, you can open the scan file in a host application for editing purposes.
Instructions for using the Fiery Remote Scan application and plug-in module are provided in Fiery Remote Scan
Help, accessed by clicking the Help icon in the Fiery Remote Scan window.

Retrieving scans using Docs

You can retrieve scan jobs in the Fiery ES mailboxes to your remote workstation using WebTools Docs.
Before sending a scan to a mailbox, you must first set up the mailbox in the User Accounts area of WebTools
Configure. If desired, set a predefined user name and password for the mailbox.
For instructions on using WebTools, see Using WebTools on page 28.
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Hot Folders

Hot Folders provide a simple and automated method of sending print jobs to the Fiery ES across the network. You
drag documents to a folder that stores and reuses preset print options for printing PostScript and PDF files on the
Fiery ES.
With Hot Folders, you can do the following:

• Create special folders (hot folders) that assign specific print settings and print queues to jobs.

• Print jobs to the Fiery ES by dragging and dropping them onto hot folders on your computer’s desktop.

• Monitor the status of jobs sent to hot folders.

Installing Hot Folders

The Hot Folders Installer is on the User Software DVD.
Before installing the utility, make sure that you complete any preliminary procedures.
To install Hot Folders on a Windows computer, see Installing user software on a Windows computer on page 7. To
install Hot Folders on a Mac OS computer, see Installing user software on a Mac OS computer on page 9.

Upgrading from an earlier version of Hot Folders

Hot Folders includes a Migration Assistant that detects an earlier version of Hot Folders and upgrades any existing
Hot Folders settings to work in the latest version.
The migration takes place only once during the installation of Hot Folders or Command WorkStation. The summary
in the Migration Assistant window indicates whether or not a Hot Folder transferred successfully to the latest
version, and in case of failure, allows you to retry once during installation without exiting the Migration Assistant.

1 Install Hot Folders and allow the Migration Assistant to detect the earlier version.

Note: The Migration Assistant window only appears if an earlier version of Hot Folders is installed. (Earlier
versions include the following: on Windows, all 2.x versions; on Mac OS, all 2.x versions.)

2 Click OK and follow the on-screen instructions.

Note: Do not click Cancel when migration is in progress. Canceling the operation may cause permanent damage
to the Hot Folders being upgraded.
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3 Check the summary in the Migration Assistant window.
If migration is successful, the successful icon is displayed next to each Hot Folder. If migration fails, or only
partially succeeds, the failed icon is displayed next to the Hot Folders that failed to migrate, with any details
highlighted in the lower pane.

4 In case of failure, click Retry to attempt migration again before exiting the Migration Assistant.

Note: Retrying generates a new summary, checking only the files that failed.

5 Click OK.

Using Hot Folders

For instructions on how to use Hot Folders features, see the Help provided with the software.
After Hot Folders is installed, a Hot Folders icon appears on the desktop of the client computer.
You can use file format filters with Hot Folders. For information, see Hot Folders Help.
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WebTools

WebTools consists of several utilities that allow you to manage your Fiery ES remotely from the Internet or your
company intranet.
The Fiery ES has a home page, where you can select the following WebTools:

• Home provides current information about the jobs processing and printing on the Fiery ES.

• Downloads allows remote users to download installers (for printer drivers and other user software) directly from
the Fiery ES.

• Docs allows remote users to access jobs on the Fiery ES over the Internet or intranet.

• Mailbox allows remote users to access jobs on the printer over the Internet or intranet. You can also create, edit,
and delete User Boxes on the printer.

• Configure allows the Fiery ES administrator to view and modify Setup options remotely from a Windows or Mac
OS computer.

Setting up WebTools

WebTools are accessed through the home page of the Fiery ES web site and do not require special installation.
However, WebTools do require initial setup by the Fiery ES administrator.
To enable network users to access and use WebTools, the administrator must set specific options in Network Setup
and Printer Setup. For information about these specific Setup options, see Configuration and Setup.
The administrator must prepare each user computer to communicate with the Fiery ES over the Internet or intranet.

1 Enable TCP/IP networking.

2 Make sure that the Windows or Mac OS computer has a valid, unique IP address.

3 Make sure that a supported Internet browser is installed on the computer.
For more information about supported browsers, see Configuration and Setup.
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Pop-up Blocker with WebTools

Pop-up Blocker is turned on by default in some versions of Internet Explorer on Windows computers. With this
function turned on, a warning message appears when you attempt to access WebTools, and access to WebTools is
denied.
To gain access to WebTools, do one of the following:

• Change the Pop-up Blocker setting by clicking the warning message and choosing one of the selections that
appears.

• Turn off Pop-up Blocker in the Internet Explorer Tools menu.

If your browser has the advanced Internet option enabled to display notifications about script errors, it might display
a warning window before displaying a Help file. To avoid the warning window, clear the “Display a notification about
every script error” option on the Advanced tab in the Internet Options dialog box. A warning message might also
appear in the Status bar, but the content of the Help file is not affected by this error.
For more information, see Internet Explorer Help, or the documentation that accompanies the Windows operating
system.

Accessing the WebTools home page

Use your Internet browser to access WebTools.
For complete information about browser and system requirements , see Configuration and Setup.

1 Start your Internet browser.

2 Type the IP address or DNS name of the Fiery ES.

3 Click the WebTools tab that you want to use.

Using WebTools

The following sections describe how to use the WebTools.

Home

Home lets you view processing and printing status on the Fiery ES. If you wish, you can specify how often printing
and processing information is updated by selecting a time interval from the Refresh Status menu.

Downloads

Downloads allows you to download installers (for printer drivers and other Fiery ES software) directly from the Fiery
ES.

Docs

Docs allows you to access jobs on the Fiery ES over the Internet or intranet.
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You can:

• Control and modify jobs.

• Submit jobs to the Fiery ES.

By default, three levels of users are set up for Docs: admin, operator, and guest. Ask your administrator for your level
of access and any required password.

Configure

Configure allows the Fiery ES administrator to view and modify Setup options remotely.
To use Configure, make sure you complete the procedures described in Setting up WebTools on page 27.

Use Mailbox to retrieve scans

When you have scanned a job to the User Box on the printer, you can access it from WebTools.
1 Start your Internet browser.

2 Type the IP address or DNS name of the printer.

3 Click the Mailbox tab.

4 Choose whether to log in to the Public boxes or as Administrator.
If LDAP has been enabled on the printer, your user name would consist of “domain name\user name”. When you
have logged in, you can choose to edit and delete existing mailboxes and also create new mailboxes.

5 Click the mailbox Number-Name link to open it.

6 Click Download if you wish to download the file to your computer.
You can choose the file format for downloading the file.
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Introduction

This document explains how to manage color output on the Fiery® ES IC-416 and provides information about color
conversion and other color operations.
This document is part of a set that includes documentation for users and system administrators. For more
information about supported operating systems and system requirements, see Configuration and Setup.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-416, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Printer MFP

Fiery ES Fiery® ES IC-416

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in Configuration
and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To use
the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-416.

Resource Description

User guides (titles in
italics)

Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities
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Resource Description

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material (titles in
italics)

• Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

Key features of ColorWise

ColorWise is the color management system (CMS) built into the Fiery ES and designed to provide both casual and
expert users with the best color output for a variety of purposes. The ColorWise default settings provide
high‑quality, out-of-box color from many applications.
ColorWise default settings allow casual users to achieve quality output without knowing about or changing any color
settings on the Fiery ES. ColorWise also provides controls to allow expert users to obtain the best color output.
Depending on your particular needs, you can:

• Set the behavior of CMYK printing to emulate offset press standards.

• Match PANTONE and other spot colors for the best match when printing using four-color press conditions or
presses with extra, custom plates.

• Select a rendering intent for RGB printing. Rendering intents allow for rich, saturated printing of presentation
graphics, smooth, accurate printing of photographs, and relative or absolute colorimetric rendering for
specialized needs.

• Define the source of incoming RGB color data for better color conversion of RGB data with no source
information.

• Determine whether RGB data is converted into the full gamut of the printer or is first converted into the gamut
of another device, such as a press standard. This feature is useful for making one device behave like another for
RGB data. It also allows you to evaluate the appearance of an RGB file under different printing conditions
without having to convert the RGB file to CMYK first.

ColorWise color management (ColorWise) offers an open color architecture, allowing users to customize the Fiery
ES to meet new printing needs as they arise. ColorWise supports ICC profiles, which are industry-standard color
profiles that describe the color behavior of a device. Note that ICC specification version 4 profiles (profile version
4.2.0.0) are supported as well as version 2. Downloading ICC profiles to the Fiery ES enables the Fiery ES to simulate
a custom press (or another printer), as well as accurately print colors from a particular monitor or scanner. In
addition, you can create customized ICC profiles for the Fiery ES.

Color Printing
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Color features in Command WorkStation

Command WorkStation includes color-management tools and color-related features.

• Color management
Command WorkStation allows you to set the default settings of the ColorWise print options for the Fiery ES.
These default settings are applied to all print jobs sent to the Fiery ES, unless a user overrides them for an
individual job by changing settings in the printer driver or in Job Properties.

• Profiles
Command WorkStation allows you to manage all of the ICC profiles used in Fiery ES workflows. You can also
create custom profiles by editing existing CMYK source or output profiles and saving them as new profiles.
The AutoGray feature allows you to adjust the gray balance of output profiles.

• Calibrator
For consistent color, calibrate the Fiery ES on a regular basis. Command WorkStation includes an easy-to-use
calibrator, which allows you to calibrate using a measurement instrument.
Command WorkStation also allows you to use any Status T densitometer by importing data in a standard file
format. In this case, it is important to note that the quality of the instrument used determines the quality of the
calibration.

• Spot-On (spot colors)
Spot-On is a spot color (named color) manager. You can adjust and manage lists of spot colors and their CMYK
equivalents. The matching lists of spot colors and CMYK values are known as spot color dictionaries. Spot-On
allows you to edit spot color definitions on the Fiery ES and create custom spot color definitions and dictionaries.

Installing and starting Command WorkStation on a Windows or Mac OS computer is described in Utilities. You can
install Command WorkStation from the User Software DVD.
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ColorWise print options

The Fiery ES provides print options that affect the output of color objects in various color spaces. By specifying the
appropriate settings for each print option, you can obtain the expected results for your jobs.
Color management determines how color data in a job is converted to the color data that is sent to the printer. Some
color print options affect the color management applied to a job. Other color print options are not related to color
management.

Color management on the Fiery ES

The ColorWise color-management system on the Fiery ES determines how the color data in a document is
converted from source to output.
Applications allow you to generate color data in different color spaces. The most common type of color data
produced from office applications is RGB, while prepress applications generally produce CMYK data. Desktop
applications also generate spot colors, such as PANTONE colors. A single page of a document may contain a mix of
RGB, CMYK, and spot colors.
Through print options that apply specifically to RGB, CMYK, or spot color data, you specify the color management
of a job.

Print options that affect CMYK data Print options that affect RGB data Print options that affect spot-color data

CMYK/Grayscale Source RGB Source Spot Color Matching

CMYK/Grayscale Processing Method RGB/Lab Rendering Intent

Separate RGB/Lab to CMYK Source

Black Text and Graphics Black Text and Graphics

Gray (CMYK) Gray (RGB)

Combine Separations

Output Profile Output Profile

RGB Source applies strictly to RGB color data. The other options that affect RGB color also affect Lab, XYZ, and
other calibrated color spaces, which are more rarely used.

Color Printing
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If a job contains calibrated CMYK (CIEBasedDEFG) data, the CMYK processing options are not used. Instead, the
RGB/Lab Rendering Intent print option, which normally affects only RGB data, is used to process the calibrated
CMYK data.

Auto Trapping

Trapping is a technique where the size of objects is modified so that colors printed next to each other overlap
slightly, to prevent white spaces between two colors. These white spaces, or "halos," can be caused by factors such as
misregistration, the physical properties of the toner, and the stiffness of the media.

Figure 1: Auto Trapping Off Figure 2: Auto Trapping On

If you turn on the Auto Trapping option, trapping is applied to all of the objects in a job.
The Fiery ES has default trapping values that are optimized for a Fiery-driven print device using regular paper.
If the default trapping values do not provide the results necessary for the media that you use, you can modify the
values to meet your requirements in Command WorkStation with the configurable Auto Trapping feature.
For more information about configurable Auto Trapping, see Fiery Productivity Package

Black Overprint

The Black Overprint option specifies whether black text, or black text and vector graphics (where black is defined as
RGB=0, 0, 0, or as CMYK=0%, 0%, 0%, 100%) print over colored backgrounds. If you turn off this option, black text,
or black text and graphics knock out colored backgrounds. Knocking out can create a white edge around objects, or a
"halo," caused by the misalignment of color plates.
The Black Overprint option has the following settings:

• Text - Black text overprints colored backgrounds, eliminating white gaps and reducing the halo effect from
misregistration of colors. You can select this setting only if the Black Text and Graphics option is set to Pure Black
On.

• Text/Graphics - Black text and graphics overprint colored backgrounds, eliminating white gaps and the halo
effect from misregistration of colors. You can select this setting only if the Black Text and Graphics option is set
to Pure Black On.

• Off - Black text and graphics knock out colored backgrounds.
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Note: PostScript applications may perform their own black overprint conversions before printing.
An example of how you might use this setting is a page that contains black text on a light blue background. The
background blue is CMYK=40%, 30%, 0%, 0%. The black text is CMYK=0%, 0%, 0%, 100%.

• With Black Overprint set to Text or Text/Graphics, the final text or graphic portions of the page are overprinted,
or combined with the underlying color. Black colors generated by applications (for example, RGB=0, 0, 0 or
CMYK=0%, 0%, 0%, 100%) are printed using black only. This means that black text and line art do not exhibit
halftone artifacts (as long as the printer is calibrated correctly). No transition in cyan and magenta occurs and
the quality of the output is improved, because it does not show artifacts near the edges of text.

• With Black Overprint set to Off, the border of the text or graphic is on an edge that has cyan and magenta on one
side (outside the object) and black on the other side (inside the object). This transition may cause visible artifacts
due to the practical limitations of the printer.

Note: The reproduction of CMYK components is affected by the CMYK/Grayscale Source setting and calibration
when CMYK is not 0%, 0%, 0%, 100%.

Black Point Compensation

The Black Point Compensation option lets you control the output quality of shadow areas for CMYK source colors.
Use Black Point Compensation to enhance details in shadows when the CMYK source space is larger than the gamut
of the printer. In proofing applications, when the CMYK source space is smaller than the gamut of the printer, do
not use this option.

Note: For RGB source colors, black point compensation is always applied.
Black point compensation works by scaling the source colors so that the darkest point in the source profile maps to
the darkest point in the output profile.

Black Text and Graphics

The Black Text and Graphics option affects black text and vector graphics. When you set this option to Pure Black
On, the black generated by applications (RGB=0, 0, 0 or CMYK=0%, 0%, 0%, 100%) is printed using black only.
With Black Text and Graphics set to Pure Black On, black text and line art are not misregistered, since only one
colorant is used. This setting also eliminates blasting, which is an undesirable effect that occurs when excess
amounts of toner, combined with certain types of paper stock, cause objects to spread beyond their defined
boundaries.
For some jobs, we recommend setting Black Text and Graphics to Normal. For example, if a job includes gradient fills
that use black, the Normal setting gives the best result.
If you set Black Overprint to Text or Text/Graphics, Black Text and Graphics must be set to Pure Black On.

Note: Use Black Text and Graphics only when printing composites, not separations.
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The following table describes the behavior of Black Text and Graphics with black defined in different color spaces.

Color Black Text and Graphics = Normal Black Text and Graphics = Pure Black
On or Rich Black On

RGB=0,0,0 (all other RGB
values are unaffected by Black
Text and Graphics)

Printed according to the definition for
RGB=0,0,0 in the output profile. This may
be a rich black (one that uses multiple
colorants) if the output profile specifies a
rich black, or K-only if the output profile
specifies K-only for RGB=0,0,0. The output
is affected by calibration.

Printed as 100% K (Pure Black On) or 100%
K plus 50% Cyan (Rich Black On) using
black and cyan.

CMYK=0%,0%,0%,100% (all
other CMYK values are
unaffected by Black Text and
Graphics)

Printed as K-only or as a rich black using all
colorants, depending on the CMYK/
Grayscale Source and CMYK/Grayscale
Processing Method settings.

If CMYK/Grayscale Processing Method is set
to Pure Primaries, or if CMYK/Grayscale
Source is set to Bypass Conversion,
CMYK=0%,0%,0%,100% prints as 100% K
and the amount of black is limited by the
CMYK/Grayscale Source profile and
calibration.

If CMYK/Grayscale Processing Method is set
to Full (Output GCR), CMYK=0%,0%,0%,
100% is printed as a rich black using all
colorants according to the output profile.
The output is affected by calibration.

If CMYK/Grayscale Processing Method is set
to Full (Source GCR), CMYK=0%,0%,0%,
100% is printed as a rich black using all
colorants according to the CMYK/Grayscale
Source profile. The output is affected by
calibration.

Note: Setting CMYK/Grayscale Source to
ColorWise Off disables the CMYK Source
profile and calibration. In this case, the black
is not limited by calibration.

Printed as 100% K (Pure Black On) or 100%
K plus 50% Cyan (Rich Black On) using
black and cyan, regardless of the CMYK
Source and CMYK Processing Method
settings.

Spot colors (unaffected by
Black Text and Graphics)

Standard spot color processing Standard spot color processing

Note: PostScript applications may convert elements defined as RGB=0, 0, 0 to four-color CMYK black before
sending the job to the Fiery ES. These elements are not affected by the Black Text and Graphics option.
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CMYK/Grayscale Processing Method

The CMYK Processing Method option allows you to define the CMYK-to-CMYK conversion method for the CMYK
data in a print job.

• Pure Primaries - If your Fiery ES supports this setting, it outputs the primary colors in a job (C only, M only, or Y
only) as primary colors, using only a single colorant. The result is pure-looking primary colors, with minimal
banding in gradients.
Pure Primaries compromises overall color accuracy. Do not use Pure Primaries if color accuracy is important.

• Full (Source GCR) - Uses the black generation specified by the CMYK Source profile. Colorimetric accuracy is
reduced. This method can be used to preserve pure black without converting it to CMYK. However, the Gray
(CMYK) option is more typically used to preserve pure black. The black generation level that was specified in the
original (source) document is approximated.

• Full (Output GCR) - The recommended method when color accuracy is required. This method provides a
complete and accurate simulation based on colorimetric transformations. With this method, all CMYK data is
reproduced using the black generation specified by the output profile.

Note: When you specify Pure Black On for Black Text and Graphics, and Full (Output GCR) or Full (Source GCR) for
CMYK Processing Method, the black text and graphics in your document are printed with 100% black.

CMYK/Grayscale Source and RGB/Lab Source

The CMYK/Grayscale Source and RGB Source print options allow you to define the color spaces of the CMYK and
RGB data, respectively, in your document so that the appropriate color conversion occurs on the Fiery ES.
Commonly used color spaces are available on the Fiery ES. For others, you can import custom profiles to the Fiery
ES.

CMYK/Grayscale Source

To properly manage color in a printed image that was separated using an ICC profile, the same profile must be
specified for printing the image.
The CMYK/Grayscale Source profile setting you specify depends on the CMYK profile or press standard for which the
CMYK data was separated. This option affects CMYK data only.

• For images that were separated using a custom separation (such as a separation produced with an ICC profile),
select the profile used for RGB to CMYK conversions in the prepress workflow on the Fiery ES with the CMYK/
Grayscale Source setting.

• For images that were separated for a press standard, select the press standard as the CMYK/Grayscale Source
setting.

If the job contains an embedded CMYK profile, select the Use Embedded Profile When Present (CMYK) option (or
select None for CMYK/Grayscale Source, if available). The embedded profile is applied to CMYK data.

Note: For some older models of Fiery ES, the embedded profile is applied to CMYK data regardless of the CMYK/
Grayscale Source setting. For all models of Fiery ES, selecting the None setting or the Use Embedded Profile When
Present (CMYK) option results in using the embedded profile.
The CMYK/Grayscale Source option can be set to any CMYK source profile that is present on the Fiery ES.
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If you do not want CMYK data in a job to be converted to the output color space, you can select one of the following
settings:

• None or Bypass Conversion - These settings send the original CMYK data in the job to the printer without
conversion, but with calibration applied.

• ColorWise Off - This setting sends the original CMYK data in the job to the printer without calibration applied
and without converting the CMYK data. The CMYK data is still subject to the total toner limit, however.
The ColorWise Off setting is available for a specific job but it cannot be the default setting on the Fiery ES. You
select this setting for a specific job.

Note: When you print with the ColorWise Off setting, make sure that the options you choose in your application
do not cause the application to modify CMYK data. You must specify no color management in the application
when you print with the ColorWise Off setting.

RGB/Lab Source

When you specify a profile for RGB Source, the Fiery ES overrides source color space definitions or profiles that other
color management systems may have specified. For example, if your document contains an embedded RGB profile,
the RGB Source setting overrides it.
When you specify an RGB source profile, the output from the Fiery ES is consistent across platforms. The RGB
Source options are as follows:

• EFIRGB - Specifies an EFI-defined color space recommended for users who have no detailed information about
their RGB data.

• sRGB (PC) - A Microsoft and Hewlett-Packard recommended color space designed for typical home and office
applications.

• Apple Standard - Specifies the color space of an older Mac OS computer monitor.

• Adobe RGB (1998) - An Adobe-defined color space, used in some prepress workflows as the default working
space for Adobe Photoshop.

• ECI-RGB - The European Color Initiative (ECI) recommended space for use as an RGB working color space and
color data exchange format for ad agencies, publishers, reproduction, and printing houses.

• Fiery RGB - An EFI-defined color space recommended for users of office applications. This color space is similar
to EFIRGB but is larger and can provide a more desirable blue output.

In cases where you do not want RGB Source to override another specified source color space, either select None or
select the Use Embedded Profile When Present (RGB) option, whichever setting your Fiery ES supports.
If RGB Source is set to None, or the Use Embedded Profile When Present (RGB) option is enabled, the Fiery ES ignores
RGB Source and uses the RGB profile embedded in the print job (if any) as the RGB source profile.

CMYK/Grayscale Device Link and RGB/Lab Device Link

The CMYK/Grayscale Device Link option or the RGB/Lab Device Link option, along with the Output Profile option,
allows you to select a CMYK-to-CMYK device link profile or an RGB-to-CMYK device link profile (respectively).
To be selected for a print job, a device link profile must reside on the Fiery ES and be associated with a specific
source profile (CMYK/Grayscale Device Link for a CMYK-to-CMYK device link profile or RGB/Lab Device Link for an
RGB-to-CMYK device link profile) and output profile (the Output Profile setting).
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When you select the source profile and output profile settings associated with a device link profile, the Fiery ES
bypasses its normal color management and applies the device link conversion to the color data in the job. The source
profile and the output profile are not used.
Profiles that do not reside on the Fiery ES do not appear as settings. A device link profile that is not associated with a
source profile setting and an output profile setting cannot be selected for a job. Therefore, even though the source
profile and output profile that are associated with a device link profile are not used to calculate color conversions,
they must reside on the Fiery ES.

Combine Separations

The Combine Separations option specifies how to print separated CMYK data.
You can combine Cyan, Magenta, Yellow, and Black separations.

• Off - Prints each separation individually.

• On - Combines separations as a single, composite-color document, and automatically sets the following print
options: Color Mode (CMYK) and Black Overprint (Off).

The results of combining the multiple plates are predictable and accurate, regardless of the original application used.
This feature also fully supports DCS 2.0 file formats when included in a PostScript print job from a page-layout
application.
The following applications have been tested with Mac OS and Windows for compatibility with the Combine
Separations option:

• Adobe Illustrator

• Adobe InDesign

• Adobe PageMaker

• QuarkXPress

Note: You cannot use Combine Separations at the same time that you use the following features: Substitute Colors,
Composite Overprint, Postflight, or Black Overprint. Constraints are set for these print options in the printer driver
and in Job Properties.

Composite Overprint

The Composite Overprint print option allows you to print overprinted objects as specified in the source file.
When overlapping objects are printed, the foreground object can either overprint or knock out the background
object. With overprinting, the color of the background object shows through the foreground object where they
overlap, and the resulting color is a combination of the colors of the two objects. With a knockout, the foreground
object hides the background object where they overlap.

• Off - An overprinted object knocks out a background object.

• On - The area of overlap between two overprinted objects is a blend of the two colors.

Note: The Composite Overprint option does not overprint the foreground object if it is an RGB object.
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The Composite Overprint print option is supported for PostScript and PDF jobs produced by the following
applications:

• Adobe Acrobat

• Adobe Illustrator

• Adobe InDesign

• QuarkXPress

• CorelDRAW

You cannot use Composite Overprint at the same time that you use Combine Separations. Constraints are set for
these print options in the printer driver and in Job Properties.
If Composite Overprint is turned on for a job that contains spot colors, Spot-On must be activated on the Fiery ES.

Gray and Black (CMYK and RGB)

When the Gray (RGB) option is turned on, any RGB color that has equal R, G, and B values is printed as K-only black
instead of CMYK black. Similarly, when Gray (CMYK) is turned on, any CMYK color where C, M, and Y are 0 (zero),
and K is any value is printed as K-only black instead of CMYK black.
You can turn on Gray (RGB) or Gray (CMYK) for either Text and Graphics or Text, Graphics, and Images. "Graphics"
refers to vector graphics. "Images" refers to bitmap images.
The following limitations apply:

• The Gray (RGB) and Gray (CMYK) options have no effect on a job that is sent as separations.

• If CMYK Processing Method is set to Pure Primaries, Gray (CMYK) does not affect the output.

• If Separate RGB/Lab to CMYK Source is turned on, Gray (RGB) is turned off. Likewise, if Gray (RGB) is turned on,
you cannot turn on Separate RGB/Lab to CMYK Source.

• If Black Text and Graphics is set to Pure Black On or Rich Black On, it takes precedence over Gray (RGB) and Gray
(CMYK) for 100% black text and graphics.

• If a gray is specified as a spot color, Gray (RGB) and Gray (CMYK) do not affect that gray.

Optimize RGB Transparency

The Optimize RGB Transparency option corrects color errors that can occur in jobs that contain transparent RGB
or Lab objects.
Optimize RGB Transparency affects jobs with the following characteristics:

• The job is in PDF format (submitted to the Fiery ES as a PDF file, not submitted from an application through a
printer driver).

• The job contains transparent RGB or Lab objects. They might be objects that you specified as transparent using
an application that supports this capability, or they might be objects with a special effect, such as a drop shadow,
that uses transparency to achieve the effect.

• The transparent objects overlap, creating an area of mixed color.
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If you turn on Optimize RGB Transparency, the Fiery ES uses the correct RGB source profile and rendering intent
when converting the overlapping RGB colors to CMYK during the PDF-to-PostScript conversion. If you turn off
Optimize RGB Transparency, the area of overlapping colors might print with incorrect color or undesirable artifacts.
Optimize RGB Transparency can result in a longer processing time, especially for variable data printing (VDP) jobs
that contain multiple individual PDF pages. We recommend that you turn on Optimize RGB Transparency only when
necessary to achieve correct color output.
You can specify Optimize RGB Transparency for a job in Job Properties in Command WorkStation, Hot Folders, or a
virtual printer, but not when you print from the printer driver. The Optimize RGB Transparency option does not
appear in the printer driver because jobs printed from the printer driver are always submitted to the Fiery ES as
PostScript jobs, which are not affected by Optimize RGB Transparency.

Output Profile

The Output Profile print option specifies the output profile used to process a job. Color data in a print job is
converted to the color space of the printer, which is described by the output profile.
In addition, the calibration that is associated with the output profile is applied to the job before printing.
The Fiery ES includes one or more default output profiles, each created for a specific media type. You can also
import your own output profiles to the Fiery ES.
CMYK/Grayscale Device Link or RGB Device Link - When you select a specific output profile in combination with one
of these options, the combination specifies a CMYK-to-CMYK or RGB-to-CMYK device link profile.
The CMYK/Grayscale Device Link or RGB Device Link profile setting and the Output Profile setting are used in
combination to activate a device link profile. The device link profile must already be associated with specific settings
for Output Profile and CMYK/Grayscale Device Link or RGB Device Link. In this case, the selected output profile is not
used for color management, since the device link profile is used.

RGB/Lab Rendering Intent

The RGB/Lab Rendering Intent option specifies a rendering intent for RGB/Lab-to-CMYK color conversion. This
conversion can be optimized for the type of color image being printed.
To control the appearance of images, such as prints from office applications or RGB photographs from Adobe
Photoshop, select the appropriate rendering intent. The Fiery ES allows you to select from the four rendering intents
currently found in industry-standard ICC profiles.

Note: If you experience tone reproduction problems, use the Photographic setting.

Rendering intent Best used for Equivalent ICC rendering intent

Photographic - Typically
results in less-saturated output
than presentation rendering
when printing out-of-gamut
colors. This style preserves
tonal relationships in images.

Photographs, including scans and images
from stock photography CDs and digital
camera images.

Image, Contrast, and Perceptual
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Rendering intent Best used for Equivalent ICC rendering intent

Presentation - Creates
saturated colors but does not
match printed colors precisely
to displayed colors. In-gamut
colors, such as flesh tones, are
rendered well. This style is
similar to the Photographic
rendering intent.

Artwork and graphs in presentations. This
style can be used for mixed pages that
contain presentation graphics and
photographs.

Saturation, Graphics

Relative Colorimetric - Provides
white point transformation
between the source and
destination white points. For
example, the bluish-white color
(gray) of a monitor is replaced
by paper white. This style
avoids visible borders between
blank spaces and white objects.

Advanced use when color matching is
important, but you prefer white colors in the
document to print as paper white. This style
may also be used with PostScript color
management to affect CMYK data for
simulation purposes.

Relative Colorimetric

Absolute Colorimetric -
Provides no white point
transformation between the
source and destination white
points. For example, the bluish-
white color (gray) is not
replaced by paper white.

Situations when exact colors are needed and
visible borders are not distracting. This style
may also be used with PostScript color
management to affect CMYK data for
simulation purposes.

Absolute Colorimetric

Separate RGB/Lab to CMYK Source

The Separate RGB/Lab to CMYK Source option determines how RGB colors (as well as Lab and XYZ colors) are
converted to CMYK. This option defines the color spaces that are used by the Fiery ES to separate the RGB data into
CMYK values.

• When Separate RGB/Lab to CMYK Source is turned on, all RGB colors are first converted to the CMYK color
space defined by the CMYK/Grayscale Source print option before being converted to the CMYK color space of the
printer (as defined by the Output Profile print option). The result is a simulation of the RGB colors that would be
output from a printer with the characteristics defined by the CMYK/Grayscale Source profile.
With Separate RGB/Lab to CMYK Source, for example, if a high-quality ICC profile is available for another
printer, your printer can simulate the behavior of that other printer.

• When Separate RGB/Lab to CMYK Source is turned off, all RGB colors are converted directly to the CMYK color
space of the printer (as defined by the Output Profile print option).
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Spot Color Matching

The Spot Color Matching option provides automatic matching of spot colors with their best CMYK equivalents.

• On - The Fiery ES uses a built-in table to generate the closest CMYK matches of spot colors your printer can
produce. (New tables are generated when you add new output profiles.)
With Spot-On, the Fiery ES uses the CMYK matches determined through Spot-On.

• Off - The Fiery ES processes spot colors as CMYK data and uses CMYK equivalents defined by the spot color
manufacturer, such as PANTONE. These are the same CMYK equivalents used by applications that include spot
color libraries.

Note: Spot colors that are not included in the built-in table are treated as CMYK.
For jobs that include spot colors, turn Spot Color Matching on unless you are printing press simulations. In that case,
turn Spot Color Matching off and select the appropriate CMYK/Grayscale Source.
For a PDF job that includes spot colors that are not included in the built‑in table, turning Spot Color Matching on
retains the original spot colors. The Fiery ES references the built‑in table to generate the closest CMYK matches of
the original spot color.

Note: Use Spot Color Matching only when printing composites, not when printing separations.

Substitute Colors

Substitute colors are colors that, when called for in a document by their RGB or CMYK values, are substituted with a
different color that is defined in the Spot-On color dictionary. This permits exact color control and overrides
individual RGB and CMYK colors.
Spot-On allows you to create a list of substitute colors. To enable substitute colors for a job, turn on the Substitute
Colors option.

Note: You cannot use Substitute Colors at the same time that you use Combine Separations or Postflight.
Constraints are set for these print options in the printer driver and in Job Properties.
When you use Substitute Colors at the same time that you use Spot Color Matching, be sure that the CMYK color
that you want to replace with a substitute color is not a CMYK color that is also defined as a spot color. Otherwise,
the spot color may be replaced with the substitute color, which may not be the result that you expect.
For more information about creating and using substitute colors, see Command WorkStation Help.

Use Embedded Profile When Present (CMYK and RGB)

You can specify whether the Fiery ES uses the source profile (either CMYK or RGB) that is embedded in the print job
rather than the source profile specified in the print settings.

CMYK

If you turn on Use Embedded Profile When Present (CMYK), the Fiery ES ignores the CMYK/Grayscale Source option
and uses the CMYK profile embedded in the print job (if any) as the CMYK source profile. If you turn off this option,
the Fiery ES uses the profile specified in the CMYK/Grayscale Source option.
When a CMYK profile is embedded in a job and Use Embedded Profiles When Present (CMYK) is enabled for the job,
or when a job is sent with PostScript Color Management, the job contains calibrated CMYK (or CIEBasedDEFG)
data. For jobs containing calibrated CMYK, the CMYK processing options are not used. Instead, the RGB/Lab
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Rendering Intent option, which normally affects only RGB or Lab data, is used to process the calibrated CMYK data.
The RGB Source setting does not affect calibrated CMYK data.

RGB

If you turn on Use Embedded Profile When Present (RGB), the Fiery ES ignores the RGB Source option and uses the
RGB profile embedded in the print job (if any) as the RGB source profile. If you turn off this option, the Fiery ES uses
the profile specified in the RGB Source option.

Where to specify ColorWise print options

You can set ColorWise print options for all jobs by setting the default values on the Fiery ES. You can set the
ColorWise print options for a specific job to different values if the default values are not what you want for the job.
You specify default values for ColorWise print options in Color Setup in Command WorkStation. You can also set
default values from Fiery ES Setup, as described in Configuration and Setup. The defaults apply to all subsequent
print jobs unless you override them.

Note: A job uses the Fiery ES default settings (unless otherwise specified) at the time it is processed for printing, and
not at the time it is sent to the Fiery ES Hold queue.
How you set specific ColorWise print options for a particular job depends on how you submit the job to the Fiery ES.

• When you print a job from an application through the printer driver, specify ColorWise print options using the
settings that appear in the printer driver.
The printer driver sends a PostScript file to the Fiery ES that incorporates the settings for the ColorWise print
options you selected.

• When you print a job through Hot Folders or a virtual printer, specify ColorWise print options in the Job
Properties settings. These settings override the default settings on the Fiery ES.

• When a job is in the Hold queue of the Fiery ES, specify ColorWise print options through the Job Properties
settings in Command WorkStation. These settings override the default settings on the Fiery ES.

The table shows the location of each print option.

ColorWise print option Color window of printer
driver or Job Properties

Basic Settings of printer
driver, Job Properties, or
Color Setup

Expert Settings of
printer driver, Job
Properties, or Color
Setup

Auto Trapping x

Black Overprint x

Black Point Compensation x

Black Text and Graphics x
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ColorWise print option Color window of printer
driver or Job Properties

Basic Settings of printer
driver, Job Properties, or
Color Setup

Expert Settings of
printer driver, Job
Properties, or Color
Setup

CMYK/Grayscale Processing
Method

x x

CMYK/Grayscale Source or Device
Link

x x

Combine Separations x

Composite Overprint x

Gray (RGB and CMYK) x x

Optimize RGB Transparency x (Job Properties only)

Output Profile x x

RGB/Lab Rendering Intent x x

RGB Source or Device Link x x

Separate RGB/Lab to CMYK
Source

x

Spot Color Matching x x

Substitute Colors x

Use Embedded Profile When
Present

x

Print from an application

To print from an application, you use the printer driver for your operating system (Windows or Mac OS).

• For information about how to install the printer driver, set up the Fiery ES for printing, and set print options
with the printer driver, see Printing.

• When you print a job from a Mac OS application using the printer driver, you must also set color-management
print options appropriately.
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Print with color settings in Mac OS

When you print a job from a Mac OS application using the printer driver, you must set color-management print
options appropriately.

1 Select Print in your application.

2 Expand the dialog box, if necessary, by clicking the arrow next to the Printer name.

3 Click Preview, select Color Matching from the drop-down list, and then click In Printer.

4 Set other print options as needed, and then click Print to send your job.
For information about how to set print options with the printer driver for Mac OS, see Printing.
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Color profiles

The Fiery ES includes by default a number of RGB and CMYK profiles that you can use for printing through the RGB
Source, CMYK/Grayscale Source, and Output Profile settings for a job.
You can manage the profiles on the Fiery ES with Profile Manager in Command WorkStation, which allows you to
import ICC profiles to the Fiery ES, export profiles, delete profiles (except for default profiles), and set the properties
of profiles. You can also create custom CMYK source or output profiles by editing an existing profile and saving it as
a new profile.
You can install (copy) additional ICC profiles from the User Software DVD to your computer. Use the ICC profiles
with applications that support ICC standards, such as Adobe Photoshop.

ICC profiles on the User Software DVD

The User Software DVD contains additional ICC profiles that you can install (copy) to your computer.

Adobe ICC Profiles folder

The Adobe ICC Profiles folder is located inside the Windows Color Files\Legacy\ICC Profiles folder or Mac Color Files/
Legacy/ICC Profiles folder.
The profiles in this folder were created by Adobe Systems, Inc. For more information, see the documents included in
the folder.
CMYK Profiles:

• CoatedFOGRA27.icc

• CoatedFOGRA39.icc

• CoatedGRACoL2006.icc

• JapanColor2001Coated.icc

• JapanColor2001Uncoated.icc

• JapanColor2002Newspaper.icc

• JapanColor2003WebCoated.icc

• JapanWebCoated.icc

• UncoatedFOGRA29.icc

• USWebCoatedSWOP.icc

• USWebUncoated.icc

• WebCoatedFOGRA28.icc
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• WebCoatedSWOP2006Grade3.icc

• WebCoatedSWOP2006Grade5.icc

RGB Profiles:

• AdobeRGB1998.icc

• AppleRGB.icc

• ColorMatchRGB.icc

• PAL_SECAM.icc

• SMPTE-C.icc

• VideoHD.icc

• VideoNTSC.icc

• VideoPAL.icc

ECI folder

The ECI folder is located inside the Windows Color Files\Legacy\ICC Profiles folder or Mac Color Files/Legacy/ICC
Profiles folder.
The profiles were created by the European Color Initiative (ECI). For more information, see the documents included
in the CMYK Profiles and RGB Profiles folders, as well as the ECI web site at www.eci.org.
CMYK Profiles:

• ISOcoated_v2_300_eci.icc

• ISOcoated_v2_eci.icc

• ISOuncoatedyellowish.icc

• PSO_Coated_300_NPscreen_ISO12647_eci.icc

• PSO_Coated_NPscreen_ISO12647_eci.icc

• PSO_LWC_Improved_eci.icc

• PSO_LWC_Standard_eci.icc

• PSO_MFC_Paper_eci.icc

• PSO_SNP_Paper_eci.icc

• PSO_Uncoated_ISO12647_eci.icc

• PSO_Uncoated_NPscreen_ISO12647_eci.icc

• SC_paper_eci.icc

EFI Support folder

The EFI Support folder is located inside the Windows Color Files\Legacy\ICC Profiles folder or Mac Color Files/
Legacy/ICC Profiles folder.
These profiles were created by EFI. For more information, see the General Requirements for Applications in
Commercial Offset Lithography (GRACoL) website at www.gracol.org, the Fogra website at www.fogra.org, and the
Specifications Web Offset Publications (SWOP) website at www.swop.org.
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CMYK Profiles:

• EFIEURO.icc

• EFISWOP.icc

• Enterprise CMYK.icc

• GRACoL2006_Coated1_EFI.icc

• ISOCoated.icc

• ISOCoated_FOGRA39L_EFI.icc

• ISOUncoated_FOGRA29L_EFI.icc

• SWOP2006_Coated3_EFI.icc

• SWOP2006_Coated5_EFI.icc

RGB Profiles:

• EFI Fiery RGB Chroma.icc

• EFI Fiery RGB Chroma+.icc

• EFI Fiery RGB Chroma++.icc

Note: The EFI Fiery RGB Chroma profiles are designed to provide saturated colors, especially in nighttime images,
while maintaining photographic detail. Of the three profiles, EFI Fiery RGB Chroma.icc has the least effect and EFI
Fiery RGB Chroma++.icc has the greatest effect.

• EFIRGB.ICC

• Fiery RGB v2.icc

• Fiery RGB v4.icc

• Fiery RGB v5.icc

• RGB D65 (Splash).icc

Japan Profiles:

• EFIDIC.ICC

• EFIJMPA2.icc

• EFIJMPA3.icc

• JapanColor2011Coated.icc

• JC2001_type1_EFI.icc

• JC2001_type2_EFI.icc

• JC2001_type3_EFI.icc

• JC2001_type4_EFI.icc

• TOYO Offset Coated 2.0.icc
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Add ICC profiles from the User Software DVD

The User Software DVD includes a number of ICC profiles that you can add to the Fiery ES:
For most ICC-aware applications, you must install the files in the Color folder (Windows) or the Library/ColorSync/
Profiles folder (Mac OS). For use with the Fiery ES, you can copy the files to a folder of your choice.

Note: On Mac OS, see the ColorSync documentation for setting ColorSync profiles, such as EFIRGB.

1 Install the profiles on your computer.

2 Use Command WorkStation to import the files to the Fiery ES.

Install ICC profiles on a Windows computer

1 Insert the User Software DVD into the DVD drive.

2 Open the folder containing the profile.

3 Right-click the profile that you want and click Install Profile.

The profiles are installed automatically to the Windows\System32\spool\drivers\color folder on your computer.

Install ICC profiles on a Mac OS computer

You must log on with Administrator privileges.

1 Insert the User Software DVD into the DVD drive.

2 Open the folder containing the profile.

3 Copy the profiles into Library/ColorSync/Profiles.

Color Bars folder

The Color Bars folder is located inside the Windows Color Files folder or Mac Color Files folder. These files are used
for the Control Bar feature.
The Control Bar feature is available with the optional Fiery Productivity Package.
You can copy these additional color files from the User Software DVD to your computer.

• FieryColorBar.eps

• Ugra Fogra-MediaWedge V2.2x_EFIv1.eps

• Ugra Fogra-MediaWedge V3.0a_EFIv1.eps
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Calibration

Calibrating the Fiery ES ensures consistent and reliable color output. Calibration adjusts the toner densities of a job
to compensate for the difference between the expected (target) densities of the printer and the actual (measured)
densities that the printer outputs.
Periodic calibration is necessary to monitor the actual output of the printer. To calibrate the Fiery ES, you measure
the densities of printed color patches on a page.
Calibration is applied to all jobs, but you can disable it for a specific job. The ColorWise Off setting for the CMYK/
Grayscale Source option disables calibration (and color management) for CMYK data in a job. You might want to
disable calibration for testing purposes, for example.
Changing calibration has the potential to affect all jobs for all users, so consider limiting the number of people
authorized to perform calibration. Set an Administrator password to control access to calibration (see Configuration
and Setup).

Check calibration status

You can check when the Fiery ES was last calibrated in Command WorkStation.

Check the calibration status for a job

• In Command WorkStation, in Job Center, select the job.
The time of the most recent calibration is displayed in the lower-right corner.

Check the status of a specific calibration

1 In Command WorkStation, in Device Center, click the General tab, click Tools, and then click Manage (under
Calibrate).
The list of calibration settings on the Fiery ES appears in Calibrator.

2 Find the calibration in the list and check the Last calibrated value.
Default measurements indicates the factory settings, which means that the Fiery ES has not been calibrated.
You can configure Command WorkStation to optionally display a warning or suspend printing if the calibration
of a job is out of date. For more information, see the online help.
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Calibrator in Command WorkStation

You can calibrate the Fiery ES with Calibrator in Command WorkStation.
Calibrator provides a choice of measurement methods depending on the methods supported by your Fiery ES:

• ColorCal (in Command WorkStation) - Calibration method that uses the built-in scanner of the printer to
measure toner densities.
For more information about this method, see the online help.

• ES-1000 or ES-2000 - EFI ES-1000 or ES-2000 hand-held spectrophotometer
For more information about this method, see the online help.

• KonicaMinolta FD-5BT - KonicaMinolta FD-5BT hand-held spectrodensitometer
For information about this method, see the instructions in this document as well as in the documentation that
accompanies the instrument.

Multiple users can connect to one Fiery ES with Command WorkStation, but only one user at a time can use
Calibrator. If you try to calibrate when another user is using Command WorkStation to calibrate, an error message is
displayed.
Before you save calibration measurements, you can check the calibration by printing a test page to see if it prints as
you expect. It may also be helpful to print your own test page with the colors and job settings that are important to
you.
Calibrator allows you to view the calibration measurements as a graph of input versus output curves for C, M, Y, and
K.

• If the maximum measured density of a colorant is less than the target value, print a test page to check the output,
especially areas with a lot of that particular colorant.

• If the maximum measured density is greater than or equal to the target value, this is usually not a problem.

If the curves are not smooth, it may be because the printer does not print uniformly across the page. The calibrated
output may still be acceptable.
One way to check uniformity is to print a test job that covers the page with a single colorant (C, M, Y, or K) at the
percentage that you want to check. Lack of uniformity is usually visible with values between 15% and 30%. This page
must be printed without color management (CMYK Source set to Bypass Conversion). If lack of uniformity is visible,
we recommend that you calibrate using one of the sorted patch layouts, which helps to minimize banding in
gradients. However, calibration cannot fix the lack of uniformity of the printer.

Calibrate the Fiery ES with Command WorkStation

1 Start Calibrator by doing one of the following:

• In Command WorkStation, in Job Center, click the Calibrate icon.

• In Command WorkStation, in Device Center, click the General tab, click Tools, and then click Calibrate.

• In Command WorkStation, in Job Center, right-click a job and select Calibrate.
In this case, Calibrator automatically selects the calibration setting used by the job.
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2 Follow the procedure for your measurement instrument.
For more information, see the online help.

Calibrate the Fiery ES using the KonicaMinolta FD-5BT

You can calibrate the Fiery ES using the KonicaMinolta FD-5BT to make color measurements. Command
WorkStation Calibrator lets you calibrate using an existing calibration setting.

• Make sure that Fiery Color Profiler Suite v4.5 or later is installed on your computer, otherwise the
KonicaMinolta FD-5BT is not available as a measurement method.

• Connect the KonicaMinolta FD-5BT to your computer and turn on the KonicaMinolta FD-5BT.

• To learn about the KonicaMinolta FD-5BT, see the documentation that accompanies the instrument.

• Before calibrating for a specific paper, load the paper at the printer.

To calibrate, you print a page of color patches and then measure the color pages.

1 In Command WorkStation Calibrator, set the following options:

• Select a calibration setting in the Calibrate for list.

• Select the desired paper source in the Paper source list.
Make sure the paper source corresponds to the calibration setting. For example, if you select a calibration
setting for plain paper, select a paper source that contains plain paper.

• Select the KonicaMinolta FD-5BT in the Measurement method list.

2 Click Continue to print the calibration page.

3 When the page has printed, click OK and retrieve the page from the printer.

4 Place the KonicaMinolta FD-5BT, with the target mask attached to the underside, in the calibration plate as
shown on the screen, and then click Next.

5 Push down on the KonicaMinolta FD-5BT at the end near the instrument display, as shown on the screen, until
the instrument beeps.
The instrument self-calibrates using the white tile on the calibration plate.

6 If the instrument calibration is successful, proceed to measure the calibration page.

7 Place the page on a smooth, even surface.
For more accurate measurement, place several sheets of plain white paper beneath the page.

8 Place the ruler over the first strip of patches, and place the KonicaMinolta FD-5BT, without the target mask
attached to the underside, on the ruler.
For help with placing the instrument, click Show me how on the screen.

9 Slide the KonicaMinolta FD-5BT along the ruler until the sample aperture on the instrument is over the white
space at either end of the strip specified on the screen.

10 Hold down the button on the side of the KonicaMinolta FD-5BT and slide the instrument along the strip of
patches slowly and at an even pace.
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11 Release the button when the KonicaMinolta FD-5BT reaches the white space at the end.

12 After you successfully measure one strip of patches, move the ruler and the KonicaMinolta FD-5BT to the next
strip specified on the screen.

13 Continue to measure the remaining strips in the same manner until you have measured all patches on the page,
and then click Next.

14 To see the measurement results displayed on a graph, click View Measurements.

15 To print a test page using the calibration measurements, click Test Print.

16 If the calibration measurements are acceptable, click Apply & Close.

Calibration from the printer control panel

You can calibrate the Fiery ES from the printer control panel with ColorCal, without using Command WorkStation.
If an Administrator or Operator password has been set, you will need it to perform calibration from the printer
control panel. For instructions on using the printer control panel, see Configuration and Setup.
It is also possible to remove calibration measurements (and restore the default measurements) from the Fiery ES
using the printer control panel. In general, it is not necessary, because any new calibration replaces the existing one if
the same calibration setting is selected. Removing calibration affects all calibration settings.

Calibrate the Fiery ES from the printer control panel

To calibrate the Fiery ES, you print a page that contains color patches and use the printer's scanner to measure the
color patches. The measured values are saved and used for the calibration setting associated with the media that the
page was printed on.

1 When the printer is Idle, press Controller on the Machine tab to enter the Fiery Color Server display.

2 Log in as an administrator.

3 Press the Tools tab, and then press Calibrate.

4 Choose the paper source for the measurement page and press Print.
The ColorCal Calibration page is comprised of swatches of color that are measured by the printer’s scanner and
then compared to the target color values.
If scanner calibration is enabled for the Fiery ES in Calibrator preferences (in Command WorkStation), a
ColorCal Scanner page is printed as well as the ColorCal Calibration page.
We recommend that you always calibrate the scanner before calibrating the Fiery ES.

5 Retrieve the printed pages.

6 If a ColorCal Scanner page was printed, place the grayscale strip and Color Control patches according to the
instructions on the page, and press Measure to initiate the scan.

7 When the display indicates that the measurement was successful, press Continue.
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8 Follow the instructions on the screen and on the ColorCal Calibration page to place the page on the glass platen
along with the grayscale strip, and press Measure to initiate the scan.

9 When the display indicates that the measurement was successful, press Continue.

10 Optionally, press Test Print to print a test page.
You can examine the test page to decide if the calibration is successful.

11 If the calibration is successful, press Apply to save the measurements.

Managing calibration settings

Every output profile on the Fiery ES must be associated with a calibration setting. The calibration setting provides
the Fiery ES with density measurements of each of the printed colorants, for specific printing conditions (for
example, media type). This data, along with the expected density response of the printer, allows the Fiery ES to apply
corrections to color values that are sent to the printer, to achieve the calibrated output.
An output profile can be associated with only one calibration setting, but the same calibration setting can be used by
more than one output profile.
A calibration setting must be associated with at least one output profile, otherwise the calibration setting will never
be used for printing.

Output profiles and calibration settings

The Fiery ES has one or more factory-supplied output profiles. These output profiles and their associated calibration
settings may produce acceptable color quality. However, you may need to create custom calibration settings and
output profiles, depending on your situation.

Note: The Fiery ES supports a maximum of 39 calibration settings, including the factory-supplied calibration
settings as well as any custom ones that you create.

Your paper Action Notes

1 Recommended paper for a factory-
supplied output profile (the paper
that the profile is based on)

Printing with the output profile
produces acceptable color. You do not
need to create a calibration setting or
custom profile.

You can find the recommended paper
for an output profile in Calibrator.

2 Paper similar to a factory-supplied
profile’s recommended paper

You might be able to use the output
profile. The print settings required for
your paper (for example, media type
and media weight) must match the
print settings required by the
recommended paper. If the color
quality is acceptable, you do not need
to create a calibration setting or
custom profile.

The output profile name usually
indicates the general type of paper (for
example, plain, coated, or heavy). You
can find the print settings required for
the recommended paper in Calibrator.
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Your paper Action Notes

3 Paper that is similar to a factory-
supplied profile’s recommended
paper, but uses different print
settings

You might still be able to use a factory-
supplied output profile, if you create a
custom calibration setting and use it to
calibrate the Fiery ES with your paper.

You can create a custom calibration
setting in Calibrator.

4 Paper that does not yield
acceptable color with any factory-
supplied profile

You must create a custom calibration
setting and custom profile.

Use profile-generating software to
create a custom profile.

Note: Recommended papers are chosen for color quality, as well as other factors, such as feeding reliability and
quality of transfer.

Find recommended paper and print settings

You can find the recommended paper and print settings for a particular output profile in Calibrator.
There is a recommended paper for each output profile and calibration.

1 In Command WorkStation, in Device Center, click the Color Setup tab and click Color Management.

2 Select the output profile and note the name of the calibration setting displayed to the right.

3 In Device Center, click the General tab, click Tools, and then click Manage under Calibrate.
The list of calibration settings on the Fiery ES appears in Calibrator.

4 Select the calibration setting from the list.
The recommended paper is shown in the list and the required print settings are displayed in the calibration-
related properties.

5 Click Close to close the window.

Custom calibration settings

If you are printing on a paper that is similar to the recommended paper, but uses different print settings, you might
still be able to use the output profile, but you must create a custom calibration setting. If the color quality is
acceptable, you do not need to create a custom profile.
You can add a new calibration setting that you can then select when performing calibration. You can delete a custom
calibration setting. You cannot delete a factory-supplied calibration setting.
For information about adding a custom calibration setting, see the online help.
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Custom calibration settings and output profiles

If you determine that none of the factory-supplied output profiles produces acceptable color with your paper, you
must create a custom calibration setting in Calibrator and a custom profile using profile-generating software.
To create a custom calibration setting, you print a page of color patches on the Fiery ES using your paper and
measure the page with Calibrator.
If Fiery Color Profiler Suite is installed on your computer, you can start it from within Calibrator to create a custom
output profile immediately after creating a custom calibration setting.

Note: Before creating a custom calibration setting and custom output profile, make sure that the printer is calibrated
(if calibration is supported on the printer). For information about performing printer calibration, see the
documentation that accompanies the printer.

Understanding calibration

Calibration generates adjustments to toner densities that account for the difference between the actual toner
densities (measurements) and the expected response (target).

• Measurements represent the actual color behavior of the printer.

• Calibration settings contain sets of measurements that represent the output for specific printing conditions, such
as media and print options.

• Each calibration setting is associated with a calibration target that describes the expected behavior of the printer.

After you calibrate the Fiery ES for a specific calibration setting, the measurements are stored. These measurements
are used to adjust output densities when you print with the output profile associated with the calibration setting.
Although the needs of most users are met by the default calibration setting, the Fiery ES allows you to select a
calibration setting to customize calibration for specialized jobs.
Every output profile has an associated calibration setting. If you have not specified one, the calibration setting
associated with the default output profile is used.
If you update the calibration for a job after the job has been processed, you do not have to process the job again. The
new calibration affects the job without reprocessing.

How calibration works

Success in obtaining satisfactory print quality from the Fiery ES depends on many factors. Among the most
important are establishing and maintaining optimal toner densities. The density is the measure of the light absorbed
by a surface. By carefully regulating toner densities, you obtain consistent printed color.
Calibration allows you to:

• Maximize the color reproduction capabilities of the Fiery ES.

• Ensure consistent color quality over time.

• Produce consistent output across more than one Fiery ES.

• Achieve better color matches when reproducing spot colors, such as PANTONE colors or other named color
systems.

• Optimize the Fiery ES for using ColorWise rendering intents, CMYK simulations, and ICC profiles.
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Even with a calibrated system, toner density is affected by the settings of the printer, humidity, and temperature.
Density also tends to drift over time. Uneven toner density on paper affects calibration results. Regular measurement
detects day-to-day variations in density, gradation, and color reproduction, and calibration corrects them.
Calibration works by calculating adjustments that compensate for the difference between actual (measured) and
desired (target) density values. These calibration adjustments are often depicted as mathematical curves for each of
the colorants.

When to calibrate

Calibrate the Fiery ES at least once a day, depending on the volume of print jobs. If it is very important to maintain
consistent color, or your printer is subject to wide fluctuations in temperature or humidity, calibrate every few hours.
For optimal performance, calibrate whenever there is a noticeable change in print quality or printing results are not
as expected.
If you must split a print job into two or more batches to print at different times, it is important to calibrate before
you print each batch. You should also calibrate the Fiery ES after printer maintenance. However, because the printer
may be less stable immediately after maintenance, wait until you have printed approximately 50 pages before you
calibrate.

Note: Because output from the printer is very sensitive to changes in temperature and humidity, do not install the
printer near a window, in direct sunlight, or near a heater or air conditioner. Paper is also sensitive to climate
changes. Store it in a cool, dry, stable environment, and keep reams sealed until they are used.
To monitor print quality, print a color reference page. A good reference page includes fully saturated color patches
and pale tints of cyan, magenta, yellow, and black. Images with skin tones offer a good basis for comparison. Save and
periodically compare the pages you print. If a noticeable change in appearance occurs, calibrate the Fiery ES.
When you examine the reference page, all color patches should be visible, even though they may be very faint in the
five to two percent range. Each patch set should show uniform gradation from patch to patch as the color lightens
from 100% to zero.
If the solid density patches (100% cyan, magenta, yellow, or black) look less saturated over time, show the pages to
your service technician to determine whether adjusting the printer can improve output.
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Spot-On

The Spot Color Matching print option automatically matches spot colors with their best CMYK equivalents so that
spot colors can be simulated using the CMYK colors. However, you may want to adjust the default CMYK
equivalents to achieve a better match for your specific printing conditions. You can modify spot colors with the
Spot-On spot color editor in Command WorkStation.

Note: Spot colors are also called "named" colors because a color name is used to represent a specific CMYK value.

Spot Colors in Command WorkStation

The Spot Colors feature is a spot color (named color) manager in Command WorkStation that allows you to edit
spot color definitions on the Fiery ES and create custom spot color definitions. Spot Colors is a part of the Spot-On
feature. If Spot-On is available for your Fiery ES and is activated on the Fiery ES, you can adjust and manage lists of
spot colors and their CMYK equivalents.
The Spot-On feature is in Command WorkStation, in Device Center, in the Spot Colors window under the Resources
tab.
Spot Colors comes pre-loaded with libraries of named colors such as those from PANTONE, HKS, TOYO, and DIC.
The spot color libraries store the original colors with their device-independent definitions (Lab values). For each
output profile on the Fiery ES, Spot Colors computes the best available CMYK reproduction of each spot color. Each
time a new profile is generated or updated, Spot Colors automatically recalculates the best CMYK equivalents.
You can create a list of "substitute" colors. These are colors that, when called for in a document by their RGB or
CMYK values, are substituted with a different color having the CMYK values from the Spot Colors color definition.
This permits exact color control and overrides individual RGB and CMYK colors.
For more information about Spot Colors and Substitute Colors, see Command WorkStation Help.

How Spot-On works

Spot-On allows you to adjust and manage lists of spot colors and their CMYK equivalents. The matching lists of spot
colors and CMYK values are known as spot color dictionaries. Spot-On allows you to maintain multiple spot color
dictionaries for each output profile on the Fiery ES.
In Spot-On, you specify the job properties that you use to print a job. Based on the settings, Spot-On determines the
output profile and its associated spot color dictionary.
If you select Output profile X and redefine PANTONE 123 from 30%M to 50%M using Spot-On, the output will
reflect 50%M when you print a job with Output profile X. If you print a job with Output profile Y, you will get the
original value.
If you select Output profile X and create a custom color named "My Purple" and define it as 80%C 40%M, ColorWise
automatically calculates the Lab values using Output profile X and creates new CMYK values for use with Output
profile Y.
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To use the Spot-On features with named colors, you must enable the Spot Color Matching print option.

Note: Spot colors that are identified by name are printed with their defined CMYK values. Edits to an output profile
made in Command WorkStation do not affect how spot colors are printed.
Any edits made to a job with the color adjustment features in ImageViewer affect all of the colors in the job,
including spot colors.

Monitor settings

This feature requires that a job be displayed with correct colors on your monitor. To display the colors correctly on
your monitor, you must set up the monitor according to the manufacturer’s recommendations, and specify the
correct monitor profile for your monitor.
Specify the following settings for the monitor:

• On the monitor: Brightness, Contrast, and Color Temperature

• In the operating system: Resolution, Refresh rate, and Number of colors

For more information about setting up the monitor and the monitor profile, see the documentation that
accompanies the monitor.
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Introduction

This document explains the Fiery Productivity Package features and how they work.
The Fiery Productivity Package option for the Fiery ES offers additional color and production features for operators
(or users with Operator or Administrator privileges) to monitor and manage the print workflow of jobs on the Fiery
ES.

Terminology, conventions, and documentation resources

This document uses the following terminology and conventions to refer to the Fiery® ES IC-416, printer, and
supported operating systems.

Term or convention Refers to

Aero Fiery ES (in illustrations and examples)

Printer MFP

Fiery ES Fiery® ES IC-416

Mac OS All supported Mac operating systems. For a complete list, see System Requirements in Configuration
and Setup.

Windows All supported Windows operating systems. For a complete list, see System Requirements in
Configuration and Setup.

Warning: A warning concerning operations that may lead to death or injury to persons if not performed
correctly. To use the equipment safely, always pay attention to these warnings.

Caution: A caution concerning operations that may lead to injury to persons if not performed correctly. To use
the equipment safely, always pay attention to these cautions.

Important: Operational requirements and restrictions. Be sure to read these items carefully to operate the
equipment correctly, and avoid damage to the equipment or property.

The following documentation resources are available for the Fiery® ES IC-416.

Resource Description

User guides (titles in
italics)

Documents in this set: Color Printing, Configuration and Setup, Fiery Productivity Package,
Printing, Utilities

Fiery Productivity Package
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Resource Description

Online help • Help can be accessed directly from each Fiery application or by going to help.efi.com.

• Each help system is available as a printable PDF, accessed from the PDF icon in the upper right
corner of the Help window.

Additional reference
material (titles in
italics)

• Fiery Color Reference - help.efi.com/ref/colorref/en-us/

• Variable Data Printing - help.efi.com/ref/vdp/en-us/

• Workflow Examples - help.efi.com/ref/workflows/en-us/

• Configure Help - help.efi.com/configure/3.0/en-us/

Fiery Productivity Package

Most Fiery Productivity Package features are accessible from Command WorkStation.

Production features

The production features include:

Feature Where to set values or access

Fiery JDF Command WorkStation

Hot Folders Hot Folders (application)

Virtual Printers Command WorkStation: Virtual Printers

Advanced job management features:

• Print Next

• Process Next

Command WorkStation: Job Center

For information about Hot Folders, see Hot Folders Help.
For information about Fiery JDF and Virtual Printers, see Command WorkStation Help.

Color and graphic arts features

The color and graphic arts features include:

Feature Where to set values or access Print option name

Auto Trapping (with customization and
Rich Black Auto Trapping)

Command WorkStation: Color Setup Auto Trapping

Fiery Productivity Package
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Feature Where to set values or access Print option name

Control bar Command WorkStation: Color Setup Control Bar

Hot Folders file filters Hot Folders none

ImageViewer Command WorkStation: Job Center none

Image Enhance Visual Editor Command WorkStation: Job Center none

Paper simulation white point editing Command WorkStation: Profiles Paper Simulation

Postflight none Postflight

Feature activation

The Fiery Productivity Package option must be activated at the Fiery ES before you can access its features from your
computer. An administrator activates the option at your site using the software licensing feature in Command
WorkStation or in WebTools Configure.

Check activation status

• To check if an optional feature is activated at the Fiery ES, do one of the following:

• Print the Configuration page (see Configuration and Setup).

• In Command WorkStation, check the General Info tab in Device Center.

Update the status on your computer

If an optional feature is activated at the Fiery ES, you must update the status of the option on your computer before
you can access the feature from your computer.

Update the status on Windows

Before updating the status on a Windows computer, you must install the printer driver. For information about
installing the printer driver, see Printing.

1 Open the Printers (or Printers and Faxes) window.

2 Right-click the Fiery ES and select Properties (or Printer Properties).

3 Click the Installable Options tab.

4 Select Two-Way Communication.

Fiery Productivity Package
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5 Type the IP address or DNS name and click Update.

6 Verify that the feature appears under Installed Options, and click OK.

Update the status on Mac OS

Before updating the status on a computer running Mac OS, install the printer driver. For information about
installing the printer driver, see Printing.

1 Select Apple menu > System Preferences, and then select Print & Fax (Mac OS X v10.6), Print & Scan (Mac OS X
v10.7 and v10.8), or Printers & Scanners (Mac OS X v10.9 and v10.10).

2 In the Printer List, select the Fiery ES and click Options & Supplies.

3 Click the Driver tab (Mac OS X v10.6, v10.7, and v10.8) or the Options tab (Mac OS X v10.9 and v10.10).

4 Select the option from the appropriate list.

5 Click OK to apply changes.

6 Quit System Preferences.
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Advanced job management features

The following sections describe how to access and use some of the advanced job management features.

Print Next

The Print Next feature moves the selected job immediately to the printing queue. If another job is currently printing,
the selected job for Print Next is printed immediately after.

Note: The Print Next feature is valid for jobs that have spooled to the Fiery ES, but have not yet been sent to the
printer. If you want a job that has already been sent to the printer to print next, you must specify that job from the
printer control panel. For more information, see the documentation that accompanies your printer.

Process Next

The Process Next feature moves the selected job immediately to the processing queue. If another job is currently
processing, the selected job for Process Next is processed immediately after.
The feature is accessed from the Actions menu in Command WorkStation and is described in Command
WorkStation Help.

Fiery Productivity Package
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Auto Trapping customization

Trapping is a technique where some objects are printed slightly larger or smaller than you have specified in an
application, in order to prevent white edges around the objects. These white edges, or "halos," can be caused by
factors such as misregistration, the physical properties of the toner, and the stiffness of the media.
The Auto Trapping customization feature provides you with advanced trapping settings and gives you full control
over their values. The Fiery ES is shipped with values that are optimized for the printer using regular paper, but if
these values do not provide the results necessary for the media that you use, modify the values to meet your
requirements.

Print a job with Auto Trapping

1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the Fiery print options in
the printer properties.
For information about how to set Fiery print options and print to the Fiery ES from Windows and Mac OS
applications, see Printing.
Alternatively, submit the job to the Fiery ES Hold queue and then set print options in Job Properties in Command
WorkStation.

2 On the Color tab, select On for the Auto Trapping print option.

3 Click OK and print the job.

If you have not customized the trapping values with Command WorkStation, your job is printed with the default
trapping values. If you edited the values, your job is printed with the custom trapping values.

Customize Auto Trapping

In Command WorkStation, the Auto Trapping customization feature is on the Trapping tab under the Color Setup
tab in Device Center. For more information about using Trapping, see Command WorkStation Help.
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Control Bar

Control Bar allows you to add a static color bar and dynamic job information to each printed page at a user-defined
location.
The default Control Bar is designed to fit the Fiery ES default paper size, Letter/A4, or larger. You can create Control
Bars for other paper sizes.

Note: If a Control Bar does not fit on the page, it will be clipped.

Note: If a background color is defined as "white" for a user-defined Control Bar, it must be defined in the CMYK
color space for the Paper Simulation feature to take effect.
The default Control Bar provides a color bar and dynamic job information. Many jobs print satisfactorily with the
default Control Bar, but if you require your own Control Bar, create it by defining custom values on the Control Bar
tab in Color Setup.

Print a job with a Control Bar

1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the Fiery print options in
the printer properties.
For information about how to set Fiery print options and print to the Fiery ES from Windows and Mac OS
applications, see Printing.
Alternatively, submit the job to the Fiery ES Hold queue and then set print options in Job Properties in Command
WorkStation.

2 On the Job Info tab, under Reporting, select On for the Control Bar print option.

3 Click OK and print the job.
If you have not set up a custom Control Bar with Command WorkStation, your job is printed with the default
Control Bar image, which is the Ugra/Fogra Media Wedge. If you set up a custom Control Bar, your job is printed
with the custom Control Bar.

Fiery Productivity Package
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Callout Refers to

1 Static color bar

2 Job information

Customize Control Bar

The custom Control Bar feature is on the Control Bar tab under Color Setup in Device Center. For more information
about creating a custom Control Bar, see Command WorkStation Help.
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ImageViewer

ImageViewer allows you to soft proof and adjust colors in a job before it is printed. You can use the preview in
ImageViewer to verify job placement, orientation, and content, as well as general color accuracy.
If the job contains halftone screened settings, the preview shows a composite view of all separations at the dot level.
You can select to display the plate data for each process color independently or in combination with the other colors,
allowing inspection of individual plate data or a combination of any range of plates.
For information about using ImageViewer, select Help > Help in ImageViewer to see the online help.

Access ImageViewer

Start ImageViewer from the Actions menu or Preview window of Command WorkStation.

Access ImageViewer from Actions menu

1 In Job Center in Command WorkStation, select the job that you want to preview.

Note: ImageViewer recognizes only jobs that show processed/held (dark yellow) status. Processed/held jobs are
also indicated by the raster job icon (page with blue arrow).

2 If needed, select Actions > Process and Hold to move the job to processed/held status.

3 To start ImageViewer, do one of the following:

• Select Actions > ImageViewer.

• Right-click the selected job and select ImageViewer from the menu that appears.

Access ImageViewer from Preview

1 In Job Center in Command WorkStation, select the job that you want to preview.

Note: ImageViewer recognizes only jobs that show processed/held (dark yellow) status.

2 If needed, select Actions > Process and Hold to move the job to processed/held status.

3 Select Actions > Preview or right-click the job and select Preview.

4 To start ImageViewer, select the thumbnail of the page that you want to soft proof, and then click the
ImageViewer button.
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Callout Refers to

1 ImageViewer button

Monitor settings

This feature requires that a job be displayed with correct colors on your monitor. To display the colors correctly on
your monitor, you must set up the monitor according to the manufacturer’s recommendations, and specify the
correct monitor profile for your monitor.
Specify the following settings for the monitor:

• On the monitor: Brightness, Contrast, and Color Temperature

• In the operating system: Resolution, Refresh rate, and Number of colors

For more information about setting up the monitor and the monitor profile, see the documentation that
accompanies the monitor.
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Image Enhance Visual Editor

Image Enhance Visual Editor (IEVE) is an image editing application that provides users with a visual workspace to
adjust individual images in a job. With IEVE, you can see the effects of your adjustments and fine-tune the
appearance of an image.
With IEVE, you can adjust tone, color, and sharpness, and perform red-eye correction. You can apply the same
adjustments to all images on a page or a range of pages. When you save a set of adjustments as a preset, you can
easily apply the same adjustments in the future.
Adjustments made in IEVE affect the job on the server and cannot be applied to the original source document.
IEVE is accessible from Command WorkStation. For more information about IEVE, see the online help.

Access IEVE in Command WorkStation

1 In Job Center in Command WorkStation, select the job containing the images that you want to adjust.

Note: IEVE supports PDF and PostScript jobs only.

2 To start IEVE, do one of the following:

• Select Actions > Image Enhance Visual Editor.

• Right-click the selected job and select Image Enhance Visual Editor from the menu that appears.

IEVE and Image Enhance print option

IEVE adjustments are independent of the configurable Image Enhance print option. If the Image Enhance print
option is turned on for a job that is also modified with IEVE, the effects of both are applied to the images in the job.
We recommend that you use one or the other, not both, for a job.

• The Image Enhance print option is a faster way to apply simple adjustments that do not require visual
confirmation before printing.

• IEVE is faster for making selective adjustments that require fine-tuning and visual inspection.
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Paper Simulation white point editing

The Paper Simulation White Point editing feature allows you to perceptually adjust the hue, brightness, and
saturation of the simulated paper white defined in an ICC profile. Although an ICC profile contains a definition of
"white," the white may not always visually match the human eye, requiring a perceptual adjustment.
When the Paper Simulation print option is enabled, the Fiery ES simulates the white of the paper using CMYK
values rather than leaving the paper white areas of the page unprinted. You can print a job with Paper Simulation
without customizing paper simulation. Many jobs may print satisfactorily with the fixed default Paper Simulation
setting. However, you can customize the paper simulation by editing the white point values with Command
WorkStation before printing with Paper Simulation.

Print a job with Paper Simulation

1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the Fiery print options in
the printer properties.
For information about how to set Fiery print options and print to the Fiery ES from Windows and Mac OS
applications, see Printing.
Alternatively, submit the job to the Fiery ES Hold queue and then set print options in Job Properties in Command
WorkStation.

2 On the Color tab, click Expert Settings.

3 On the Color Input tab, select Paper Simulation.

4 If you edited the Paper Simulation White Point values, select the following settings as well.

• On the Color Input tab, for CMYK/Grayscale Source, select the custom profile that you saved after editing the
Paper Simulation White Point values.

• On the Color Input tab, for CMYK/Grayscale Processing Method, select Full (Output GCR).

• On the Output tab, for Output Profile, select the profile that you linked to the custom CMYK Source profile
when you edited the Paper Simulation White Point values.

5 Click OK to save the settings.

6 Click OK and print the job.

If you have not edited the Paper Simulation White Point values with Command WorkStation, your job is printed
with the default Paper Simulation values. If you edited the values, your job is printed with the custom Paper
Simulation values.
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Edit the Paper Simulation White Point

Your job may print acceptably with the fixed Paper Simulation setting. However, you can customize the Paper
Simulation setting by editing the Paper Simulation White Point values with Command WorkStation.
To access the Paper Simulation White Point dialog box, see the instructions in Command WorkStation Help.
When you edit the Paper Simulation White Point values, you save them in a custom profile, which you create by
editing an existing CMYK Source Profile in Color Editor. You must also link the CMYK source profile to an output
profile.

Note: If Paper Simulation is set to On, and you have defined a substitute color as C=0, M=0, Y=0, K=0, the values
defined in Substitute Colors override those for Paper Simulation. For information about Substitute Colors, see
Command WorkStation Help.

Monitor settings

This feature requires that a job be displayed with correct colors on your monitor. To display the colors correctly on
your monitor, you must set up the monitor according to the manufacturer’s recommendations, and specify the
correct monitor profile for your monitor.
Specify the following settings for the monitor:

• On the monitor: Brightness, Contrast, and Color Temperature

• In the operating system: Resolution, Refresh rate, and Number of colors

For more information about setting up the monitor and the monitor profile, see the documentation that
accompanies the monitor.
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Postflight

The Postflight feature helps you determine why some printed jobs do not deliver expected color output. Both a
diagnostic and a training tool, it provides helpful global and object-specific information about how a job is received
and processed by the Fiery ES.
Postflight identifies not only those color spaces that are used by visible objects, but any color space used by a job. Use
Postflight to troubleshoot color problems with a previously printed job or as a preventive measure.
You can print the original document with all objects (images, graphics, and text) color-coded. A report explains what
color spaces are used in the job and what print options affect those spaces. The report also provides information
about the printing environment. You can print a Test Page to verify the condition of the printing environment.
You cannot use the Postflight print option for a job that uses Substitute Colors or Combine Separations. Constraints
are set for these print options from the printer driver.

Postflight settings

The Postflight print option can be set to print a number of analytical reports for a job.

• Concise report

• Test page

• Color-coded pages

• All of the above

Concise report

The concise report includes job information, ColorWise global settings (such as calibration and output profile),
object-specific settings according to the object’s color space, and spot color information for all spot colors in the job.
The report is printed on the Fiery ES default paper size with the default calibrated color mode.
For mixed media jobs, which can use multiple output profiles, Postflight produces reliable results if the pages are
printed on the same media with the same settings.

Note: The background defined in the Paper Simulation is not indicated as a CMYK object in the Postflight reports.

Test page

The Test page is printed with the same media and global settings as your job. However, color objects on this page are
printed independently of the user-specified source color definitions (such as CMYK and RGB source profiles).
If the color on the Test page is not correct, it is probably because of the output profile, calibration, or printer.
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If the color on this page prints correctly, but the colors of objects in the job do not, it is likely because of a problem
with the objects that are printed incorrectly. The problem might be the wrong color values for text and graphics, bad
quality images, or out-of-gamut colors.

Color-coded pages

Postflight can print a color-coded version of the original document that prints each object in a color that identifies
its source color space.
The colors used to represent the color spaces for objects are as follows:

• Gray objects: Gray

• CMYK objects: Cyan

• RGB objects: Red

• Device-independent objects: Indigo

• Spot color objects: Yellow

After identifying the color spaces of the objects that are printing incorrectly, you can make appropriate changes to
the settings that affect those color spaces to correct the problem.

Postflight examples

Scenarios show how Postflight can be helpful to users who require high-quality color.

• Diagnose an unexpected color

• Check the calibration status of a job

• Check the quality of an output profile

• Diagnose a color problem with a specific object

For each of the scenarios, instead of printing the report to the Fiery ES, you can send it to the Hold queue of the Fiery
ES and preview the information (of a job with raster data) in ImageViewer.

Note: The procedures for printing a job from a Windows and a Mac OS computer are similar.

Diagnose unexpected color

If you print a job that results in an unexpected color, use Postflight to diagnose the problem.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the Fiery print options in

the printer properties.
For information about how to set Fiery print options and print to the Fiery ES from Windows applications and
from Mac OS applications, see Printing.
Alternatively, submit the job to the Fiery ES Hold queue and then set print options in Job Properties in Command
WorkStation.

2 On the Job Info tab, under Reporting, set Postflight to All Components.
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3 Click OK and print the job.
The Test page, Color-coded pages, and report are printed.

4 Review all Postflight pages.

5 Make appropriate changes based on all Postflight pages.
Depending on your printing environment, the condition of the printer, and the color settings, possible changes
are as follows:

• Correct problems with the printer (see the documentation that accompanies the printer).

• Calibrate the Fiery ES.

• Edit the colors of the output profile with Command WorkStation.

• Change the default settings in Command WorkStation.

• Change the job specific print option settings with Command WorkStation Job Properties.

6 Reprint the job, setting Postflight to Off.

7 Repeat these steps until the color results are acceptable.

Check the calibration status of a job

Use Postflight to check the calibration status of a job before printing the job.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the Fiery print options in

the printer properties.

2 On the Job Info tab, under Reporting, set Postflight to Concise Report.

3 Click OK and print the job.
The concise report is printed.

4 Review the information in the ColorWise global settings page.

5 Perform calibration, if needed.
If service has been performed on the printer since the last calibration, or calibration has not been performed,
perform calibration using the calibration set specified in the Postflight report.

6 Reprint the job, setting Postflight to Off.

Check the quality of an output profile

Use Postflight to check the quality of an output profile on the Fiery ES.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the Fiery print options in

the printer properties.

2 On the Job Info tab, under Reporting, set Postflight to Test Page.

Fiery Productivity Package

Postflight
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3 Click OK and print the job.
The Test page is printed.

4 Review the quality of the color on the Test page.

Note: Make sure that this page was printed with the same media and print option settings as the job.

5 Review the instructions on the Postflight Test Page.

6 Edit the color of the output profile, or create a profile, if needed.
It may be necessary to customize the output profile or create a new profile to get optimal results on the media the
job is using.

7 Reprint the job, setting Postflight to Off.

Diagnose color problem with a specific object

Use Postflight to diagnose a color problem with a specific object.
1 In your application, select File > Print, select the Fiery ES as your printer, and then go to the Fiery print options in

the printer properties.

2 On the Job Info tab, under Reporting, set Postflight to Color-Coded Pages.

3 Click OK and print the job.
The color-coded pages are printed.

4 Review the Postflight color-coded pages.

5 Make changes to the color settings, if needed.

Note: Use the Color-Coded Pages setting to send a job to another printer that has a specific color-space
requirement. For example, a document targeted to a CMYK-only printer must have only Cyan-colored objects.

6 Reprint the job, setting Postflight to Off.
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Customer Release Notes
Fiery® ES IC-416

This document contains important information about this release. Be sure to provide this information to all users
before proceeding with the installation.

Note: This document uses the term “Fiery ES” to refer to the Fiery® ES IC-416.

Mac OS

Changing cover page and paper feed settings

On Mac 10.7 and above, if Mac OS-side settings for cover page and paper feed are changed from an application print
window, some Fiery driver settings are not applied to jobs.

Setup

Enable Direct Mobile Printing

If the Enable Direct Mobile Printing option in the Bonjour settings of the Fiery ES is turned on, two printer entries
are added when you add the Fiery ES to a Mac OS computer as a Bonjour printer. The printer with Bonjour in its
name is for Bonjour printing. The printer without Bonjour in its name is for Direct Mobile Printing.

Security

Account Track

When you use the Account Track feature on the printer and set the Print without Authentication option to Allow,
you must delete the user name in the User Authentication area on the Job Info tab in the Fiery ES printer driver. The
user name field is filled in by default.

Printing

Printing files on the USB flash drive

When you print a file from the USB flash drive with the printer control panel, the printer control panel will stop
working after multiple actions are performed. Reboot the printer. This is a known limitation of the printer. As a
workaround, submit the print job through other methods.

© 2015 Electronics For Imaging
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Print options

Banner printing

If you print a job in Banner mode (Banner mode is set on the printer), you must set the Paper type to Thick 1+.

Copy Protect

If you select the Copy Protect option for a job, you must type some text in the Copy Protect field. If you leave the field
blank, the job is canceled.

Command WorkStation

Printing jobs with a pre‐printed front cover and tab sheets

When you print a job with a pre-printed front cover and tab sheets, do not insert a tab sheet before the first page,
otherwise the printed output is incorrect. As a workaround, insert the tab sheet after the first page.

Fiery Compose

Proof printing with tab inserts from Compose

If tabs are inserted into a job through Compose, and the job is set to multiple copies, the initial proof print is correct,
but the remaining proof prints are incorrect. This is because the first copy of the proof print is handled by the Fiery
ES, but additional copies of the same proof print job are handled by the printer, which converts duplex jobs to
simplex. If you want multiple proof prints of a job, print each additional proof print as a single-copy job.

Fiery Impose

Impose

When you open a job in Impose, always save it before you exit Impose. Some job settings may be lost if you do not
save the job.

Hot Folders

Hot Folders cannot be re‐opened after changing language

When you change the language preference for Hot Folders, do not close the application by clicking the X in the
upper-right corner of the Hot Folders Console. You must choose File > Quit to close Hot Folders, and then restart it.

Image Enhance Visual Editor

Working with duplicate jobs

In Image Enhance Visual Editor, changes are applied to both the selected job and any duplicates of the selected job.

2



Scanning

Scan jobs with both color and black‐and‐white images

When you acquire a mixed color and black-and-white scanned document from a User Box on the printer control
panel, do not use the TWAIN module because an extra page or extra image may appear. As a workaround, use the
Fiery Remote Scan utility to acquire the scan to a local disk and then open it with the desired application.

PrintMe

Importing jobs

When you import jobs through PrintMe, multiple jobs with different duplex settings may cause incorrect duplex
output. As a workaround, import jobs individually.

Other applications

Printing JDF files

When you print a JDF job from an application, such as Adobe Acrobat, to the Fiery ES with Command WorkStation,
you may encounter a JDF ticket error. As a workaround, right-click the job in the Command WorkStation Held list,
select Ignore JDF ticket conflicts, and then print it. Resolve any runlist errors. All other print settings are preserved.

3



4



45135259© 2015 Electronics For Imaging

16 April 2015

Fiery®  ES IC-416: Packing List

*45135259*

(5, AUS/EU/UK/US/CHN)
(1, J)

x3



ReadMe
Fiery® ES IC-416

Newer printer driver available
A newer version of the Fiery printer driver is available for this product. Go to the Download Center on efi.com to 
download the latest driver.

Dernier pilote d’imprimante disponible
Une version plus récente du pilote d'imprimante Fiery est disponible pour ce produit. Visitez le Centre de 
téléchargement sur efi.com pour télécharger le dernier pilote.

Nuovo driver di stampa disponibile
Per questo prodotto è disponibile una nuova versione di driver di stampa Fiery. Andare nella sezione Download Center 
su efi.com per scaricare il driver più recente.

Neuer Druckertreiber erhältlich
Eine neuere Version des Fiery-Druckertreibers ist für dieses Produkt erhältlich. Besuchen Sie das Download Center 
auf efi.com, um den neuen Treiber herunterzuladen.

Nuevo controlador de impresora disponible
Hay una nueva versión del controlador de impresora de Fiery disponible para este producto. Ve al Centro de descargas 
de efi.com y descárgate el último controlador.

Nieuw printerstuurprogramma beschikbaar
Er is een nieuwere versie van het Fiery-printerstuurprogramma beschikbaar voor dit product. Ga naar het 
downloadcentrum op efi.com en download het nieuwste stuurprogramma.

Novo driver de impressora disponível
Uma nova versão do driver de impressora Fiery está disponível para este produto. Acesse o Download Center em 
efi.com para baixar o driver mais recente.
© 2015 Electronics For Imaging 
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2ReadMe
较新的打印机驱动程序可用

该产品较新版本的 Fiery 打印机驱动程序可用。请前往 efi.com 上的 “ 下载中心 ” 下载最新的驱动程序。

最新のプリンタードライバーが利用可能です。
この製品には最新のバージョンの Fieryプリンタードライバーが利用可能です。efi.comにアクセスし、「Download 
Center」から最新のドライバーをダウンロードしてください。

Доступен новый драйвер для принтера
Для данного принтера доступна новая версия драйвера Fiery. Чтобы получить его, перейдите в Центр загрузок 
на сайте efi.com.

Dostępna jest nowsza wersja sterownika drukarki
Dla tego produktu dostępna jest nowsza wersja sterownika drukarki Fiery. Aby pobrać najnowszą wersję sterownika, 
przejdź do Centrum pobierania w witrynie efi.com.

Yeni yazıcı sürücüsü mevcut
Bu ürün için yeni Fiery yazıcı sürücüsü sürümü mevcut. En son sürücüyü indirmek için efi.com adresinde Download 
Center'a gidin.

Je k dispozici novější ovladač tiskárny
Pro tento produkt je k dispozici novější verze ovladače tiskárny Fiery. Přejděte na centrum stahování na webu efi.com a 
stáhněte si nejnovější ovladač.

http://www.efi.com/
http://www.efi.com/
http://www.efi.com/
http://www.efi.com/
http://www.efi.com/
http://www.efi.com/


LEGAL NOTICES 1
LEGAL NOTICES

This product documentation is protected by copyright, and all rights are reserved. No part of it may be reproduced 
or transmitted in any form or by any means for any purpose without express prior written consent from Electronics 
For Imaging, Inc. (“EFI”), except as expressly permitted herein. Information in this document is subject to change 
without notice and does not represent a commitment on the part of EFI.
This product documentation is provided in conjunction with the EFI software (“Software”) and any other EFI 
product described in this documentation. The Software is furnished under license and may only be used or copied 
in accordance with the terms of the EFI Software End User License Agreement set forth below. 

Patents
This product may be covered by one or more of the following U.S. Patents:
5,276,490, 5,278,599, 5,335,040, 5,343,311, 5,398,107, 5,424,754, 5,442,429, 5,459,560, 5,537,516, 5,543,940, 
5,553,200, 5,563,689, 5,565,960, 5,596,416, 5,615,314, 5,619,624, 5,625,712, 5,640,228, 5,666,436, 5,682,421, 
5,745,657, 5,760,913, 5,818,645, 5,835,788, 5,859,711, 5,867,179, 5,940,186, 5,959,867, 5,970,174, 5,982,937, 
5,995,724, 6,025,922, 6,035,103, 6,041,200, 6,065,041, 6,081,281, 6,112,665, 6,116,707, 6,122,407, 6,134,018, 
6,141,120, 6,166,821, 6,173,286, 6,185,335, 6,201,614, 6,215,562, 6,219,155, 6,219,659, 6,222,641, 6,224,048, 
6,225,974, 6,226,419, 6,238,105, 6,239,895, 6,256,108, 6,269,190, 6,271,937, 6,278,901, 6,279,009, 6,289,122, 
6,292,270, 6,327,047, 6,327,050, 6,327,052, 6,330,363, 6,331,899, 6,340,975, 6,341,018, 6,341,307, 6,347,256, 
6,348,978, 6,366,918, 6,369,895, 6,381,036, 6,429,949, 6,449,393, 6,457,823, 6,476,927, 6,490,696, 6,501,565, 
6,519,053, 6,539,323, 6,543,871, 6,546,364, 6,549,294, 6,549,300, 6,550,991, 6,552,815, 6,559,958, 6,572,293, 
6,590,676, 6,606,165, 6,616,355, 6,633,396, 6,636,326, 6,637,958, 6,643,317, 6,647,149, 6,657,741, 6,660,103, 
6,662,199, 6,678,068, 6,679,640, 6,707,563, 6,741,262, 6,748,471, 6,753,845, 6,757,436, 6,757,440, 6,778,700, 
6,781,596, 6,786,578, 6,816,276, 6,825,943, 6,832,865, 6,836,342, 6,850,335, 6,856,428, 6,857,803, 6,859,832, 
6,866,434, 6,874,860, 6,879,409, 6,885,477, 6,888,644, 6,905,189, 6,930,795, 6,950,110, 6,962,449, 6,967,728, 
6,974,269, 6,978,299, 6,992,792, 7,002,700, 7,023,570, 7,031,015, 7,058,231, 7,064,153, 7,073,901, 7,081,969, 
7,090,327, 7,093,046, 7,095,518, 7,095,528, 7,097,369, 7,099,027, 7,105,585, 7,116,444, 7,177,045, 7,177,049, 
7,204,484, 7,206,082, 7,212,312, 7,229,225, 7,233,397, 7,233,409, 7,239,403, 7,245,400, 7,248,752, 7,259,768, 
7,259,893, 7,280,090, 7,296,157, 7,301,665, 7,301,667, 7,301,671, 7,302,095, 7,302,103, 7,304,753, 7,307,761, 
7,342,686, 7,343,438, 7,349,124, 7,365,105, 7,367,060, 7,367,559, 7,389,452, 7,396,119, 7,396,864, 7,397,583, 
7,397,961, 7,426,033, 7,431,436, 7,433,078, 7,453,596, 7,460,265, 7,460,721, 7,461,377, 7,463,374, 7,466,441, 
7,471,403, 7,480,070, 7,489,422, 7,495,812, 7,506,253, 7,522,311, 7,522,770, 7,528,974, 7,532,347, 7,552,207, 
7,552,923, 7,554,687, 7,562,957, 7,564,583, 7,574,545, 7,574,546, 7,579,388, 7,587,336, 7,587,468, 7,598,964, 
7,600,867, 7,630,106, 7,636,180, 7,648,293, 7,653,683, 7,669,096,  7,672,013, 7,673,965, 7,684,085, 7,688,458, 
7,688,486, 7,706,015, 7,724,392, 7,729,014, 7,738,147, 7,738,710, 7,742,204, 7,756,346, 7,770,999, 7,791,777, 
7,800,773, 7,800,776, 7,812,999, 7,828,412, 7,831,830, 7,849,316, 7,859,689, 7,859,711, 7,859,724, 7,861,156, 
7,869,079, 7,880,934, 7,884,962, 7,889,403, 7,889,361, 7,911,432, 7,911,433, 7,982,890, 7,996,806, 8,013,871, 
8,014,036, 8,031,363, 8,107,122, 8,139,256, 8,169,630, 8,171,103, 8,208,012, 8,243,326, 8,294,925, 8,408,676, 
8,430,498, 8,459,773, 8,459,778, 8,477,165, 8,484,316, 8,553,286, 8,567,936, 8,595,384, 8,601,605, 8,610,932, 
8,616,691, RE38,732, D419,185, D426,206, D439,851, D444,793.

Trademarks
The APPS logo, AutoCal, Auto-Count, Balance, Best, the Best logo, BESTColor, BioVu, BioWare, ColorPASS, 
Colorproof, ColorWise, Command WorkStation, CopyNet, Cretachrom, Cretaprint, the Cretaprint logo, 
Cretaprinter, Cretaroller, DockNet, Digital StoreFront, DocBuilder, DocBuilder Pro, DocStream, DSFdesign 
Studio, Dynamic Wedge, EDOX, EFI, the EFI logo, Electronics For Imaging, Entrac, EPCount, EPPhoto, 
EPRegister, EPStatus, Estimate, ExpressPay, Fabrivu, Fast-4, Fiery, the Fiery logo, Fiery Driven, the Fiery Driven 
logo, Fiery JobFlow, Fiery JobMaster, Fiery Link, Fiery Prints, the Fiery Prints logo, Fiery Spark, FreeForm, Hagen, 
Inktensity, Inkware, Jetrion, the Jetrion logo, LapNet, Logic, MiniNet, Monarch, MicroPress, OneFlow, Pace, 
PhotoXposure, Printcafe, PressVu, PrinterSite, PrintFlow, PrintMe, the PrintMe logo, PrintSmith, PrintSmith Site, 
Printstream, Print to Win, Prograph, PSI, PSI Flexo, Radius, Rastek, the Rastek logo, Remoteproof, RIPChips, RIP-
While-Print, Screenproof, SendMe, Sincrolor, Splash, Spot-On, TrackNet, UltraPress, UltraTex, UltraVu, UV 
Series 50, VisualCal, VUTEk, the VUTEk logo, and WebTools are trademarks of Electronics For Imaging, Inc. and/
or its wholly owned subsidiaries in the U.S. and/or certain other countries.
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Third-Party Notifications
APPLE, INC. (“APPLE”) MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT 
LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE. APPLE DOES NOT WARRANT, 
GUARANTEE, OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF 
THE USE OF THE APPLE SOFTWARE IN TERMS OF ITS CORRECTNESS, ACCURACY, RELIABILITY, 
CURRENTNESS, OR OTHERWISE. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE 
OF THE APPLE SOFTWARE IS ASSUMED BY YOU. THE EXCLUSION OF IMPLIED WARRANTIES IS 
NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION MAY NOT APPLY TO YOU. 
IN NO EVENT WILL APPLE, ITS DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE LIABLE TO 
YOU FOR ANY CONSEQUENTIAL, INCIDENTAL, OR INDIRECT DAMAGES (INCLUDING 
DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS 
INFORMATION, AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE APPLE 
SOFTWARE, EVEN IF APPLE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY FOR 
CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO 
YOU. Apple’s liability to you for actual damages from any cause whatsoever, and regardless of the form of the 
action (whether in contract, tort [including negligence], product liability, or otherwise), will be limited to $50. 
PANTONE® Colors displayed in the Software or in the documentation may not match PANTONE-identified 
standards. Consult current PANTONE Color Publications for accurate color. PANTONE® and other Pantone, 
Inc. trademarks are the property of Pantone, Inc. © Pantone, Inc., 2001. Pantone, Inc. is the copyright owner of 
PANTONE color data and/or software. Certified PDF is a registered trademark of Enfocus, patent pending. PitStop 
Professional, PitStop Extreme, PitStop Server, Instant PDF, StatusCheck, CertifiedPDF.net, Instant Barcode, and 
PDF Workflow Suite are product names of Enfocus. Enfocus products and the use of Enfocus products are under 
license from Markzware under U.S. Patent No. 5,963,641. Enfocus is an EskoArtwork Company.
The Software may contain various components which are subject to different licenses, including the EFI modified 
version of the Linux kernel binary image, certain LGPL libraries, certain other open source libraries and tools, and 
software developed by the Apache Software Foundation (www.apache.org).  By using the Software or any of the 
incorporated components, you agree to be bound by the terms and conditions of their respective licenses.  The 
respective copyright notices, acknowledgments and licenses can be found on the Fiery WebTools home page.  As a 
reminder, the term "Software" as used in the EFI Software End User License Agreement does not include any open 
source software that is contained in the product, and the terms of the EFI Software End User License Agreement do 
not apply to open source software.

Regulatory Notices and Markings
THE FOLLOWING REGULATORY NOTICES AND MARKINGS APPLY IF THE EFI PRODUCT YOU 
RECEIVED INCLUDES EQUIPMENT.

WARNING: FCC Regulations state that any unauthorized changes or modifications to this equipment not expressly 
approved by the manufacturer could void the user’s authority to operate this equipment.
Refer to the Class Compliance sticker affixed to the back of your Fiery (or, in the case of embedded systems, to the 
sticker affixed to the print engine) to identify the appropriate classification (A or B, below) for this product.

FCC Class A Compliance
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 
of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is likely to cause interference, 
in which case the user will be required to correct the interference at his own expense.
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Industry Canada Class A Notice
This Class A digital apparatus complies with Canadian ICES-3(A).

Avis de Conformation Classe A de l’Industrie Canada
Cet appareil numérique de la Classe A est conforme à la norme NMB-3(A) du Canada.

FCC Class B Declaration of Conformity
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to 
Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in 
a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the 
following measures:
Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.
Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.
In order to maintain compliance with FCC regulations, shielded cables must be used with this equipment. Operation 
with non-approved equipment or unshielded cables is likely to result in interference to radio and TV reception. 
The user is cautioned that changes and modifications made to the equipment without the approval of the 
manufacturer could void the user’s authority to operate this equipment.

Industry Canada Class B Notice
This Class B digital apparatus complies with Canadian ICES-3(B).

Avis de Conformation Classe B de l’Industrie Canada
Cet appareil numérique de la Classe B est conforme à la norme NMB-3(B) du Canada.

RFI Compliance Notice
This equipment has been tested concerning compliance with the relevant RFI protection requirements both 
individually and on a system level (to simulate normal operation conditions). However, it is possible that these 
RFI Requirements are not met under certain unfavorable conditions in other installations. It is the user who is 
responsible for compliance of his particular installation.
Dieses Gerät wurde sowohl einzeln als auch in einer Anlage, die einen normalen Anwendungsfall nachbildet, auf 
die Einhaltung der Funkentstörbestimmungen geprüft. Es ist jedoch möglich, dass die Funkentstörbestimmungen 
unter ungünstigen Umständen bei anderen Gerätekombinationen nicht eingehalten werden. Für die Einhaltung 
der Funkentstörbestimmungen einer gesamten Anlage, in der dieses Gerät betrieben wird, ist der Betreiber 
verantwortlich.
Compliance with applicable regulations depends on the use of shielded cables. It is the user who is responsible for 
procuring the appropriate cables.
Die Einhaltung zutreffender Bestimmungen hängt davon ab, dass geschirmte Ausführungen benützt werden. 
Für die Beschaffung richtiger Ausführungen ist der Betreiber verantwortlich.

CE Marking (Declaration of Conformity)
This product complies with the following EU directives: 93/68/EEC, 2002/96/EC, and 2006/66/EC. 
This declaration is valid for the area of the European Union.
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EFI SOFTWARE END USER LICENSE AGREEMENT
PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE AGREEMENT”) CAREFULLY. 
THIS LICENSE AGREEMENT IS A LEGAL AGREEMENT BETWEEN YOU AND ELECTRONICS FOR 
IMAGING, INC. (“EFI”) REGARDING THE EFI SOFTWARE (“SOFTWARE”).  YOU AGREE THAT THIS 
AGREEMENT IS LIKE ANY WRITTEN NEGOTIATED AGREEMENT SIGNED BY YOU.  BY CLICKING 
TO ACKNOWLEDGE YOUR AGREEMENT DURING REVIEW OF AN ELECTRONIC VERSION OF 
THIS LICENSE AGREEMENT OR BY INSTALLING, COPYING OR BY OTHERWISE USING THE 
SOFTWARE, YOU AGREE TO BE BOUND BY THIS LICENSE AGREEMENT. THIS LICENSE 
AGREEMENT IS ENFORCEABLE AGAINST YOU AND ANY LEGAL ENTITY (E.G., SYSTEM 
INTEGRATOR, CONSULTANT OR CONTRACTOR) THAT INSTALLS OR USES THE SOFTWARE ON 
YOUR BEHALF.  IF YOU DO NOT AGREE, DO NOT INSTALL, COPY, OR OTHERWISE USE THE 
SOFTWARE, AND RETURN THE SOFTWARE TO YOUR PLACE OF PURCHASE FOR A FULL REFUND 
IN ACCORDANCE WITH ITS REFUND POLICIES.
NOTICE TO PARTIES THAT ACT AS AN AGENT OF AN END USER OR OTHERWISE DO NOT 
INTEND TO BE END USERS OF THE SOFTWARE:  IF YOU CLICK TO ACCEPT AN ELECTRONIC 
VERSION OF THIS AGREEMENT, OR INSTALL, COPY OR OTHERWISE USE THE SOFTWARE AS AN 
AGENT ACTING ON BEHALF OF THE INTENDED LICENSEE, THEN YOU WILL BE DEEMED TO BE 
THE USER OF THE SOFTWARE AND BOUND BY THE TERMS OF THIS AGREEMENT UNLESS YOU 
(I) DELIVER THE TANGIBLE MEDIA CONTAINING THE SOFTWARE AND THIS LICENSE 
AGREEMENT TO THE LICENSEE PRIOR TO PROVIDING THE LICENSEE ACCESS TO THE 
SOFTWARE, AND (II) REMOVE AND DESTROY ANY COPIES OF THE SOFTWARE IN YOUR 
POSSESSION.
IF YOU HAVE EXECUTED A SEPARATE SIGNED WRITTEN AGREEMENT WITH EFI FOR THE 
SOFTWARE, IN THE EVENT OF ANY CONFLICTING TERMS AND CONDITIONS BETWEEN SUCH 
WRITTEN AGREEMENT AND THIS LICENSE AGREEMENT, THE TERMS AND CONDITIONS OF 
THE WRITTEN AGREEMENT SHALL CONTROL.

License
EFI grants you a limited, non-exclusive license to use the Software solely in accordance with the terms and conditions 
of this License Agreement, solely as specified in the EFI product documentation, and solely with the product(s) 
specified in the EFI product documentation (“Product(s)”).  Some third-party materials distributed with the 
Software may be subject to other terms and conditions, which are typically found in a separate license agreement or 
“Read Me” file located near such third party materials.
The term “Software” as used in this License Agreement shall mean the EFI software (including software provided by 
third party suppliers) and all documentation, downloads, on-line materials, bug fixes, patches, releases, release notes, 
updates, upgrades, technical support materials, and information regarding the EFI software. The terms and 
conditions of this License Agreement shall apply to and govern your use of all such items; however EFI may provide 
other written terms with an update, release or upgrade.
The Software is licensed, not sold. You may use the Software solely for the purposes described in the EFI product 
documentation.  You may not rent, lease, sublicense, lend, or otherwise distribute the Software or use the Software in 
any time sharing, service bureau, or similar arrangement. Certain Software may only be installed at a single, physical 
location and any relocation of such Software will require EFI’s written consent.
You may not make or have made, or permit to be made, any copies of the Software or portions thereof, except one (1) 
backup or archive copy for the purposes permitted in this License Agreement; provided, however, that under no 
circumstances may you make or have made, or permit to be made, any copies of any portion of the Software that is 
included on any portion of the controller board or hardware of a product. Any copies of the Software that you are 
permitted to make pursuant to this Agreement must contain the same copyright and other proprietary notices that 
appear on or in the Software.
EFI may occasionally verify the number of copies and configurations, and/or the physical location of Software in use 
by you.  Any such verification shall be conducted during normal business hours and in such a manner as not to 
unreasonably interfere with your normal business activities.  In the event such verification discloses an underpayment 
of fees, you shall promptly pay such underpaid fees to EFI in accordance with EFI’s then-current price list. You agree 
not to localize, translate, disassemble, decompile, decrypt, reverse engineer, unbundle, repackage, discover the source 
code of, modify, create derivative works of, or in any way change any part of the Software.
As between you and EFI, you assume all risk and are solely responsible for any and all liability resulting from your use 
of the Software in a way that violates (or that produces content that violates) any law or the rights of others including, 
without limitation, laws concerning copyright infringement or privacy.
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Intellectual Property Rights
You acknowledge and agree that all rights, title, and interest, including all intellectual property rights, in and relating 
to the Software, all EFI Products, and all copies, modifications, and derivative works thereof, are solely owned by and 
shall remain with EFI and its suppliers. Except for the express limited license granted in this License Agreement, no 
right or license of any kind is granted. You receive no rights or license under any patents, copyrights, trade secrets, 
trademarks (whether registered or unregistered), or other intellectual property. You agree not to adopt, register, or 
attempt to register any EFI trademark or trade name or any confusingly similar mark, URL, internet domain name, 
or symbol as your own name or the name of your affiliates or products, and agree not to take any other action which 
impairs or reduces the trademark rights of EFI or its suppliers.

Excluded License
Notwithstanding anything to the contrary, you are not licensed to (and you agree that you will not) integrate or use 
the Software in any manner that would cause the Software in whole or in part to become subject to any of the terms 
of an Excluded License.  “Excluded License” means any license that requires as a condition of use, modification and/
or distribution of software subject to the Excluded License, that such software or other software combined and/or 
distributed with such software be (i) disclosed or distributed in source code form; (ii) licensed for the purpose of 
making derivative works; or (iii) redistributable at no charge.

Updates
If the Software is an upgrade or update to a previous version of the Software, you must possess a valid license to such 
previous version in order to use such upgrade or update.  All upgrades and updates are provided to you on a license 
exchange basis.  You agree that by using an upgrade or update you voluntarily terminate your right to use any 
previous version of the Software.  As an exception, you may continue to use previous versions of the Software after 
you use the upgrade or update only to assist you in the transition to the upgrade or update, provided that the upgrade 
or update and the previous versions are installed on the same device.  Upgrades and updates may be licensed to you 
by EFI with additional or different terms.

Confidentiality
The Software, including its structure, organization, and code, constitutes valuable trade secrets and confidential, 
proprietary information of EFI and its suppliers and you may not distribute or disclose the Software. You may, 
however, permanently transfer all of your rights under this License Agreement to another person or legal entity 
provided that: (1) such a transfer is authorized under all applicable export laws and regulations, including the laws 
and regulations of the United States, including the United States Export Administration Regulations; (2) you transfer 
to the person or entity all of the Software (including all copies, updates, upgrades, media, printed documentation, 
and this License Agreement); (3) you retain no copies of the Software, including no backup, archival, or other copies, 
however stored; and (4) the recipient agrees to all of the terms and conditions of this License Agreement.

Termination
Unauthorized use, copying, or disclosure of the Software, or any breach of this License Agreement will result in 
automatic termination of this license and will make available to EFI other legal remedies. In the event of termination, 
you must destroy all copies of the Software and all component parts thereof.  All provisions of this License Agreement 
relating to confidentiality of the Software, disclaimers of warranties, limitation of liability, remedies, damages, 
governing law, jurisdiction, venue, EFI’s intellectual property rights, and Adobe Software shall survive any 
termination of this license.
If the Software contains a License Key, upon termination, EFI may immediately and without notice, execute the 
License Key, defined as a programming code, intentionally inserted into the Software, which if executed, renders the 
Software or portions thereof inoperable.  YOU ACKNOWLEDGE AND AGREE THAT THE SOFTWARE MAY 
CONTAIN A LICENSE KEY AND THAT EXECUTION OF SUCH LICENSE KEY SHALL RENDER THE 
SOFTWARE OR A PORTION THEREOF INOPERABLE.  YOU FURTHER ACKNOWLEDGE AND 
AGREE THAT THE LICENSE KEY IS NOT A VIRUS AND THAT IN THE EVENT THAT THE LICENSE 
KEY IS EXECUTED DUE TO YOUR BREACH, YOU MAY BE OBLIGATED TO PAY EFI’S THEN 
CURRENT FEE TO REACTIVATE THE SOFTWARE, PLUS ANY OTHER APPLICABLE FEES, 
INCLUDING LICENSE FEES.



LEGAL NOTICES 6
Limited Warranty and Disclaimer
EFI warrants that the Software, if used as specified in the EFI product documentation, will perform substantially in 
accordance with the EFI product documentation for a period of ninety (90) days from the date of receipt when used 
on the recommended operating system, platform, and hardware configuration. All warranty claims must be made, 
along with proof of purchase, within such ninety (90) day period.  EFI makes no warranty or representation that the 
Software will meet your specific requirements, that the operation of the Software will be uninterrupted, secure, fault-
tolerant, or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or 
otherwise, regarding the performance or reliability of any other Products or services or any third party products 
(software or hardware) or services. THE INSTALLATION OF ANY THIRD PARTY PRODUCTS OTHER 
THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. USE, MODIFICATION, AND/OR 
REPAIR OF THE SOFTWARE OR AN EFI PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL 
VOID THIS WARRANTY. FURTHER, THIS LIMITED WARRANTY IS VOID IF A PROBLEM WITH THE 
SOFTWARE ARISES FROM ACCIDENT, ABUSE, MISAPPLICATION, ABNORMAL USE, VIRUS, WORM, 
OR SIMILAR CIRCUMSTANCE.  TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
EXCEPT FOR THE EXPRESS LIMITED WARRANTY SET FORTH ABOVE (“LIMITED WARRANTY”), 
EFI MAKES AND YOU RECEIVE NO REPRESENTATIONS OR WARRANTIES RELATING TO THE 
SOFTWARE, ANY PRODUCT AND/OR ANY SERVICES, WHETHER EXPRESS, IMPLIED, STATUTORY, 
OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR ANY OTHER COMMUNICATION. EFI 
AND ITS SUPPLIERS SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES, REPRESENTATIONS, 
AND CONDITIONS, INCLUDING THOSE OF SECURITY, MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. THERE IS NO 
WARRANTY OR REPRESENTATION THAT THE OPERATION OF THE SOFTWARE AND/OR ANY 
PRODUCT WILL BE UNINTERRUPTED, FAULT-TOLERANT, SECURE, OR ERROR-FREE. TO THE 
MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, YOUR SOLE AND EXCLUSIVE REMEDY, 
AND THE ENTIRE LIABILITY OF EFI AND ITS SUPPLIERS, RELATING TO ANY AND ALL 
SOFTWARE, PRODUCTS, SERVICES, AND/OR APPLICABLE WARRANTIES SHALL BE, AT EFI’S 
OPTION, (1) TO REPAIR OR REPLACE THE SOFTWARE THAT DOES NOT MEET THE LIMITED 
WARRANTY; OR (2) PROVIDE A REFUND OF THE PRICE PAID (IF ANY) FOR THE SOFTWARE THAT 
DOES NOT MEET THE LIMITED WARRANTY. EXCEPT AS PROVIDED IN THIS SECTION, EFI AND 
ITS SUPPLIERS SHALL PROVIDE NO REFUNDS, RETURNS, EXCHANGES, OR REPLACEMENTS.

Limitation of Liability
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, YOU AGREE THAT THE ENTIRE 
LIABILITY OF EFI AND ITS SUPPLIERS FOR ALL CLAIMS RELATED TO ANY SOFTWARE, PRODUCT, 
SERVICES, AND/OR THIS LICENSE AGREEMENT, REGARDLESS OF THE FORM OF ACTION 
(WHETHER IN CONTRACT, TORT, UNDER STATUTE, OR OTHERWISE), SHALL BE LIMITED TO 
THE AMOUNT PAID BY YOU, IF ANY, FOR THE EFI SOFTWARE. YOU AGREE THAT SUCH 
AMOUNT IS SUFFICIENT TO SATISFY THE ESSENTIAL PURPOSE OF THIS LICENSE AGREEMENT 
AND THAT SUCH A LIABILITY IS A FAIR AND REASONABLE ESTIMATE OF ANY LOSS AND 
DAMAGE LIKELY TO BE SUFFERED IN THE EVENT OF ANY WRONGFUL ACT OR OMISSION BY EFI 
AND/OR ITS SUPPLIERS. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO 
EVENT SHALL EFI AND ITS SUPPLIERS BE LIABLE FOR COST OF PROCUREMENT OF SUBSTITUTE 
SOFTWARE, PRODUCTS OR SERVICES, LOST PROFITS OR DATA, THIRD PARTY CLAIMS, OR ANY 
SPECIAL, INDIRECT, RELIANCE, CONSEQUENTIAL, EXEMPLARY, PUNITIVE, OR INCIDENTAL 
DAMAGES, HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, RELATED TO ANY 
SOFTWARE, PRODUCT, SERVICES AND/ OR THIS LICENSE AGREEMENT. THIS LIMITATION 
SHALL APPLY EVEN IF EFI AND ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES. YOU AGREE THAT THE PRICE OF THE EFI SOFTWARE REFLECTS THIS 
ALLOCATION OF RISK. YOU ACKNOWLEDGE AND AGREE THAT THE FOREGOING LIMITATIONS 
OF LIABILITY AND DISCLAIMERS FORM AN ESSENTIAL ELEMENT OF THIS LICENSE 
AGREEMENT, WITHOUT WHICH EFI WOULD NOT HAVE LICENSED THE EFI SOFTWARE TO 
YOU.  BECAUSE SOME JURISDICTIONS DO NOT ALLOW SOME OR ALL OF THE EXCLUSIONS 
AND/OR LIMITATIONS OF LIABILITY HEREIN, SOME OR ALL OF THE ABOVE EXCLUSIONS AND 
LIMITATIONS MAY NOT APPLY TO YOU.
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Export Restrictions
The Software and EFI Products are subject to the export laws and regulations of the United States, including the 
United States Export Administration Regulations. The license granted to you herein is conditioned upon your 
compliance with all applicable export laws and regulations, including the export laws and regulations of the United 
States. You represent and agree that you will not use, disclose, distribute, transfer, export, or re-export any portion of 
the Software or any EFI Product in any form in violation of any applicable export laws and regulations, including the 
export laws and regulations of the United States.  In addition, if the Software is identified as an export controlled 
item under the applicable export laws and regulations, you represent and warrant that you are not a citizen of, or 
located within, an embargoed or otherwise restricted nation and that you are not otherwise prohibited under such 
laws and regulations from receiving the Software.

Consent to Use of Data
You agree that EFI may collect and use anonymously aggregated technical information gathered in any manner as 
part of product support services related to the Software.  Subject to EFI’s then-current privacy policy and applicable 
laws and regulations, EFI may: (i) use this information to improve its products or to provide customized services or 
technologies to you; (ii) transfer this information to its affiliates, agents, and partners; and (iii) transfer this 
information to the United States and/or any other country where EFI and its affiliates, agents, and partners maintain 
facilities.

Adobe Software
The Software may contain the following Adobe Systems Incorporated (“Adobe”) materials:  (a) software included as 
part of the printing system, including PostScript® software, Font Programs (digitally-encoded machine-readable 
outline data encoded in special format and in encrypted form used to produce various typefaces) and other Adobe 
software (collectively, “Printing Software”), and (b) other software which runs on a computer system for use in 
conjunction with the Printing Software (“Host Software”).  The following terms are applicable to the materials 
provided by Adobe:

1. Printing Software. You may use the Printing Software (in object code form only) (i) on a single output device 
that contains an embedded controller; OR (ii) for Printing Software residing on a host computer, on up to the 
authorized number of central processing units (“CPUs”) for which you are licensed, for imaging to the licensed 
output device(s), solely for your own internal business purposes.  You may not change the name of any driver 
software file or driver software icon without consent of EFI.  You may use Roman character Font Programs and 
Adobe Type Manager® to reproduce weights, styles, and versions of letters, numerals, characters and symbols 
(“Typefaces”) on up to five (5) computers for use with the Printing Software.

2. Host Software. You may install the Host Software in a single location on a hard disk or other storage device on 
one (or the authorized number of) computer(s) for which you are licensed (“Permitted No. of Computers”), and, 
provided that the Host Software is configured for network use, install and use the Host Software on a single file server 
for use on a single local area network for either (but not both) of the following purposes: (i) permanent installation 
onto a hard disk or other storage device on the Permitted No. of Computers; or (ii) use of the Host Software over 
such network, provided the use of the Host Software does not exceed the Permitted No. of Computers.  You may 
make one backup copy of the Host Software (which shall not be installed or used).
You are hereby notified that Adobe Systems Incorporated, a Delaware corporation located at 345 Park Avenue, San 
Jose, CA 95110-2704 (“Adobe”) is a third-party beneficiary to this License Agreement to the extent that this License 
Agreement contains provisions which relate to your use of any software, font programs, typefaces, and/or trademarks 
licensed or supplied by Adobe. Such provisions are made expressly for the benefit of Adobe and are enforceable by 
Adobe in addition to EFI. ADOBE WILL HAVE NO LIABILITY WHATSOEVER TO YOU FOR ANY ADOBE 
SOFTWARE OR TECHNOLOGY LICENSED HEREUNDER.

Oracle Software
The Software may contain the software and/or materials provided by Oracle Corporation ("Oracle").  Java and all 
Java-based trademarks and logos are trademarks or registered trademarks of Oracle and/or its affiliates.
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U.S. Government Restricted Rights
Use, duplication, or disclosure of the Software by the United States Government is subject to restrictions as set 
forth in FAR 12.212 or DFARS 227.7202-3 - 227.7202-4 and, to the extent required under U.S. federal law, the 
minimum restricted rights as set out in FAR 52.227-14, Restricted Rights Notice (June 1987) Alternate III(g)(3) 
(June 1987) or FAR 52.227-19 (June 1987). To the extent any technical data is provided pursuant to the Agreement, 
such data is protected per FAR 12.211 and DFARS 227.7102-2 and to the extent explicitly required by the U.S. 
Government, is subject to limited rights as set out in DFARS 252.227.7015 (November 1995) and DFARS 
252.227-7037 (September 1999). In the event that any of the above referenced agency regulations are modified or 
superseded, the subsequent equivalent regulation shall apply. The name of the Contractor is Electronics For Imaging, 
Inc.

Governing Law and Jurisdiction
The rights and obligations of the parties related to this License Agreement will be governed in all respects by the laws 
of the State of California exclusively, as such laws apply to contracts between California residents performed entirely 
within California. The United Nations Convention on Contracts for the International Sale of Goods and any other 
similar convention does not apply to this License Agreement. For all disputes related to the Software, Products, 
services, and/or this License Agreement, you consent to the exclusive personal jurisdiction and venue of the state 
courts in San Mateo County, California and the federal court for the Northern District of California. 

General
This Agreement is the entire agreement held between us and supersedes any other communications or advertising 
with respect to the Software, Products, Services, and any other subject matter covered by this License Agreement. 
If any provision of the License Agreement is held invalid, such provision shall be deemed modified to the extent 
necessary to be enforceable and the other provisions in this License Agreement shall continue in full force and effect.  
If you have any questions, see the EFI web site at www.efi.com.
Electronics For Imaging, Inc.
6750 Dumbarton Circle
Fremont, CA 94555
USA
Copyright © 2004-2014 Electronics For Imaging, Inc. All rights reserved.
45125529
1 January 2014

http://www.efi.com 
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